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Welcome!

 

In a few short years the world has changed. Once music making was 
strictly divided between those with access to professional studios, ex-
pensive equipment and other musicians, and those whose music mak-
ing was confined to the realms of second rate equipment, limited funds 
and a good deal of dreaming.

We at Steinberg are pleased to be part of the continuing revolution that 
has broken down these barriers, allowing anyone with musical ambi-
tions to realise their true musical potential.

The Cubase VST you now have in front of you, is our finest achieve-
ment to date. It embodies the experience of over ten years of Steinberg 
history. Whether you are a seasoned professional musician or some-
one starting out in music, Cubase VST provides the finest easy-to-use 
tools, and the best framework for your music.

Karl Steinberg              Manfred Rürup
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About Cubase...

 

Now that you have Cubase VST, you belong to one of the largest mu-
sic software user groups in the world. Cubase is a family of music 
software, ranging from the easy-to-understand package for the begin-
ner to professional tools for the most demanding applications. That's 
the Cubase advantage, Cubase grows as you develop musically. 

Cubase may come in different versions and on different computer 
types, but it's always a Cubase. What you learn now will be just as 
valid if you decide to change to another version or another type of 
computer. We developed a method of working with music software 
that has re-defined 'ease of use', and set the standard.

Cubase VST was created as a result of years of experience in both 
software engineering and listening to our users. The Cubase of today 
is a very different product compared to its first release. A major com-
ponent of this continuing success story is your active involvement. We 
welcome suggestions and comments about Cubase VST and the direc-
tion it should take in the future. Also we are very pleased to see inde-
pendent Cubase Clubs appearing all over the world. These create 
networks of expertise and advice which helps all Cubase users.

Cubase is used by Hollywood film composers, world class recording 
studios, audio-visual facilities, and – of course – every conceivable 
type of musician. We are very proud of this, and would like to thank 
you for becoming part of the Cubase family.

Your Steinberg Team.
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How to find your way around the Manual

 

The documentation for Cubase VST comes in several flavors:

 

The Installation booklet

 

This separate booklet describes how to install the program. This is the 
first item you should read.

 

This book

 

This book contains the following:

 

• A Guided Tour in which you can find out about Cubase VST.
• Introductions to the various aspects of the program, allowing you to try out 

many of the possibilities.

 

In other words, this book is not a complete description of all the fea-
tures of the program, but a good way to get started.

 

The electronic documentation

 

¶ To be able to read the electronic documentation, you need to have the Acro-
bat Reader installed. This software is included on the Cubase VST CD. If you 
haven’t already installed the Acrobat Reader during the installation of Cu-

 

base VST, double click on the file “Install Acrobat Reader” on the CD.

 

In the “Documentation” folder on your hard disk you will find full 
documentation of all features in the program. This documentation 
consists of several documents in Adobe Acrobat format:

 

• Table of Contents.

 

This document contains links to all other included Acrobat documents, to-
gether with brief explanations of each document. Use this to find out where 
to look. When you double click on the “Documentation” icon in the Cubase 
VST folder on your hard disk, the Table of Contents document is opened.
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• Getting into the Details.

 

This is the main documentation, containing detailed descriptions of Cubase 
VST parameters, functions and techniques. When we refer to the “Electronic 
Documentation” in this book, we mean the Getting into the Details docu-
ment (if nothing else is stated).

 

• Score Printing and Layout.

 

If you have the Score or VST/24 version, the program includes a more ad-
vanced Score Editor. This editor is described in the Score Printing and Layout 
document.

 

• The VST Plugins documents.

 

In the Cubase folder there is a folder called “VST Plugins”. In here you will 
find documents describing each of the audio plug-in effects that are included 
with your program version.

 

• Using OMS.

 

This document contains information about how to set up and use OMS 
(Open Music System), which allows you to communicate with other MIDI 
programs, keep track of your MIDI instrument setup, etc.

 

• MIDI Mixer and Mix Tracks.

 

Describes how to use the MIDI Mixer in Cubase VST to control levels and pa-
rameters in your MIDI instruments from within the program.

 

• IPS.

 

This document describes how to use the Interactive Phrase Synthesizer.

 

• The Arpeggiator.

 

This document describes how to use the built-in Arpeggiator.

 

• Working with Styles.

 

Styles are complete accompaniment patterns, which allow you to easily cre-
ate music in a wide range of styles, either in real time or by predefining the 
chord changes. This document describes how to use, edit and create new 
Styles.

 

• System Exclusive Handling

 

This document describes how to work with MIDI System Exclusive messages.

 

• Controlling Tape Recorders.

 

If you plan to use Cubase VST together with a multitrack tape recorder, this 
document contains information about how to do this, using Tape Tracks.
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• Menu and Dialog Reference

 

This document contains reference descriptions of all menu items and dialogs 
in the program. Use this as a quick way to look up the purpose of a certain 
item.

 

¶ Some items are described in the Menu and Dialog Reference only!

 

So, what should I read?

 

• In either case, follow the instructions in the Installation booklet.
• Then, if you want to get acquainted with the program, read this book and re-

fer to the electronic documentation whenever necessary.
• If you know you want to learn as much as possible about this program, you 

should make sure to read this book and all the included electronic documen-
tation.

 

How you can reach us

 

You can find us at the World Wide Web, at the following address:

 

www.steinberg.net 

 

On the web site you can do the following:

 

• Find support information, answers to frequently asked questions, etc.
• Send email to our support personnel.
• Download the latest update of your programs and demo versions of other 

Steinberg products.
• Communicate with other Steinberg users in the User Area.
• There are also sections for Education and Multimedia users.
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What is Digital Audio?

 

“Audio” is any sound source that you can connect to the sound input 
of your Macintosh computer; a microphone, an electric guitar or simi-
lar. “Digital” we say because the computer converts the audio signal to 
numbers, which Cubase VST captures and stores on your hard disk. 
This conversion of sound into a stream of numbers opens up an enor-
mous range of possibilities for creatively manipulating your record-
ings.

 

What is MIDI?

 

MIDI is a type of control information used with synthesizers. Let’s ex-
plain this with an analogy: Your computer can send messages to a 
printer about how you want a page to look. The printer then takes care 
of converting this information to the actual “ink” on paper.

With MIDI the synthesizer works much like a “musical printer”: the 
computer sends information to it, specifying which notes you want it 
to play, and it takes care of actually creating the audio.

One of the advantages of this technique is that a recording made with 
for example a piano sound can be played back with a harpsichord, 
brass or guitar sound, just by changing settings on the synthesizer.

General MIDI (abbreviated GM) is an additional specification for 
MIDI instruments. If an instrument or sound card is General MIDI 
compatible, it will have a common, wide ranging set of sounds built in 
(piano, bass, drums, brass, strings etc). If you create music with a 
General MIDI compatible instrument it can be played back on any 
other GM instrument and the music will sound more or less the same. 
This allows you to share your Cubase VST songs with other people, 
and even publish your works in a common data format, for example on 
the Internet!

Cubase VST also supports two extensions to the GM standard, called 
GS (Roland) and XG (Yamaha).
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The Main Windows in Cubase VST

 

The Transport Bar

 

This is much like the transport control on any tape recorder. This is 
where you Play, Stop, “wind the tape” etc. But the Transport bar is 
also used for setting tempo, time signature etc.

These meters 
indicate MIDI In 
(recording) and 
Out (playback) 
activity.

These buttons are the 
equivalents of the transport 
controls on a regular 
cassette tape recorder.

Activates the 
metronome.

These are used for 
defining where to start 
and end recording and 
what section to Cycle.

Activates the 
Master Track. 

The tempo and 
time signature

This shows you the current 
Song Position in bars, 
beats and ticks.

When you activate 
this, the program will 
cycle the section be-
tween the Locators.

Click here to change the size and 
layout of the Transport Bar.
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The Arrangement

 

This is where you record and assemble your Songs.

Vertically, the Arrangement is divided into Tracks, letting you organ-
ise your recordings. You might use one Track for drums, another for 
bass, a third for main vocals, a fourth for vocal harmonies, etc.

The Track List

This symbol indicates 
an Audio Track

This column shows you 
whether anything is being 
played back from the Track .

Click in this column to Mute 
(silence) a Track.

The Track’s 
channel

The name of the Track. 
Double click to change.

This symbol indicates 
a MIDI Track

This button opens the Inspector

The active 
(selected) Track. 
Recording always 
happens on the 
active Track.

This symbol indicates a 
Drum Track

This symbol indicates a 
Mix Track
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The right part of the Arrangement is called the Part Display. 

At the top of the Arrange window is a tool- and settings bar.

Time runs from left to right, as the ruler indicates.

Each recording you make appears in the 
Part Display as a box, called a Part.

The Song Position The Left Locator The Right Locator

The vertical position 
of the Part shows you 
which Track it is on.

The horizontal position 
shows you where in the 
Song the Part starts.

The width of the 
box shows you 
the length of the 
recording.

In the Part you will see a visual 
representation of the recording.

Click here to listen to the 
selected Track only

The Snap value. This is the “precision” for 
operations such as moving, splitting, etc.

This note value is used for 
the Quantize function.

The mouse pointer’s position. This can be displayed 
either in Meter or Time format.
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The Audio mixer windows

 

The Audio Channel Mixer is where you mix your Audio Tracks, that 
is, adjust the levels (volume), stereo panning, effect sends, EQ, etc. 

The final output is adjusted in the Master window:

Mute and Solo 
buttons

Pan controls

Level fader

Level meter

Mixer 
automation 
controls

Clip indicator

Input level 
switch

Level meters

Master Effect 
displays

Level faders

Mono output 
button
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The EQ and Effect windows

 

For each audio channel in Cubase VST, you can have up to four bands 
of parametric equalization. Furthermore, each channel has eight effect 
sends, each of which you can assign to any of eight internal “effect 
processors” for adding reverb, chorus and other effects.

There are also four independent Insert Effects for each audio channel 
and four Master Effects, which are inserted into the master output bus.

Equalizer sectionEffect sends

The Send Effects window, with five effects activated (out of eight possible).
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The MIDI Track Mixer

 

This mixer is similar to the Audio Channel Mixer, only you use it to 
adjust the levels, panning and other parameters for your MIDI Tracks.

 

The Pool

 

This window lists all your audio recordings. It is also used to import 
audio files created in other programs, for use in Cubase VST.

Mute and Solo buttons

Pan controls

Level fader

Level meter

Mixer automation 
controls

Click this button 
to Mute all Audio 
Tracks.

Use this menu to import Files 
created in other programs

This is a file containing 
an audio recording.

These are segments that play sections of 
the file. By dragging segments into the 
Arrangement, you can use the audio file 
in your Song.
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The Audio Editor

 

This is the window where you do the basic editing of your Audio 
Parts, moving and trimming start and end points of Audio Events, etc.

 

The Wave Editor

 

This window is for detailed editing and permanent alteration of the ac-
tual audio recordings.
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The MIDI Editors

 

There are four different editors for editing your MIDI recordings: 

 

Key Edit

 

This editor consists of a “grid” with the notes shown as boxes. The 
pitch of a note is indicated by the vertical position, and the note length 
is indicated by the width of the box. This is the editor to use when you 
want quick graphical editing of notes and continuous controllers, such 
as modulation and volume.

Continuous Events Notes
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Drum Edit

 

This editor is similar to Key Edit, but designed specially for editing 
drum and percussion Tracks. Each Drum Sound has its own row and 
settings, making it easy to create and change rhythm patterns. 

Drum Sounds

Notes
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List Edit

 

In this editor, all MIDI notes, controllers and other Events are shown 
in a list. You can move, insert and delete Events in the list and perform 
detailed editing of all values. List Edit is useful when you want abso-
lute control over values and positions, or if you are a “computer type 
of person”, used to numerical editing.

 

Score Edit

 

Here, the MIDI notes are presented as a musical score. Use Score Edit 
to print scores, or simply if you are used to working with musical no-
tation.

The Event List

MIDI Events

The Event Display
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The Controller Editor

 

In this window, you can view, edit and create any continuous informa-
tion, such as MIDI controllers, recorded mixer fader movements, etc.
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About this Chapter

 

This chapter gives you a really quick introduction to Cubase VST. It is 
based on the Quick Start demo Song, included on the VST CD-ROM. 

 

Opening the Quick Start Song

 

1. Insert the Cubase CD-ROM into the drive.

2. In the Finder, copy the folder Quick Start Song on the CD-ROM to 
your hard disk.

3. Open the Quick Start Song folder on your hard disk, and locate the 
Cubase Song file with the same name. Double click on it.

 

Cubase launches, and the Song opens. What you see now is the Arrange win-
dow, the real focus of Cubase.

 

Playing Back

 

At the bottom of the screen you will find the 

 

Transport Bar

 

. This is 
used to control playback, recording and many other functions, much 
like the controls on a regular tape recorder.

 

The transport controls.

 

1. Click the Play button, on the Transport Bar.

 

The Song starts playing. At this point, you will only hear the audio Tracks, 
that is, audio recordings stored on your hard disk as files. No MIDI is played 
at this point.

 

2. When you are done listening, hit Stop. Also try out Fast Forward 
and Rewind to see how you can move the Song Position (the verti-
cal moving line in the Arrange window) to any point in the Song 
and start playback from there.
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Muting and Soloing Tracks
As you can see, the Arrange window is divided into a number of 
Tracks. These are listed vertically. You can silence any number of 
Tracks, by using the functions Mute and Solo.

1. Click in the “M” column in the Tracks list, for the Track Bass.
You will notice how the bass disappears from the music. Click again to get it 
back. What you just did was muting and unmuting a Track.

• Experiment with muting/unmuting Tracks but leave the MIDI 
Tracks (Vibes, Strings, Mono Lead and Congas) muted for now.

2. Click on the name of the Track Bass.
The Track goes dark. What you just did, was selecting a Track. Selecting 
something means it is now the target for some operation you are about to 
perform.

3. Click on the Solo button, at the top of the Arrange window.
You will now hear only the selected Track. Solo can be thought of as a sort of 
inverse mute. Click Solo again to hear all the unmuted Tracks.

A Muted Track

This Track is selectedThe Solo button
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Activating the MIDI Tracks
The four Tracks at the bottom do not play audio but MIDI. You can see 
this by checking the “C” column for each Track. The note symbol in-
dicates that a Track is a regular MIDI Track whereas the waveform 
symbol indicates an audio Track.

To be able to play the MIDI Tracks you need to have an external MIDI 
synthesizer connected to a MIDI Interface. If your synthesizer is not 
General MIDI compatible, you might still play the Tracks, and you 
will probably hear something, but it might not be the sounds we as-
sume in this example.

1. Make sure your synth is in its General MIDI compatible mode.
Most synths are on startup already in this mode.

2. Click twice on the Stop button to move the Song Position to the be-
ginning of the Song.

3. Unmute the four Tracks Vibes, Strings, Mono Lead and Congas.

4. Activate playback.
You will now hear, from the MIDI synthesizer, some additional parts in some 
sections of the Song. If you don’t hear anything, check the Output column for 
the MIDI Tracks and make sure they are set to the correct “port”. 

Audio Track symbol

MIDI Track symbol
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Changing the Sound and Level of a MIDI 
Track

Now, let’s try to make some changes to the sound and levels of the 
MIDI Tracks. Let’s begin with changing sounds:

1. Let the music keep playing.

2. Select the “Mono Lead” Track.

3. Look at the Inspector (the area with a lot of settings, to the left of 
the Track list).
If the Inspector isn’t visible, click on the button in the lower left corner to dis-
play it.
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4. Position the pointer over the “GM Name” pop-up menu, and press 
the mouse button.
A hierarchical pop-up menu appears, with all GM (General MIDI) sounds 
listed in groups of eight.

5. Select a new sound from the pop-up menu.
When the Mono Lead Parts are played back, you will hear them with the 
sound you just selected. If nothing happens, this is because your instrument 
is not set up to receive the MIDI message Program Change.

Now, lets’s change the levels of the MIDI Tracks. The easiest way to 
do this (although there are others) is to use the MIDI Track Mixer:

6. Keep the music playing.
If the Song has ended already, click twice on the Stop button to move the 
Song Position to the beginning of the Song, and then click Play again.
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7. Select “MIDI Track Mixer” from the Panels menu.
A window with faders, meters and other controls open. 

This is where you mix your MIDI Tracks. Currently, the MIDI Track Mixer has 
four “channel strips”, since there are four MIDI Tracks in the Quick Start 
Song (had there been five MIDI Tracks, you would have had five channel 
strips, etc).

8. Use the faders to adjust the levels of the MIDI Tracks, as desired.
If you like, experiment with the other controls in this window.

9. When you are done, press [Return] to close the window.

The four “Channel Strips”

Mute and Solo buttons

Pan control

Volume fader

Level (velocity) meter

Track name
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Setting the Levels of the Audio Tracks
Now that you’ve learned how to mix the MIDI Tracks, let’s do the 
same for the audio Tracks.

1. Rewind the Song to the beginning and activate playback.

2. Select “Audio Channel Mixer” from the Panels menu.
The Audio Channel mixer appears. Here you can see, via the colored bar 
graphs, which audio channels are playing (in this example, each audio 
channel corresponds directly to an Audio Track, so that Track 1 plays back 
on audio channel 1, and so on).

The Audio Channel mixer window.

3. Use the channel faders to adjust the levels of the Tracks, as de-
sired.
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Adding an Effect
Now, let’s add some audio effects to the Guitar Track. To hear what 
we’re doing, let’s Solo it first.

1. Locate the Track “Guitar”, the one labelled “Chan 4” at the bot-
tom, and click on its Solo button (in the upper part of the “channel 
strip”).

2. Click on the same Track’s FX button, located just above its Mute 
button.
The EQ and FX Send window for that channel appears. Essentially this is a 
mixer window with detailed settings for one channel only.

The effect settings in the EQ/FX window.

The section we are interested in now is the one to the far left, with the 
eight blue knobs. These represent controls for the amount of effect for 
this audio channel. In this Song, four effects are activated, which 
means you can use the first four effect sends (the four knobs to the 
left).

3. Click on the On buttons for the four first effect sends.
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4. Use the knobs to add various amounts of each effect to the Guitar 
sound.
To do this, press the mouse button with the pointer over the knob, keep the 
button down and drag in a circular motion around the knob.

Drag in a circular motion around the knob.

5. When you are done, close the FX window, click the Solo button 
again to deactivate Solo and finally close the Audio Channel mixer.
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Checking Out the Arrange Window Toolbox
So far you’ve been mixing and setting sounds. Now it’s time to ex-
plore the possibilities of editing the music. This is mainly done in the 
Arrange window, using a graphical Toolbox that allows you to manip-
ulate recordings.

As you have probably noted, the recordings on the Tracks are made up 
of Parts, small boxes that each represent a musical recording, regard-
less of whether it contains audio or MIDI. Editing in the Arrange win-
dow means manipulating these Parts.

Parts in the Arrange window.

1. Pull down the Tools menu.
A Toolbox appears.

The Arrange window Toolbox.

2. Select the Eraser tool.
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3. Click on one of the Parts.
It disappears - because you just erased it!

4. Select Undo from the Edit menu.
The Part comes back.

5. Select the pointer from the Toolbox.

6. Position the mouse pointer over any Part, press the mouse button 
and drag.
The Part moves. If you like, play back to hear the effect.

7. Select one Part. Then hold down [Shift] and click on more Parts, 
one after the other.
They all get selected and turn dark to indicate this.

8. Press the mouse button with the pointer over one of the selected 
Parts, and drag.
They all move together, as a block.

9. If you like, try out the other Tools.
The functions of the most common Tools are described in the chapter “Work-
ing in the Arrange window”.
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Checking the Contents of the Parts
The Arrangement is fine for block editing purposes, like repeating a 
chorus etc. However, there will be many instances when you will want 
to perform more detailed manipulations of your recordings. For this 
you use the various Editors.

1. Double click on a Part on an audio Track.
The Audio Editor opens. This has a Toolbox and a number of controls, menus 
and settings all of its own. If you like, experiment with the possibilities.

2. Close the Audio Editor.

3. Double click on a MIDI Part.
The Key editor opens. This is one of a number of MIDI editors, each one 
streamlined for a certain type of work.

4. Again, experiment with the possibilities, if you like.

5. Close the Key editor.

Closing Up
This finishes our quick tour of the demo Song. By now you are proba-
bly anxious to record something of your own. Proceed to the next 
chapter to get an introduction to the basic methods and concepts used 
in the program, and then get ready for a unique musical experience, 
using Cubase VST to realize your own musical inspirations.

¶ Apart from the Quick Start Song, there may also be other Demo Songs in-
cluded on the CD-ROM. Use these to try out other features and get an im-
pression of the full capacity of Cubase VST!
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Why you should read this Chapter
In this chapter, none of the actual features of Cubase VST are de-
scribed. Instead, the chapter contains information about the general 
methods you need to employ when using Cubase VST, plus some use-
ful terminology. These methods are the same in every part of the pro-
gram, no matter if you are making a basic recording or using Cubase 
VST at its most advanced level. To make your work with Cubase VST 
as effective as possible, please take the time to read this chapter.
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Using Tools
When you are working with Cubase VST, you need different tools in 
different situations. You may for example want to input notes or im-
port audio using a Pencil tool, or delete notes using an Eraser tool. 
There are a lot of other tools as well.

Some examples of tools

About Toolboxes
The various tools used in certain situations, are gathered in Toolboxes. 
Each is essentially a “frame” containing an icon for each tool. Most of 
the windows in Cubase VST have their own Toolbox.

Some examples of Toolboxes
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Selecting a Tool from a Toolbox

Using the Toolbox as a menu

You may simply choose tools from the menu bar:

1. Pull down the “Tools” menu on the menu bar.

2. Position the pointer over a tool and release the mouse button.
The pointer takes on the shape of the selected tool.

3. When you are done using a tool, simply choose another from the 
Toolbox.
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Using the Toolbox as a window

You can "tear off" the Toolbox from the menu bar if you want it to ap-
pear as a window of its own:

1. Pull down the "Tools" menu on the menu bar.

2. With the mouse button pressed, drag the Toolbox to a new place.
An outline of the Toolbox shows you where it will be positioned.

3. Release the mouse button.
The Toolbox appears in its new position.

• This can also be done by holding down [Control + Shift] and click-
ing wherever you want the Toolbox window.

4. To select a Tool, click on its icon in the Toolbox.
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5. If you want to move or close the Toolbox, proceed as with any 
Macintosh window.

• You can choose between a “horizontal” or “vertical” toolbox by 
clicking on the zoom box on the window title.

• You can always select “Tools” from the menu bar, even if the Tool-
box is already opened as a window.

¶ You can also open the Toolbox temporarily by pressing [Ctrl] and clicking 
the mouse on any (applicable) window.

Switching to the Arrow Tool

By using a key command (by default the [Tab] key), you can toggle 
between the Arrow tool and the last tool used.

Pop-Up Menus
Throughout the program you will select values from pop-up menus. 
These differ a bit from the regular “menu bar menus”. Pop-up menus 
may be located anywhere in a window, and are not on a menu bar. But, 
selecting is done identically from all menus, pop-up or regular.

When “torn off”, the Toolbox has a 
title bar with a close box and a zoom 
box, just like an ordinary window.

Press the mouse button with the pointer 
positioned on the small triangle...

...to pull down a pop-up menu.
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About the Toolbar
The Toolbar is a separate window to which you can add icon buttons 
for virtually all Cubase VST functions. The reasoning behind this is 
that each user has an individual set of functions that he/she accesses 
more often than others. Setting up a Toolbar with icons for the func-
tions you use often makes working in Cubase VST quicker and more 
efficient.

Showing and Hiding the Toolbar

• To show the Toolbar, pull down the Windows menu and select 
Show Toolbar.
The Toolbar appears at the position it was last displayed.

The Toolbar with the default set of icons.

• To hide the Toolbar, pull down the Windows menu and select Hide 
Toolbar, or click on the Toolbar’s close box.

Using the Toolbar

• To select a function from the Toolbar, simply click on an icon.
When you move the pointer over an icon, its associated function is displayed 
below it on the Toolbar.

Customizing the Toolbar

To remove or add icons from the Toolbar, go to the Key Commands di-
alog (accessed from the Preferences submenu on the Edit menu). Use 
the pop-up menu and scroll bar to find the desired function, and click 
in the “Icon” column to select a toolbar icon for it. This is described in 
more detail in the chapter “Key Commands” in the electronic docu-
mentation.
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About Positions, Lengths and Resolution

Resolution and Ticks

Cubase VST always works with a position resolution of 15360 frac-
tions per quarter note. This means that within each quarter note, there 
are 15360 possible positions for the start point of a MIDI or Audio 
Event. This very high figure is chosen to capture the finest timing nu-
ances, and assure that a recording will sound exactly as it was origi-
nally played.

However, when managing and editing the recordings in Cubase VST, 
this high resolution can sometimes make positioning unnecessarily 
complicated and clutter up the displays. Therefore, in the Preferences 
dialog on the Edit menu you have the option of selecting a display res-
olution that is less than that: 7680, 1536, 480 or 384. 

The Display Resolution item is located in the Preferences–General–
Miscellaneous dialog (see page 53).

The display resolution affects two things: 

• In how small increments you can move and resize Events on the screen.
• How meter positions are displayed numerically throughout the program (see 

below).



CUBASE VST
Basic Methods 4 – 44

4
4
4
4
4
4
4
4

4
4

The smallest display resolution unit is called a tick. If for example you 
have selected a display resolution of 7680, there will be 7860 ticks for 
each quarter note and 1920 tick for each 1/16th note.

Positions

You will often work with position values in the Arrange window and 
in the editors. Positions in Cubase VST are displayed in one of two 
formats: 

• Meter Positions
Meter Positions are divided into Bars, Beats (quarter notes), 1/16th notes and 
Ticks. This is the most commonly used position format in Cubase VST.

For example, if you place the Song Position pointer just before the second 
sixteenth into the third bar, the position will be displayed like this: “3.1.2.0” 
(third bar, first beat, second sixteenth note and zero ticks).

¶ In previous versions of Cubase, meter positions were displayed with three 
digits: Bars, Beats and Ticks, with a resolution of 384 ticks per quarter note. If 
you prefer this older meter position format, select “Old Cubase” in the Dis-
play Resolution pop-up menu in the Preferences–General–Miscellaneous di-
alog.

• Time Positions
Time Positions and lengths are shown as “hours: minutes:seconds:frames”. 
How many frames there are to each second depends on the frame rate, as set 
in the Synchronization dialog box. See the “Synchronization” chapter in the 
electronic documentation.

 
The beginning of the Song, displayed as a Time position.

MIDI Note Lengths

MIDI Note lengths are always displayed as beats, sixteenth notes and 
ticks.
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Setting Values

Different types of values
There are three basic kinds of values displayed in Cubase VST:

• “Normal” values.
• “Segmented” values, i.e. values divided into two or more “component val-

ues”. Examples of these are positions, tempo, time signature, etc.
• Note Pitches.

Some different values.

Changing values
There are several ways to change a value in Cubase VST:

• Point at the value and click with the mouse.
To increase the value one step, click in the upper half of the value field, to 
decrease it, click in the lower half.

• Scroll the value up or down by pressing and holding down the 
mouse button with the pointer in the upper or lower half of the 
value field.

¶ If you hold down [Shift] while using the methods above, the value will 
change/scroll in larger steps (often steps of ten).

• Click on a value and drag the mouse up or down with the button 
pressed.
The whole screen acts like an invisible scroll bar or fader, which you can use 
to change the value.

• Double click on the value, type in a new value and press [Return].



CUBASE VST
Basic Methods 4 – 46

4
4
4
4
4
4
4
4

4
4

About changing “segmented” values

If you are using the mouse to change a “segmented” value such as a 
position or a decimal number, you can change any one of the “seg-
ments” individually. In a position value for example, you can change 
the bar, beat and tick values independently, just by positioning the 
pointer at the right numeral.

If you are changing a segmented value by typing, you can use spaces, 
dots, commas or any character that is not a number, to separate the nu-
merals. However, you don’t have to type in all the numerals. If you 
just type in a single number, you will change the largest numeral in the 
segmented value, and all the lesser numerals will be set to their lowest 
values:

Clicking on the “Beats” value...

...will change this value only.

Double clicking on this 
value (Song Position)...

...brings up a highlighted 
value box.

If you type a single value 
and press return...

...the lesser numerals get their 
lowest values automatically.
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About displaying and editing Note Pitches

Note Pitches can be displayed alphanumerically in several different 
ways in Cubase VST. On the the Note Name Style pop-up menu in the 
Preferences–General–Editors dialog (see page 53) you can choose one 
of the four following display modes:

• MIDI.
Notes are displayed with their note name (C, D, E, etc), a #-sign if necessary, 
and an octave number (ranging from -2 to 8). For example, the “middle A” 
(usually 440 Hz) would be displayed as “A3” in this mode.

• MIDI+Value.
Notes are displayed as in the MIDI display mode above, followed by the ac-
tual MIDI note number (0-127). For example, the “middle A” would be dis-
played as “A3/69” in this mode.

• DoReMi.
Notes are displayed with their italian names (Do, Re, Mi, etc), a #-sign if nec-
essary, and an octave number (ranging from -2 to 8). For example the “mid-
dle A” would be displayed as “La3” in this mode.

• Classic.
Notes are displayed in a “classic German” way, which has the following 
properties:
• Note names are given as C, D, E, etc, with “black notes” signified by “is” 

(“Dis” means “D#”).
• The letter “H” is used instead of “B”.
• Octaves are indicated by the case of the note name, in combination with 

a number. From bottom to top, the C notes are displayed: C3, C2, C1, C, 
c, c1, c2, c3, c4, c5, c6. The “middle A” is displayed as “a1”.

If you are editing a pitch (note number) by typing, you would normally 
type it according to the currently selected display mode. However, you 
can always specify note pitches as a note name (C3, C#3, D3, etc) or as 
a MIDI note number (0 - 127), no matter which display mode is selected.

You may enter a MIDI note number, 
for example 37...

...but Cubase VST will display the 
name of the note (here C#1).
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Changing a value via MIDI
Any value that represents a note (pitch) or fixed velocity can be 
changed via MIDI: 

1. Double click on the value field to highlight it.

2. Send a Note On message by pressing a key, hitting a pad, playing a 
string or whatever. 
The value in the field changes immediately. If you don’t get it right the first 
time, just try again.

3. When the displayed value is the one you want, click outside the 
field or press [Return].

Naming
You can give names to Tracks, Parts and many other items in Cubase 
VST. To edit a name just double click on it. The text gets highlighted 
and you can type in the changes you want to make. You can use the ar-
row and [Backspace] keys, just as in any text-editing program.

Double clicking on the name... 

...highlights it and makes it ready to edit.
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Window Techniques
Cubase VST’s windows are regular Macintosh windows, which means 
that you may move, resize, scroll and close windows using standard 
Macintosh procedures. There are also a couple of special features:

Changing the Magnification
In the Arrange window and most of the editors, a small magnification 
control box appears on each scroll-bar. The control boxon the left/
right scroll bar changes the horizontal magnification. The control box 
on the up/down scroll bar changes the vertical magnification.

You use the magnification controls in the following way: 

• Click on the minus sign to decrease magnification.

• Click on the plus sign to increase magnification.

• Drag the triangle to quickly change magnification several steps.
You can also change the magnification from the computer keyboard, 
using any keys you select in the Key Commands section of the Prefer-
nence dialog (see the electronic documentation). By default, the fol-
lowing keys are used:

Finally, in the Arrange Window and in Score Edit, you can change the 
magnification by using the Magnifying Glass tool. This allows you to 
quickly zoom in on a specific object or area.

[G] Decrease horizontal magnification.

[H] Increase horizontal magnification.

[Shift]-[G] Decrease vertical magnification.

[Shift]-[H] Increase vertical magnification.

The vertical magnifying control

The horizontal magnifying control



CUBASE VST
Basic Methods 4 – 50

4
4
4
4
4
4
4
4

4
4

Dividers
Some of the windows in Cubase VST are divided into two or more 
sections. The “borders” between the sections are called Dividers. You 
can click on the Divider and drag it in the direction of one of the sec-
tions. This way, you will shrink that section and enlarge the other.

Dragging the Divider in the Arrange Window.
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Using the Computer Keyboard
You can use the computer keyboard to control a very large number of 
items in the Cubase VST. When you install the program, the default 
key command settings will be used, but you’re free to make your own 
key assignments in the Key Commands section of the Preferences dia-
log (see the “Key Commands” chapter in the electronic documenta-
tion).

• By default, the Transport functions (such as Play, Stop, Record and 
so on) all have keyboard equivalents on the numeric key pad to the 
right on the computer keyboard. 
See page 129 for a list of these default key commands.

• For a complete list of the default key commands, see the “Key 
Commands” chapter in the electronic documentation.
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How Keyboard Commands are displayed in this Manual

¶ The keyboard commands mentioned in the manual refer to the default key 
settings. As described in the “Key Commands” chapter in the electronic doc-
umentation, you can change these settings, should you so wish.

The following list shows how the “special” keys on the computer key-
board are displayed in this manual.

When the text says something like “press [Command]-[T]” this means 
that you should hold down the Command key on the computer key-
board and press T once.

¶ Some key commands involve pressing two modifier keys, for example: “press 
[Shift]+[Command]-[T]”. The “+” sign between the modifiers means that you 
should press the Shift key and the Command key at the same time, hold 
them down and then press T once.

In this manual: On some keyboards:

[Shift]

[Option]

[Command]

[Tab]

[Return]

[Backspace]

[Enter]
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About Preferences
There are a lot of settings you can make to customize the program, so 
that it suits your way of working. These settings are gathered in the 
Preferences dialogs, on the Edit menu.

Furthermore, some of the Preferences dialog are divided into several 
“pages”. You choose which page should be shown, by pulling down 
the pop-up menu at the top of the Preferences dialog, and selecting 
one of the options there.

Each of these menu 
items opens a separate 
Preferences dialog.
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How the Preferences are referred to in this Manual

When we refer to the Preferences in this manual, we use the following 
syntax: Preferences–dialog name–Page name.

For example, “Preferences–General–Editors” means the “Editors” 
page in the “General” dialog, found on the “Preferences” submenu on 
the Edit menu.

The Preferences–General–Editors dialog.

¶ The settings you make in the Preferences dialogs can either be saved “glo-
bally” for all Cubase Songs, or separately for each Song. This is described on 
page 71.
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Undo
Cubase VST has a very wide-ranging Undo function. This means that 
if you regret your last action, you can Undo it. This is very helpful 
when something doesn’t turn out as intended. Remember that it is only 
the last action that can be undone.

You Undo an action by selecting “Undo” from the Edit Menu, or by 
pressing [Command]-[Z] on the computer keyboard.

If you wish to “Undo the Undo”, this is possible. The menu text 
changes to “Redo” after an Undo (for example “Redo Delete”). If the 
menu item is grey, nothing can be undone.

Often the menu item Undo tells you what will be undone 
at any given moment. In this case, "Undo Delete" means 
the last deletion will be undone.
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Setting up your System 5
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Setting up Audio

¶ This chapter (and in fact the whole Getting Started book) assumes you are us-
ing the audio hardware built into your Macintosh, or an audio card with an-
alog stereo inputs and outputs. 
If you have an audio card with several inputs and outputs, you find informa-
tion about activating different Inputs and routing audio to different Outputs in 
the chapter “Using Additional Audio Hardware” in the electronic documen-
tation. 
To get a grip on the basic audio procedures in Cubase VST, we recommend 
that you set up and connect your audio hardware so that it resembles a stan-
dard “two in/two out” card, and try out the possibilities described in this 
book. Then go on to learn about the Output Bus features as described in “The 
Input/Output Bus System” in the electronic documentation.

Connecting your system - Inputs and Levels

A Basic system including an External Mixer

In most Macintosh models, the built-in audio inputs accepts line-level 
signals only, that is, the input gain is not sufficient for recording the 
output of a microphone, an electric guitar or other low output audio 
sources. To amplify the signal, you need a separate microphone ampli-
fier, or a mixer. (Should your Macintosh model have dedicated micro-
phone inputs, you may still benefit from using an external mixer, since 
these often provide better sound quality.)

In addition to this, you probably want to connect one or several exter-
nal MIDI instruments. This means you have two or more audio 
sources that you want to hear in your speakers or headphones – the au-
dio output from the Macintosh and the output from the synthesizer(s). 
Again, the solution is to connect it all to a mixer.
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The picture below shows a setup that includes both these functionali-
ties (for details on the actual MIDI connections, see page 65).

In the example above, a special output on the mixer called a “monitor 
send” or a separate “bus” is connected to the Macintosh audio input. 
This ensures that you can separately control what gets recorded on an 
audio Track.

The main outputs of the mixer are connected to the speakers, and it is 
via this connection you are able to hear the output of the Macintosh 
and the synthesizers, blended to a final mix.

Naturally, there are endless variations on the above concept depending 
on the type of mixer and the sources to be recorded. Contact your mu-
sic dealer for help on configuring a system ideal for your specific 
needs.

Recording From a CD player

The CD-ROM drive on the Macintosh can also be used as a regular 
CD player, making it possible to record sound or music from a CD di-
rectly into Cubase VST. See page 76.

Send/Bus Out

MainOut
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About Recording Levels and Inputs

If you are using an external mixer for your audio input sources, you 
should match the levels of the different sources using the mixer’s input 
gain controls (refer to the mixer documentation). However, you still 
need to make sure that the output signal of the mixer (the signal being 
sent into the Macintosh) is not too loud or too weak, or your record-
ings will either be distorted or unnecessarily noisy. The same goes for 
connecting a line-level instrument directly to the audio input of the 
Macintosh. 

Cubase VST will help you by indicating input levels, but there are no 
actual input level settings within the program. If it is possible to adjust 
input levels with the audio hardware you are using, this is either done 
in a special application included with the audio hardware or possibly 
from an ASIO control panel, accessed from Cubase VST’s Audio Sys-
tem dialog (this is the case if you are using the built-in audio hardware 
of the Macintosh).
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About Monitoring
In Cubase VST, Monitoring means listening to the signal being re-
corded while preparing to record or while recording. There are basi-
cally three ways to monitor:

• Via a Mixer
If you have the equipment connected to a mixer and then to the audio card, 
you can of course choose to listen to the connected equipment directly from 
the mixer. If you should choose this option or not depends on how advanced 
your mixer is.

• Directly via the audio hardware.
In this case, the computer’s audio input is connected directly to its output. 
You set this up with the ASIO Control Panel for the audio hardware (accessed 
from Cubase VST’s Audio System dialog) or a mixer application that comes 
with the card.

• Via Cubase VST
In this case, the audio passes from the input into Cubase VST and back to the 
output. You then control monitoring via settings in Cubase VST.

Which should I choose - “Direct” or “Cubase” 
monitoring?

• Monitoring via Cubase VST has the advantage that any effect and 
other settings you make in the program will also be apparent on 
the monitored signal, not only on recordings you have already 
made and play back.
This will not be the case if you monitor directly via the audio hardware.

• Monitoring via Cubase VST has only one disadvantage: There is an 
unavoidable delay in the Monitor signal (the monitored sound will 
appear to be a little late). This is due to the way audio is handled 
on Macintosh computers.
Normally, “direct” monitoring does not have this problem.
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Setting up

• If you want to use Cubase VST’s monitoring, make sure any moni-
toring (“through”) function is deactivated in the audio hardware’s 
mixer application.
With some audio hardware (including the Macintosh’s built-in audio) you 
can change this setting at any time, using an ASIO Control Panel accessable 
from within Cubase VST.

• If you instead want to monitor directly through the audio hard-
ware, make sure this function is activated in the card’s mixer ap-
plication or ASIO Control Panel. Also select the Global Disable 
monitor option in Cubase VST’s System dialog (found on the Op-
tions - Audio Setup submenu).
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System and ASIO Settings
1. Pull down the Options menu and select “System...” from the Audio 

Setup submenu.
The Audio System Setup dialog appears:

2. If you are using the built-in audio hardware of the Macintosh, 
make sure that “Apple DAV” is selected on the ASIO Device pop-
up menu.
If you have a card for which there is a special ASIO driver, you should select 
that driver. See the electronic documentation for details.

¶ The ASIO Device option called “Apple Sound Manager” will also work with 
the built-in audio hardware. However, the “Apple DAV” device will provide 
better performance, notable in tighter alignment between audio and MIDI 
timing. 
The only time you should use the “Apple Sound Manager” device is if you in-
tend to simultaneously run Cubase VST and another audio program, which 
also plays back audio via the regular, built-in Macintosh audio hardware.
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3. If required, adjust the Number of Channels in the Audio Perform-
ance section.
How many channels you will actually be able to use depends on your com-
puter’s processing power, the speed of the hard disk and other factors.

4. Click Apply.

5. Click on the ASIO Device Control Panel “Launch” button.
The ASIO Control Panel opens. This is used to make settings for your audio 
hardware (in this case, the built-in audio hardware of the Macintosh).

The ASIO Control Panel for the Apple DAV device.

6. If you want to monitor your audio recordings directly through the 
audio hardware (see page 60), activate the “Play Through” check-
box.

7. If you want to monitor your recordings directly through the audio 
hardware (if you activated “Play Through” in step 6 above), or if 
you want to use an external mixer for monitoring, select “Global 
Disable” in the Monitoring section.
If instead you want to monitor your recordings through Cubase VST, select 
“Tape Type” or “Record Enable Type” (the difference between these modes is 
explained in the “Menu and Dialog Reference” electronic document).

8. Close the dialog by clicking OK.

9. Click OK to close the System dialog.
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Enabling/Disabling Audio

On the Audio Setup submenu on the Options menu you will find a set-
ting called Disable Audio, which allows you to disable all audio input 
and output. This feature is mainly for two situations:

• When you only want to record and play back MIDI and don’t want 
to waste processing power on the audio engine.
This allows the computer to use all its power for screen updates and MIDI 
playback.

• When the computer you use is not powerful enough to run Cubase 
VST with the VST engine enabled.
Note the following:

• When audio is disabled, the menu item changes name to “Enable Audio”.
• The setting is automatically saved in the Cubase VST preferences. This means 

that if you disable the Audio Engine, it will remain disabled until you enable 
it again.

• It is only CPU processing power that is preserved. The program will still use 
the same amount of primary memory (RAM) and disk space.

• All audio functionality is actually intact, it is only audio recording, playback 
and synchronization that are disabled. If you like, you can for example per-
form “silent editing” of audio in this mode.

Disabling audio on startup
• To disable audio on startup, hold down [Shift] while launching Cu-

base VST.
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Setting up MIDI
This section describes how to connect and set up MIDI equipment. If 
you have no MIDI equipment you can skip this section and move di-
rectly to page 73.

Connecting the MIDI Equipment
The descriptions below describe four setup examples for small MIDI 
systems. You might need or want to hook things up differently!

Example 1A – Using the same Keyboard for recording and 
playback, via a separate MIDI Interface

1. Connect the MIDI Out of the instrument to a MIDI In on the MIDI 
interface.
If you have several, it doesn’t matter which MIDI In you use. Cubase VST can 
record from all inputs on a multi-port interface.

2. Connect a MIDI Out on the interface to a MIDI In on the instrument.

MIDI In
MIDI Out
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Your MIDI interface may have more than one MIDI Out. Each MIDI port can 
address up to 16 different devices (or the 16 different voices in a multitimbral 
module ). On smaller MIDI interfaces, the Outputs all carry the same infor-
mation, so it doesn’t matter which you use. 

On larger, multi-port interfaces, the MIDI Outputs are all separate, that is, 
they carry different sets of the 16 MIDI channels. This allows Cubase VST to 
send MIDI data selectively to different MIDI channels on any of the available 
outputs. If you have a multi-port interface, you should connect the first out-
put to your instrument, and use the following outputs if you need to connect 
more instruments.

Example 1B – Using a Keyboard with a built-in MIDI 
Interface

If your instrument has a built-in MIDI interface, no MIDI cables are 
needed, only a serial cable (see the instrument’s documentation for ca-
ble specifications).

1. Make the connections with computer and instrument turned off.

2. Connect the cable between the printer or modem port on the com-
puter and the computer connection on the instrument.
Many instruments have a special switch that needs to be set for the computer 
connection to be active (see the instrument’s documentation).

The connection above allows you to feed the computer with the sig-
nals from the keyboard, during recording. It also allows you to send 
MIDI signals from the computer to the instrument during playback.

Computer Connection
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Example 2– Using a separate Keyboard and Sound Module

If you have a separate MIDI keyboard, that produces no sound, and a 
sound module without keyboard, you should hook things up as in the 
picture below. Using Cubase VST’s MIDI Thru feature (described 
later) you will still be able to hear the sound from the sound module 
while playing the keyboard and when recording.

MIDI In
MIDI Out
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Example 3 – Adding more devices using the MIDI Thru 
connectors on the instruments.

You might want to use more instruments for playback. Connect MIDI 
Thru on the first instrument to MIDI In on the next, and so on. In this 
hook-up, you will always play the first keyboard when recording. But, 
thanks to the Thru connection, you can still use all your devices for 
providing sounds on playback.

¶ If you plan to use more than three sound sources we recommend that you ei-
ther use an interface with more than one output, or a separate MIDI Thru box 
instead of the Thru jacks on each unit.

Setting up the Instruments
If you have a General MIDI, Roland GS or Yamaha XG compatible in-
strument, you may want to set it to its GM/GS/XG mode. If you have 
other types of instruments, set each Sound (Timbre, Part, Program, 
Patch) to receive on a different MIDI Channel.

MIDI In
MIDI Out
MIDI Thru
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Setting MIDI Thru and Local On/Off
In the “System” dialog on the Options - MIDI Setup submenu, you will 
find a setting called “MIDI Thru” which can be enabled or not. This is re-
lated to a setting in your instrument called “Local On/Off” or “Local 
Control On/Off”.

• If you use a MIDI keyboard instrument, as described in Example 1 earlier in 
this chapter, MIDI Thru should be activated and that instrument should be set 
to Local Off (sometimes called Local Control Off – see the instrument’s oper-
ation manual for details). This will let the MIDI signal from the keyboard get 
recorded into Cubase VST and at the same time re-routed back to the instru-
ment so that you hear what you are playing, without the keyboard “trigger-
ing” its own sounds.

MIDI In
MIDI Out

“Synth”

When “MIDI Thru” is active in 
Cubase VST, MIDI data received is 
immediately “echoed” back out.

When you press a key, 
it is sent out via MIDI 
to Cubase VST.

MIDI data coming in to 
the instrument is played 
by the “Synth” inside it.

When Local Control is On in the 
instrument, the keys you press will be 
played by the “Synth” inside the 
Instrument.
When Local Control is turned Off, this 
connection is cut off.
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• If you use a separate MIDI keyboard, that does not produce any sounds itself, 
as in Example 2, MIDI Thru in Cubase VST should also be activated, but you 
don’t need to look for any Local On/Off setting in your instruments.

• The only situation where MIDI Thru should be deactivated is if you use Cu-
base VST with only one keyboard instrument and that instrument cannot be 
set to Local Off mode.

Checking your MIDI Setup
1. Launch Cubase VST if you haven’t already done so.

2. Select a MIDI Track by clicking on its name in the Track list (to the 
left in the Arrange window).

3. Play your MIDI keyboard.

4. Check the “In” indicator on the Transport Bar so that you are sure 
that Cubase VST receives MIDI data.

5. If you have Thru activated, the “Out” indicator should indicate 
Output of data.

MIDI Tracks are indicated by the note 
symbol in the “C” column.

When this lights up, Cubase VST is 
transmitting MIDI data.

When this lights up, Cubase 
VST is receiving MIDI data.



CUBASE VST
Setting up your System 5 – 71

5
5
5
5
5
5
5
5

5
5

6. Make sure you hear the instrument that you are playing.
If not, check your MIDI connections and Cubase VST’s MIDI Thru setting. 
Also check the audio equipment and audio connections.

7. If you are playing a MIDI instrument with a built-in sound source, 
listen to make sure the instrument doesn’t sound “thin” or 
“flanged”.
If it does, you have probably not set the instrument to Local Off. This means 
that every key you press is played twice, once directly on the instrument and 
once via MIDI.

Saving the settings – “Save with Song”
Many of the dialogs in Cubase VST contain a checkbox labeled “Save 
with Song”. If this is activated, you have to save the Song to keep the 
settings you have made in the dialog. If the checkbox isn’t activated, 
this means that the settings you make will automatically be saved in 
Cubase VST’s preferences when you Quit.

Let’s say you set a “number of channels” value in the Audio Perform-
ance section of the System dialog, activate the “Save with Song” 
checkbox and save the Song. When you later open this Song, the 
“number of channels” is automatically set to the saved value.

If you deactivate “Save with Song” instead, the settings you make are 
written into Cubase VST’s preferences and the program is instructed 
to use the preferences for this setting in this Song. Next time you open 
the Song, the “number of channels” is set to the value in the prefer-
ences (which may be the value you saved or another value, saved later 
from another Song).
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For the audio and MIDI settings made in this chapter, the best choice 
is probably to save them in a Startup Song, so that you don’t have to 
redo them each time you launch Cubase VST. Proceed as follows:

1. Make sure all relevant “Save with Song” checkboxes are activated.
The “Save with Song” checkboxes are found together with the respective set-
tings. For example, you will find checkboxes in the Audio System Setup dia-
log and on each page in the Preferences dialog.

The “Save with Song” checkbox in the Audio System Setup dialog.

2. Pull down the File menu and select “Save As...”.

3. Click on the “Song” file type selector.

4. Make sure you save in the same folder as where you have your Cu-
base VST program.

5. Type in the name “Autoload” (make sure you type the name ex-
actly like that, but without the quotes of course!).

6. Click Save.
Now the next time you launch the program, the basic Song settings you just 
saved will automatically be loaded (see page 339).
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Preparations done! Where do I go next?
There are basically two things we suggest you do:

• Read through the rest of this book and try out the different possi-
bilities as you go along.

• Read the sections of the electronic documents that interest you, to 
get more detailed information about each section of the program.
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Recording Audio 6
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Preparations

Activating Cubase VST Inputs
Cubase VST allows you to use audio hardware with several Inputs and 
route different Inputs to different audio channels. This Getting Started 
book however, assumes you are using audio hardware with 2 in/2 out, 
such as the built-in audio on the Macintosh (or, if you have more ad-
vanced audio hardware, that you are using the first two Inputs only). 
Still, you need to make sure that these Inputs are activated before you 
attempt to record anything:

1. Pull down the Panels menu and select “Audio Inputs”.
The Input window appears:

The left column contains the available “physical” Input ports (in this case 
there are two Inputs). The fields in the right column show the names that will 
be used for each Input throughout the program. The middle column contains 
an indicator for each input pair, showing which Inputs are active.

2. Make sure that the indicator in the middle column is lit.
If not, click on it so that it lights up. This shows that the Inputs are active.

3. Close the Inputs window by clicking in its close box.

¶ Note that active Inputs use processing power! Make it a habit to only activate 
audio inputs which you actually want to use.

Read more about the Inputs in the chapter “The Input/Output Bus Sys-
tem” in the electronic documentation.
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Selecting Sample Rate and Input Source
Before you can start recording you have to set the sample rate and se-
lect an input source for the Song:

1. Pull down the Options menu and select “System...” from the Audio 
Setup submenu.
The Audio System Setup dialog opens.

2. Use the Sample Rate popup to select a sample rate.
This setting determines the audio quality of your recordings. The higher the 
value, the better the quality, but when you raise the value, each recording 
also uses up more disk space and computer processing power. For recordings 
where the audio quality is important, 44100 Hz is the most common sample 
rate. For multimedia purposes, or in situations where you want to keep the 
audio files small, 22050 Hz may be a better choice.

¶ This setting is done once and for all for the whole Song. You can not make 
some recordings at one sample rate and others at some other sample rate.

3. Click on the “Launch” button to open the ASIO Device Control 
Panel for the audio hardware.

¶ If you are using audio hardware other than the built-in Macintosh audio, 
there may not be an ASIO Device Control Panel, or the settings in the Control 
Panel may be different. For some types of audio hardware, you make settings 
in a special application program that comes with the card. Refer to the audio 
hardware documentation for details.
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4. Use the Source pop-up menu to select an input source.
When you are using the standard audio hardware of the Macintosh, you can 
usually choose between the built-in input jack and the audio from the inter-
nal CD-player. If you are using other audio hardware, there may be no input 
source selection at all.

5. Use the gain controls to adjust the input level, if necessary.
If you have connected your audio via an external mixer, it may be best to 
leave the gain controls in the Control Panel in a middle position, and adjust 
the output level of the mixer instead.

6. Close the Control Panel by clicking OK.

7. Close the System dialog by clicking OK.

Enabling 24 bit recording

If you are using the VST/24 version of Cubase, you will find an extra 
checkbox at the lower right corner of the System dialog, labelled “En-
able 24 Bit Recording”.

If you have audio hardware which supports 24 bit audio input and out-
put, you can activate this switch. Recording with 24 bit resolution will 
give you better sound quality and greater dynamic range. However, 
you should be aware that the audio files will be bigger (1.5 times the 
size of 16 bit files) and that the audio engine will require more proces-
sor power.

¶ A Song can contain both 16 and 24 bit audio files, with no limitations.
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Setting a tempo and time signature for the Song
Before you start you should decide for a tempo and time signature. 
These are both adjusted on the Transport bar:

Tempo tip

A good way of setting the tempo is to activate playback and adjust the 
tempo on the Transport Bar while listening to the metronome (Click) 
that is generated on each beat (quarter note). For the metronome to be 
heard, you need to make sure that the Click button on the Transport 
bar is activated:

¶ If you start playback with Click activated and still cannot hear the metro-
nome, you need to adjust the settings in the Metronome dialog on the Op-
tions menu (see page 131 to find out about the parameters and options in the 
dialog).

For now, make sure 
Master is not activated 
on the Transport bar.

The time signature determines the overall 
“feel” of the beat. 4/4, for example is often 
used in rock and pop. 3/4 is used for waltz.

The tempo determines the “speed” 
of the music. The number is in beats 
(quarter notes) per minute. 

Activate this to get a 
metronome. Use the 
Metronome dialog box 
(on the Options menu) 
to set up the type of 
click you desire.

For now, we recommend that 
you leave Cycle deactivated.

Click activated on the Transport Bar.
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Selecting and setting up a Track

About Stereo and Mono

Before you select a Track to record on, it is necessary to understand 
something about audio channels and how Cubase VST handles mono 
and stereo recordings: 

• All audio is played back via audio channels. The maximum number of au-
dio channels is determined by the settings in the Audio System dialog and 
your computer/hard disk performance. 

• Each audio channel can play back one mono audio recording at a time. 
• Stereo recordings play back on two audio channels, one for each “stereo 

side”. A stereo channel pair always consists of an odd channel and the next 
even channel (eg. channel 1+2, 3+4, etc).

• Channels that are used in stereo pairs cannot be used for mono recordings, 
and vice versa.

For more information on audio channels, see the chapter “How Cu-
base VST handles Audio and MIDI” in the electronic documentation.
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Setting Up

Set up a Track for recording as follows:

1. Select an Audio Track by clicking on its name field in the list.

• If you don’t have any empty Audio Tracks in your Arrangement, 
you need to create one, for example by using the Create Track item 
on the Structure menu. 

2. Set the Track's channel (Chn) to the audio channel you plan to 
record on.
If this is the first Audio Track you record on, select 1. Generally, you should 
avoid using a channel already used by another Track, since each channel 
can only play one recording at the time.

The “Any” channel setting is explained in the electronic documentation. For 
now, select a “normal” channel number.

¶ If you plan to make a stereo recording, you need to select an odd channel 
number.

An Audio Track.

To make sure the Track is an Audio 
Track, position the mouse in the “C” 
column for the Track, pull down the 
pop-up menu and select “Audio Track”.
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3. Open the Inspector.
This is done by clicking on the Inspector icon below the Track list.

4. If you want the recording to be in stereo, activate the Stereo 
switch in the Inspector.
If a lock symbol is shown in the button, you cannot switch mode for the 
Track. This can have several reasons:

Click on this icon...

...to open the 
Inspector.

The Track is set to Mono and cannot be 
switched to Stereo. This is either because 
the Track is set to an even channel, or 
because this or the next channel is 
already used for a mono recording.

The Track is set to Stereo and cannot 
be switched to Mono. This is because 
there is already a stereo recording on 
the Track.
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If you select Stereo for a Track, it will use the audio channel you selected for 
the left side of the stereo recording, and the next channel for the right side. 
These two channels are then reserved for stereo use, so that no mono Track 
can be set to any of these channels. For more information about this, see the 
chapter “Stereo, Multi Channel and Multi Track Recording” in the electronic 
documentation.

5. Double click on the Track name, type in a new name for the Track 
and press [Return].
Use names that correspond to the sounds or instruments you are going to 
record. This will make audio file handling easy later on, as audio files are 
usually named according to the Track names.

Now you need to make sure that the correct inputs are selected for the 
audio channel(s) you have selected:

6. Pull down the Panels menu and select “Audio Channel Mixer”.
The Audio channel mixer window opens.

7. Locate the “mixer strip” for the audio channel(s) you have selected 
for recording.
There is one mixer strip for each audio channel (the value you set in the Chn 
column for the Track on page 80 in this chapter). In the upper part of the 
strip, you find a button with the name of the Input selected for the channel.
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8. Hold down [Command] and click on the Input button to pull down 
a pop-up menu with the available Inputs.
In this example, we assume that you are using “regular” audio hardware with 
stereo inputs, but you may also have more advanced audio hardware with 
several inputs. 

Note that only activated Inputs will appear on this pop-up menu (see page 75 
for information about how to activate and deactivate Inputs).

9. Select the Input to which your sound source is connected.
If you have selected Stereo above, you need to select different Inputs for the 
two audio channels.

10.Go back to the Arrange window and click on the Record Enable 
button in the Inspector, to make the Track and its selected audio 
channel(s) ready for recording.
If this is the first time you enable audio recording in the Song, you will be 
asked to select a folder for storing your recorded audio files.
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Selecting a folder for your Audio Files
When you enable recording for the first time in a new Song, a file dia-
log box will appear, asking you for a folder for your audio files. The 
folder you select will be used to store all audio files recorded for the 
Song. If you have the opportunity, we recommend that you store your 
audio files on a separate hard disk (see the chapter “Optimizing Audio 
Performance” in the electronic documentation for more information 
on hard disk considerations).

• If you want to change folder for your audio files during the session, 
you can do this at any time by pulling down the Options menu and 
selecting “Audio Files Folder” on the Audio Setup submenu.
This opens the same file dialog, letting you select a new folder, which will be 
used from that point on.

About Audio File Names

When you record audio, the resulting audio file is named according to 
the settings in the Preferences–Audio dialog:

• If “Use Track Name as Basis” is selected, the audio file gets the 
name of the Audio Track.

• If “Use Inspector Record File” is selected, the audio file gets the 
name in the “Record Info” box in the Inspector.

This allows you to determine the name of the file before you record, by click-
ing on the Record Info box and entering a name.

• You can also choose to append the name of the Song or Arrange-
ment to the audio file name.
Audio files with the same name are automatically separated by numbers.
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Monitoring
As described on page 60, you can monitor via Cubase VST or directly 
via the audio hardware.

If you monitor via Cubase VST, and Record Enable a Track, monitor-
ing is usually automatically activated for that audio channel. This 
means that you will hear the audio source connected to the channel in-
put, when in Stop mode and when actually recording. 

• You can also turn “Cubase” monitoring on and off manually, by 
clicking on the Input button in the Audio Channel mixer window 
or in the Inspector.

¶ If you cannot get monitoring in Cubase VST to work at all, pull down the Op-
tions menu, select “System...” from the Audio Setup submenu, and check if 
the Global Disable monitor option is selected (if this function is enabled, Cu-
base VST will not provide monitoring at all). Select Tape Type monitoring, 
exit the System dialog and try turning monitor on in the Inspector again. The 
other monitoring options are described in the Menu and Dialog Reference 
document.
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Checking the Input Levels
Digital recording (as in Cubase VST) is different from analog record-
ing when it comes to recording levels. Whereas with analog recording 
it is often perfectly acceptable to let the “needle hit the red” (record at 
levels actually higher than the system can reproduce accurately), this 
is not true when it comes to digital recording.

The term used here is headroom. The headroom is the difference in 
level between the signal you record and the maximum level the system 
can handle. When the signal increases, the headroom diminishes to-
wards 0 dB (decibels). 

When the signal is stronger than the system can handle - when you ex-
ceed the available “headroom” - in a digital recording system, hard 
clipping occurs, which results in clearly audible and very unpleasant 
distortion. To avoid this, you should use the Input meter function in 
the Audio Channel mixer to accurately check the recording levels, and 
then adjust the input level in one of the ways described in step 4 below.

1. Pull down the Panels menu and select “Audio Channel Mixer”.
The Audio channel mixer window opens.

2. Click the “In” button (above the level meter for the recording 
channel) to activate the Input meter function.

In this mode, the meter shows the signal level at the input selected for the au-
dio channel. Note however, that all other settings (volume, pan, etc) relate to 
the output signals - it is not possible to set the Input Gain with the Volume 
fader!

• If you are making a stereo recording, activate the “In” buttons for 
both channels in the stereo pair.
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3. Sing or play the connected instrument and check the meter and the 
numeric level display above the fader.
The level should be as high as possible, without clipping (exceeding 0dB).

4. If needed, adjust the recording level in one of the following ways: 
• Adjust the output level of the sound source or external mixer.
• Use the audio hardware’s own application program to set the input levels, if 

this possibility is provided (see the documentation for the audio hardware).
• Click the ASIO Control Panel button in the Audio System dialog in Cubase 

VST and adjust the input level in the control panel that appears.
This requires both that your audio hardware supports the ASIO Control Panel 
function, and that there are input level settings in the control panel for the 
card.

5. When you are done, click on the “In” button again.
When the button is deactivated, the meters show the output level of each 
audio channel.

6. While you are in the Audio Channel mixer window, you may want 
to adjust the output level of the monitored channel.
Use the volume fader for the channel to set a comfortable listening level (this 
only works if you are monitoring through VST).

Clipping is indicated by the red 
clip light above the “In” button. 
To reset the clip indicator, click 
on it.
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Performing the first recording

Setting start- and end-points for the recording
There are several ways to start and end recordings. In this example, re-
cording will start at the position of the Left Locator and end at the 
Right Locator (for more info about this, see page 102).

To position the Locators, proceed as follows:

• Point at the Locator flags on the Arrange Window ruler and drag 
left or right.

or

• Hold down [Option] (Left Locator) or [Command] (Right Locator) 
and click on the ruler.

Recording
1. Make sure the buttons on the Transport Bar are set up like this:

2. Click the Record button.

3. After the two bar count-in, start performing.
Recording will automatically be deactivated when you reach the Right Loca-
tor, if you don’t hit Stop before that happens.

Dragging the Left Locator.
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4. When you are done, press Stop.
The program will now calculate an image file so that a waveform can be dis-
played in the program. Depending on the length of your recording, this may 
take a few seconds, during which a dialog box shows the progress of the cal-
culation.

The program has now created an audio file in the folder you selected 
on page 84 in this chapter. The file will appear in the Pool (a window 
containing a list of all audio used in the Song, see page 217). In the 
Arrange window, a Part is created between the start and end points of 
the recording. The Part contains an audio segment, which in turn plays 
back the whole audio file you just recorded.

• A segment is a piece of an audio file. Read more about audio files 
and segments in the chapter “How Cubase handles audio and 
MIDI” in the electronic documentation.

Listening to the Recording
1. To hear what you just did, use the Transport Controls to move back 

to the beginning of the recording and click Play.

2. Stop when you are done.
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If you don’t like what you just recorded
There are two ways you can get rid of a recording that you are not sat-
isfied with:

Using Undo

If after recording you select Undo from the Edit menu, the Part you 
just created will disappear and you can record again. However, the au-
dio file still resides on the hard disk and there is a segment for it in the 
Pool (see page 218 for details). You can always later delete unused 
segments and files, so this is nothing to worry about.

Deleting the Part

The other option is to manually delete the Part and then record again 
on the Track.

• If you delete the Part as you would with a MIDI Part, it disappears, 
but the segment and the audio file are not deleted (just as when 
you use Undo, see above).

• If you select the Part, hold down [Command] and press [Back-
space], a dialog appears, asking you if you also want to delete the 
audio file. To do this, click OK.
This is the method to choose if you are sure you want to delete the recording 
permanently.
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Recording more on the same Track
To record more on the same Track, proceed as follows:

1. Move the Left Locator to the next position where you want to start 
recording.
This can be at a “free” area on the Track, or at some place where something 
is already recorded, as described below.

2. Make sure the Right Locator is to the right of the Left Locator. If it 
isn’t, please move it.

¶ You cannot activate recording if the Locators are positioned in “reverse order”.

3. Activate recording just as you did the first time on the Track.
A new file is automatically created.

About overlap

When you record again where something has already been recorded 
on the Track, you will get a new Part which overlaps the previous 
one(s). However, when you play back, only the Parts that you can ac-
tually see are played back. Generally: One audio channel can only 
play back one audio file at the time.

Recording the Next Track - Overdubbing
Recording the next Track is done just as with the first. Here follows a 
summary of the steps:

1. Select another audio Track and make sure it’s set to another audio 
channel.

2. Make sure the Track is set to the correct audio Input.

3. Set up the Locators and activate recording.

Now, the previously recorded Tracks will play back and you are able 
to record the new Track as an overdub.
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About this chapter
In this chapter, you will learn how to make a basic MIDI recording. 

This chapter assumes the following:

• That you have connected a MIDI keyboard (or other controller) and some 
kind of MIDI sound source. As described in the examples in the chapter “Set-
ting up your System”, this could be a MIDI keyboard with a built-in sound 
source, or any combination of a MIDI controller and a sound module.

• That you are already familiar with Audio Recording as described in the previ-
ous chapter.

Tempo, Time Signature and Click
If this is your first recording in a new Arrangement, set up the time sig-
nature, tempo and Click as described on page 78 in this book.

Selecting and naming a Track
Tracks with a note symbol in the “C” column are for MIDI recording. 
An Arrangement can contain an unlimited number of Tracks.

1. Select a Track by clicking on its name in the list.

• If you don’t have any empty MIDI Tracks in your Arrangement, 
you need to create one, for example by using the Create Track item 
on the Structure menu. 
To make sure the Track is a MIDI Track, position the mouse in the “C” col-
umn for the Track, pull down the pop-up menu and select “MIDI Track”.

2. Double click on the Track name, type in the name you desire and 
press [Return].
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Setting MIDI Channel and Output

Setting the MIDI Channel in the Instrument

Most MIDI synthesizers can play several sounds at the same time, 
each on a different MIDI Channel. This is the key to playing back sev-
eral sounds (bass, piano etc.) from the same instrument.

Some devices (such as General MIDI compatible sound modules) al-
ways receive on all 16 MIDI Channels. If you have such an instru-
ment, there’s no specific setting you need to make in the instrument.

On other instruments you will have to use the front panel controls to 
set up a number of “Parts”, “Timbres” or similar so that they receive 
on one MIDI Channel each. See the manual that came with your in-
strument for more information.

Setting the MIDI Channel and Output in the Track List

1. Set the Chn column for the Track to the same MIDI Channel as you 
just setup to use on the synthesizer.

2. Drag the Track List Divider all the way to the right, to reveal the 
Output column.

Dragging the Divider...

...reveals the Output column
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3. Make sure the Track you plan to record on is set to the MIDI Out-
put that the synthesizer is actually connected to. If it isn’t, pull 
down the Output menu for that Track and select the desired MIDI 
Output.
If you only have one standard MIDI interface, that is limited to 16 MIDI 
Channels, then this setting is probably correct as it is. If you for example only 
have a standard MIDI interface on the Modem port, this should say “Mo-
dem”.

Selecting a sound
When you play your keyboard, you should now hear the sound that the 
instrument plays on this MIDI Channel (the Track’s “Chn” setting).

You can select sounds from within Cubase VST, by instructing the 
program to send Program Change messages to your MIDI instrument. 
The following general rules apply:

• Make sure your instrument is set to respond to Program Change messages.
• In Cubase VST, programs (sounds) are numbered 1-128. Your instrument 

may use a different numbering - refer to its documentation for details.
• If your instrument is General MIDI (GM) compatible, you can select sounds 

by name instead of by numbers.

Proceed as follows:

1. Open the Inspector.

2. Set a numeric Program Change value in the “Prg” field.

Clicking in the Output column brings up a 
pop-up which lists the available MIDI Outputs 
plus three items: Echo, Arpeggio and MROS 
(all described in the electronic documentation.
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If you have a GM compatible instrument and want to select sounds by 
name, proceed as follows:

3. Open the Preferences–General–Arrangement dialog.

4. Make sure that the checkbox “Use Inspector GM Names” is acti-
vated.

5. Click OK to close the Preferences dialog.
In the Inspector, you will find a value box labeled “GM Name” below the 
“Prg” field.

6. Click on the GM Name box and select an instrument name from 
the hierarchical menu that appears.

7. Play the keyboard to try out the new sound.
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Setting levels
While you can set volume, pan, etc from the Inspector, it is much eas-
ier to do this from the MIDI Track Mixer:

1. Pull down the Panels menu and select MIDI Track Mixer.
The MIDI Track Mixer window opens. This window contains “mixer strips” 
for all MIDI Tracks, which you can use to mix your MIDI sound sources, 
manually or automatically.

2. Locate the mixer strip for the Track you plan to record on.

3. Use the volume fader and pan control to set volume and pan for 
the sound.

¶ Again, note that your instrument must be able to respond to MIDI Volume 
and Pan messages for this to work. Refer to the instrument’s documentation.

If you have a MIDI Instrument compatible with the GS (Roland) or 
XG (Yamaha) standards, you can use the MIDI Track Mixer to control 
a lot of other parameters in your instrument. This is described in the 
MIDI Track Mixer chapter in the electronic documentation.

4. Press [Return] to close the MIDI Track Mixer window.

Pan Control

Volume Fader
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Verifying the Settings
Now when you play your keyboard you should hear the right sound in 
the synthesizer (and only that sound). If not, check the following:

• Is the Track set to the correct MIDI channel?
• Is the Track set to the MIDI Output the instrument is connected to?
• Do you have MIDI Thru enabled in Cubase VST?
• Do you have Local Off activated in your instrument (if needed and/or availa-

ble)?
• Do you have the correct sound selected in the synthesizer?

Recording
1. Set start and end points using the Locators, and decide if you want 

a Click or not, just as when recording audio.
If you pull down the Options menu and select “Metronome...” you can select 
whether you want an audio click from the computer (“Beep”) or a MIDI click, 
or both. The MIDI click settings are described on page 131.

2. Click the Record button.
By default, you will get a two bar count-in. This can be changed in the Met-
ronome dialog.

3. Perform the recording and press Stop.
A Part appears. 

You can now listen, Undo or record more on the same Track, just as 
with Audio Tracks.
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About overlap and the Overdub/Replace switch
MIDI Tracks are different from Audio Tracks when it comes to over-
lapping Parts. When you record again, where something has already 
been recorded on the Track, the result is determined by the setting of 
the Overdub/Replace switch on the Transport Bar:

Overdub

In this mode, the new recording is simply added to whatever was on 
that Track before. When you play back, you will hear both recordings. 
This can be used creatively when you are recording in Cycle mode, as 
described on page 114.

Overdub Mode is probably the safest way to record. If you add too 
much music, you can simply remove it later by editing (see the chapter 
“An Introduction to MIDI Editing”). Up until now, we have assumed 
that this switch was in Overdub mode.

Replace

In this mode, whatever you record replaces what was previously on 
the Track. Replace mode is probably the best choice if you have made 
a mistake and wish to correct it by recording something new.
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Recording different types of MIDI Messages
There are a few facts about the recording of some types of MIDI mes-
sages that can be useful to know. If you don’t know too much about 
MIDI you may not understand everything below. Later when you have 
gained a more thorough understanding, come back and read this infor-
mation.

Notes
In MIDI, when you press and release a key on your synth or other 
MIDI keyboard, a Note On (key down) and a Note Off (key up) mes-
sage are sent out.

The MIDI note message also contains the information which MIDI 
Channel was used. Normally, this information is overridden by the 
MIDI Channel setting for the Track. For more information about this, 
see the chapter “How Cubase handles audio and MIDI” in the elec-
tronic documentation.

Continuous Messages
Pitch bend, AfterTouch and Controllers (like modulation wheel, sus-
tain pedal, volume etc.) are considered as MIDI continuous Events (as 
opposed to the momentary key down and key up messages).

About recording Continuous Messages

If you move the Pitch Bend wheel on your synthesizer while record-
ing, this movement gets recorded together with the key (Note On and 
Note Off messages), just as you’d expect.

But the continuous messages can also be recorded after the notes have 
been recorded (or even before). They can also be recorded on Tracks 
separate from the notes they belong to. 
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Say for instance that you record one or several bass Parts on Track 2. 
If you now set another Track, like Track 55, to the same Output and 
MIDI Channel as Track 2 you can make a separate recording of just 
Pitch Bends for the bass Parts. This means that you activate recording 
as usual and only move the Pitch Bend wheel during the take. As long 
as the two Tracks are set to the same Output and MIDI Channel it will 
appear as if the two recordings were made at the same time.

Program Change Messages
Normally, when you switch from one Program to another on your key-
board (or whatever you use to record), a number corresponding to that 
Program is sent out via MIDI as a Program Change message. These 
can be recorded on the fly with the music, recorded afterwards on a 
separate Track, or manually entered in one of the Edit windows. You 
can also configure Program Change messages in the Inspector. 

System Exclusive Messages
System Exclusive (Sys Ex) is a special type of MIDI message used to 
send things that only make sense to a unit of a certain make and type. 
Every major MIDI manufacturer has its own Sys Ex identity code. Sys 
Ex can be used to transmit a list of the numbers that make up the set-
tings of one or more sounds in a synth. System Exclusive can be re-
corded just as any other messages and can be edited in List Edit.

This is discussed in more detail in the chapter “System Exclusive Han-
dling” in the electronic documentation.

¶ You can prevent Cubase VST from recording certain types of MIDI data, by 
using the Input Filter function. This is described in the chapter “Filtering and 
Mapping MIDI data” in the electronic documentation.
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About Punch In and Out
Those of you who have used multi-track tape recorders know about a 
technique called Punching In. This is when you activate recording 
while the tape is rolling. If you for example have made a mistake in 
the middle of a chorus, you can play back from the beginning of the 
chorus and just before the flawed section, punch in and replace that 
section with a new performance.

Punch Out is when you deactivate recording without stopping play-
back. If – in the example above – the chorus is followed by a verse 
which is perfectly OK, you would punch out at the end of the chorus 
so that you don’t record anything over the verse.

In Cubase VST there are two ways to Punch In and Out: Manual and 
Automatic:

Automatic Punch In
1. Select a Track and set it up as necessary (as with any other record-

ing).

2. If you are recording MIDI, decide if the new recording should re-
place what is currently on the Track (Replace mode) or if you want 
to add to it (Overdub mode).
This is done with the Rec Mode switch on the Transport Bar, as described in 
the previous chapter.

3. Set the Left Locator at the position where you want recording to be 
activated.

4. Move the Song Position to some point before the Left Locator.
This can for example be done by using the Transport buttons (Rewind, Fast 
Forward etc) or by changing the value in the Song Position box on the Trans-
port Bar. More info on page 134.
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5. Click on the Punch In button on the Transport Bar so that it is acti-
vated.

6. Activate playback.

Now, when the Song Position reaches the Left Locator, recording is 
automatically activated, as you can note by observing the Record but-
ton on the Transport Bar.

7. Record.

8. Terminate recording either by stopping or by Punching Out (see 
below).

Punch In activated.

1. Set the Song Position...

2. Activate playback...

3. When the program 
reaches the punch in point...

4. Recording is 
automatically activated!
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Manual Punch In
1. Select a Track and set it up as necessary (as with any other record-

ing).

2. If you are recording MIDI, use the Rec Mode switch to decide 
whether the new recording should replace what is currently on the 
Track or add to it.

3. Make sure Automatic Punch In on the Transport bar is not acti-
vated.

4. Move the Song Position to some point before the position where 
you want to Punch In.

5. Activate playback.

6. When you reach the right position, click on the Record button or 
press [*] on the numeric key pad.

7. Record.

8. Terminate recording either by stopping or by Punching Out (see 
below).

About punching in on long MIDI notes
When you activate recording in Cubase VST, already recorded MIDI 
notes are never cut off, they will play to their end just as they did be-
fore you started this recording. This is true regardless of the Record 
mode chosen (Overdub or Replace).

Punch In deactivated.
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About punching in on MIDI Controller or Pitch Bend data
Watch out when punching in and out on recordings with Pitch Bend or 
Controller data (modulation wheel, sustain pedal, volume etc), since 
this may lead to strange effects (apparently hanging notes, constant vi-
brato etc). 

If you for instance punch out with the sustain pedal on your synthe-
sizer down, you have instructed the program to keep the notes playing, 
since the release of the pedal has not been recorded. During playback, 
Cubase VST may clean up Pitch Bend, Modulation and Damper pedal 
and Channel Pressure at the end of each Part, taking into account what 
happened in earlier Parts. But, the way Continuous MIDI messages 
behave is still something to be aware of.
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Automatic Punch Out
1. Set the Right Locator to the position where you want recording to 

be terminated.

2. Click on the Punch Out button on the Transport Bar so that it is ac-
tivated.

3. Now, recording is automatically deactivated when the Song Posi-
tion reaches the Right Locator.

You can of course combine automatic Punch In and Out for a totally 
automated recording.

The Right Locator 
positioned

Punch Out 
activated

Activate recording.

When the Song Position 
reaches the Right Locator...

Recording is automatically deactivated, 
but playback continues.
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Manual Punch Out
1. Activate recording in any way you like.

You might for example combine manual Punch In and Out to fix an error in 
an otherwise good performance.

2. When you reach the right position, click on the Record button or 
press [*] on the numeric key pad.

3. If you like, Punch in again and record some more.

4. When you’re done, Stop Cubase VST.
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About the Cycle
Cubase VST can play back and record in a Cycle – a loop. You decide 
where the Cycle starts and ends by setting the Left and Right Locators. 
When Cycle is active you can repeatedly listen to a section of the Ar-
rangement, and record, adding more on each lap etc. Cycled playback 
is also convenient when editing and when making adjustments in the 
Inspector.

Setting up the Cycle
1. Set the Left Locator to the position where you want the Cycle to 

begin.

2. Set the Right Locator to the position where you want the Cycle to 
end.

3. Click on the Cycle button on the Transport Bar so that it gets acti-
vated, or use the corresponding key command (by default, this is 
[/] on the numeric key pad).

 

Set up the Left and 
Right Locator...

...and activate the Cycle.
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Playing back the Cycle
When you play back with Cycle activated, the section between the Lo-
cators gets repeated indefinitely.

You can use any and all functions while the program is playing back. 
This fact allows you to use Cycled playback for a number of things, 
many of which you will learn about later in this manual:

• Rehearse a part before recording.
• Mute Tracks and Parts to try out variations on an Arrangement.
• Concentrate editing in the Audio and MIDI editors to a certain section of the 

Song.
• Make adjustments in the Inspector, apply Quantize etc, to fine tune levels 

and grooves.
• Make settings in the Mixer, add EQ and Effects to Audio Parts.
• Make adjustments to the sounds in your MIDI instruments or try out a Track 

with another sound.
• etc, etc.
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Recording in Cycle Mode

¶ The basic Cycle recording procedure is the same for MIDI and Audio Tracks. 
However, the results are different, as described on page 113 in this chapter.

From the Left Locator

1. Set the Left and Right Locator and activate the Cycle button.

2. Set up a Track to record on.

3. If you are recording MIDI, select a Record Mode (Overdub or Re-
place) with the switch on the Transport Bar.
This is described on page 99.

4. Click the Record button.

5. After the count-in, start playing.

6. Keep playing on each lap of the Cycle until you are satisfied.
If you are recording MIDI, see the Cycled Recording Modes and Functions 
described below.

7. Stop Cubase VST or punch out manually.

Cycle On/Off
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From Before the Cycle

1. Set up the Cycle and activate the Cycle button.

2. Set up a Track to record on and select a Record Mode (Overdub or 
Replace).

3. Activate automatic Punch In on the Transport Bar.

4. Set the Song Position to some point before the Cycle.

5. Activate playback.

When Cubase VST reaches the Cycle, recording is automatically acti-
vated.

6. Keep playing on each lap of the Cycle until you are satisfied.
See the Cycled Recording Modes and Functions described below.

7. Stop Cubase VST or punch out manually.

¶ If you Punch In manually before the Cycle, the Cycle is automatically turned 
off!

Punching In and Out in the Cycle
Once you are in the Cycle you can punch in and out manually as many 
times as you wish without stopping in between. Simply click the 
Record button or use the corresponding key command (by default, this 
is [*] on the numeric keypad).

Punch In activated.
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About Recording Audio in the Cycle
If you are recording Audio in Cycle mode, the following happens:

During the entire recording, only one Audio file is created. However, 
this is split up into a number of Segments (one for each lap) which are 
“stacked” in the Audio Editor. Since the Segments are all on the same 
Track, this normally means that only one of them will play back (the 
last “take” you recorded). However, you can use this feature to assem-
ble a “perfect” take from all the different Segments, by cutting out the 
best pieces of each Segment and putting them together. This is de-
scribed in the chapter “The Audio Editor” in the electronic documen-
tation.

• None of the Cycle modes and Functions used when recording 
MIDI (described on the following pages) have any relevance to au-
dio recording.
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About Recording MIDI in the Cycle
Basically, MIDI Cycle Recording can either be used to add new data 
for each lap (overdub) or replace previously recorded data. However, 
there are a lot of special modes and functions available when record-
ing MIDI in the Cycle:

Switching Tracks while recording
You can record on more than one MIDI Track while in the Cycle:

1. Set up a few MIDI Tracks that you wish to record on. Also set up 
the instrument(s) so that they play the right sounds on these MIDI 
Channels.

A few Tracks set up for recording a four bar groove.

2. Enter recording in Cycle mode.
Record on the first Track.

3. Without stopping, select a new MIDI Track in the Track list or use 
the [↑ ] and [↓ ] keys to step through the Tracks.
Selecting a new Track set to a different MIDI Channel and maybe Output, au-
tomatically routes your playing to the new sound.

4. Record on this second Track as with the first.

5. Keep recording on different Tracks until you are satisfied.
See the Cycled Recording Modes and Functions described below.

6. Stop Cubase VST or punch out manually.
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Recording Sys Ex data in the Cycle
There is nothing that prevents you from Cycled recording of Sys Ex 
data (see the chapter “System Exclusive Handling” in the electronic 
documentation), although this can lead to serious confusion. In plain 
English: don’t, if you’re not absolutely sure of what you are doing.

Cycle Recording Modes

Switching Modes

On the Transport Bar you will find a small box labelled “Cycle Rec”. 
This is used to select one of four “behaviours” when recording in Cy-
cle Mode.

You can select any of the modes prior to, or during, recording.

¶ As always when you record, the regular Record Mode switch (Overdub/Re-
place) determines what happens with any MIDI data that is already on the 
Track before you start Cycle Recording. For an explanation of the relation 
between the Record Mode and the Cycle Recording Mode, see page 121 in 
this chapter.

The Cycle Rec Mode Switch
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Mix Mode

In Mix mode, everything you record is added to what was recorded be-
fore. This is the preferred mode if you for example are building up a 
rhythm pattern in Cycle mode. You can start with the hi-hat, add bass 
drum on the second lap, snare on the third etc.

Punch Mode

In this mode Cubase VST automatically punches in the moment you 
play anything on a lap. Proceed as follows:

1. Select Punch Mode.

2. Start Recording in a Cycle.

3. If you make a mistake in the middle of the Cycle, simply wait until 
you reach the correct position on the next lap, and start playing 
again.
What was previously recorded from this point to the end of the Cycle is re-
placed with what you play now.

4. When you have a recording you’re happy with, you can turn off 
Punch mode, Stop or Punch Out.

Record some notes on the first lap...

Whatever you record on the 
following lap(s) is simply added to 
the existing notes

Record some notes on the first lap...

Whenever you start playing on an 
upcoming lap, your new recording 
will replace the notes from that point 
and onwards.
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Normal Mode

The name Normal mode refers to the way Cubase VST behaves during 
normal (as opposed to Cycled) recording. This allows you to record 
afresh on the Track each time you enter the Cycle.

1. Decide if you want to overwrite earlier recordings on the Track or 
not, by selecting a Record Mode (Overdub or Replace).
See page 99.

2. Select Normal Cycled Recording Mode.

3. Record something on a lap.
You will not hear what you recorded, on the next lap(s).

4. If you’d like to redo the recording, simply try again on any upcom-
ing lap.
Everything you recorded on earlier laps is automatically deleted.

5. When you have a performance you like (a complete recording on a 
lap), stop recording or switch to another Cycled Recording Mode.

¶ Please note: a complete lap is only kept when the recording is stopped some 
time during the next lap.

Record some notes on the first lap...

If you play anything on any of the 
upcoming laps, it will totally replace 
your earlier recording.
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Add Mode

This is the Mode to select when you want to record several “takes”, 
and decide afterwards which one you want to keep. In Add Mode, 
each time a cycle is completed, a new MIDI Track is created, holding 
the latest “take” (provided you recorded something during the cycle). 
After finishing recording, you just need to listen to your takes and 
mute or remove all but the best one.

• If you activate the setting “Cycle Record (Add): Mute Previous 
Track” in the Preferences–MIDI–Others dialog, all Tracks but the 
latest are muted automatically.

• As an option, you can have Cubase VST create a Folder Track (see 
“Folder Tracks” in the electronic documentation) and put the 
Tracks with all the takes in this folder.
You can select whether you want this or not by changing the setting “Cycle 
Record (Add): Create Folder First” in the Preferences–MIDI–Others dialog.
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Cycle Recording Functions
These functions are found on a pop-up menu that appears when you 
press the mouse button with the pointer over the “Cycle Rec” text on 
the Transport bar, while recording in Cycle mode.

Delete Last Version

If you just made a mistake on the last lap, proceed as follows:

• While recording, select Delete Last Version from the pop-up menu 
or, by default, press [V] on the computer keyboard. 

This erases your last recording. It doesn't matter if you didn't play any-
thing for several laps, the last lap that you recorded anything on is 
erased.

Delete Subtrack

If you make a mistake and don't wish to keep anything of what you've 
just recorded, proceed as follows:

• While recording, select Delete Subtrack or, by default, press [B] on 
the computer keyboard.

The Part is cleared (but not deleted) and you can instantly start input-
ting music again, without leaving Record mode.
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Key Erase

To erase all notes played with a certain key, or keys, proceed as fol-
lows:

1. While recording, press and hold the relevant keys on the synth 
keyboard.

2. Select Key Erase from the pop-up menu or, by default, hold down 
[K] on the computer keyboard.

Quantize Last Version

Quantizing is a function you can use to let the computer correct impre-
cisely played notes to the next correct timing position, defined by you. 
Quantizing is not irrevocable, it can always be undone unless you spe-
cifically “freeze” your Quantize. Cubase VST provides several differ-
ent Quantize options, described on page 294.

If you want to Quantize everything you recorded on the last lap, pro-
ceed as follows:

1. Select a Quantize note value by using the Quantize pop-up at the 
top of the Arrange window.

2. On the Functions menu, use the Quantizing Type submenu to se-
lect which type of Quantizing you want to perform.
This selection remains until you select a new Quantizing Type. See page 294 
for a description of the different Quantizing Types.

The Quantize pop-up
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3. Select Quantize Last Version or, by default, press [N] on the com-
puter keyboard. 

Just as with Delete Last Version, it doesn't matter if Cubase VST has 
played back the Cycle several times since you last played anything, 
the last lap you recorded anything on is Quantized anyway.

About Cycled MIDI Recording and the Overdub/Replace 
Switch

As described on page 99, the Overdub/Replace switch is used to de-
cide if what you record now is added to whatever was on the Track be-
fore or whether it should replace the existing recordings.

The same is true for Cycled Recording:

• If Overdub is selected, everything you record is added to what was previ-
ously on the Track.

• If you select Replace mode, everything you record during one recording 
pass (the time from which you activate recording until you deactivate it 
again) replaces what was previously on the Track.

• The Cycle recording Modes and Functions described on the previous pages 
only apply to what is recorded during one recording pass. For example, 
the special Cycle Punch Mode does not delete any notes recorded on the 
Track before, only notes that were recorded in the Cycle this time.

1. Let’s say you have a Part already 
recorded.

2. You activate Cycled recording in 
Overdub Mode to add more notes.

3. If you now use the Cycle 
Mode Punch function, you will 
only replace the notes recorded 
during the Cycle recording pass.
The previously recorded notes 
are not affected.
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About Multi Recording
For both audio and MIDI, Cubase VST allows you to record on several 
different channels or Tracks at the same time. There are several uses 
for this:

• You can record several players playing “live” at the same time.
For this to be possible with audio recording, you would need audio hardware 
with at least as many separate inputs as there are players.

• You can record a MIDI instrument that transmits on several MIDI 
channels simultaneously.
In this case you could either simply record on one Track, and set the MIDI 
Channel to “Any”, in which mode the Track will play back each recorded 
Event on the MIDI Channel it was transmitted on. Or, you could use Multi 
Track recording, to automatically record different MIDI Channels on different 
Tracks.

• You can record MIDI and audio at the same time.
The “Any” Channel setting and the Multi Track Recording methods are de-
scribed in the chapters “How Cubase handles Audio and MIDI” and “Multi 
Track Recording” in the electronic documentation. 
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The Transport Bar
Below, you will find a brief description of what each control on the 
Transport Bar is used for:

¶ The pictures below show the Transport Bar in its default size and appear-
ance. However, you may change this, as described on page 126.

Activates Punch In

Switches between the 
four Cycle Recording 
modes (see page 115)

The Overdub/Replace switch 
(see page 99)

Record start point, Punch In point 
and beginning of Cycle

Cycle 
On/Off

Activates 
Punch Out

Handle
(move)

Punch Out point and 
end of Cycle

Song Position 
(Meter format)

Song Position 
(Time format)Position Slider

Rewind Fast Forward Stop Play Record

Indicates MIDI 
In/Out activity

Activates synchronization 
to other equipment

Tempo Time Signature

Turns the Metronome 
On/Off

Turns the Master 
Track On/Off

Activates automatic 
quantization during record Size/appearance 

selector
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Hiding and showing the Transport Bar
To hide the Transport Bar, either click its Close box or select “Hide 
Transport” on the Windows menu. To bring it back, select “Show 
Transport” from the Windows menu.

When the Transport Bar is hidden, you can still access all its functions 
via the computer keyboard. See below for a list of default Transport 
Bar key commands.

Moving the Transport Bar
You can put the Transport Bar anywhere you want it, by dragging the 
handles.

Changing the Size and Appearance of the Transport Bar
The Transport Bar has five different “looks”. To choose the one you 
prefer, proceed as follows:
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Switching between the three main “modes”

To toggle the Transport Bar between the three main layouts (large, 
small and vertical), click the zoom box in the upper right corner of the 
Transport Bar:
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Shrinking the Vertical Transport Bar

When the vertical Transport Bar layout is selected, you can click on 
the small arrows on each side to hide/show the upper and lower sec-
tions of the panel. This makes it possible to have a Transport Bar with 
only the absolutely necessary controls:

To make a hidden section visible, click on the respective arrow again.

¶ Please note that shrinking the Transport Bar this way actually removes some 
of the controls. Use this feature when you have no need for all Transport Bar 
controls (for example at mixdown) and want to see as much as possible of the 
other Cubase windows.

The Transport Bar with both the lower and the upper section hidden.

Click on this button to 
hide the upper section 
of the Transport Bar.

Click on this button to 
hide the lower section 
of the Transport Bar.
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The Numeric Key Pad
In the default key command setup (the one you got when you first 
started Cubase VST, or when you open the original Autoload that 
came with the program), the numeric part of the computer keyboard is 
used for many Transport Bar operations. Some of these are described 
in more detail later in this chapter.

By default, the Space bar also functions as Stop button.

num
lock = / *

7 8 9 –

4 5 6 +

1 2 3

0 , enter

Record 

Lower Tempo 

Raise Tempo 

Play 

Cycle On/Off Rewind 
Fast Forward 

Go to 

Go to 

Go To 

Go To 

Cue Point 

last Stop 

Left Locator 

Right Locator 

Stop 
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Basic Tempo and Time Signature Handling

Transport Bar and Master Track Tempo
There is actually a choice of two sources for Cubase VST’s tempo:

• When the song uses a steady tempo throughout, you can turn off the Master 
button and simply set the right tempo directly on the Transport Bar. The 
tempo can be adjusted at any time, even while playing back.

• When the song contains tempo changes, you need to use the Master Track, 
(which is Cubase VST’s tempo Track but also more!). For those tempo 
changes to actually “happen” on playback, the Master button on the Trans-
port Bar must be activated. This is all discussed in the chapter “The Master 
Track” in the electronic documentation.

Setting the Transport Bar Tempo
The tempo on the Transport Bar is adjusted like any other value (see 
page 45 in this book). The value is in BPM (Beats Per Minute). The in-
teger and fraction part can be adjusted separately, if needed.

The Tempo setting on the 
Transport Bar is used.

The Tempo settings in the 
Master Track are used.
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Setting up the Metronome Click

As mentioned earlier, you turn the metronome click on and off on the 
Transport Bar. You can also specify the volume of the click, whether 
you want to hear it on recording or playback, etc. These settings are 
made in the Metronome dialog, opened from the Options menu:

Click During

Use the three checkboxes in this section to determine whether you 
want the click to be heard during Precount (count-in), recording and/
or playback.

¶ The Click button on the Transport Bar still governs whether the metronome 
should be activated or not! However, if you deactivate all three checkboxes 
in this section, no click will be heard, even if you turn on the Click button.

Click activated on the Transport Bar.
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The Precount section

This sections of the dialog contains settings for the Precount, i.e. the 
count-in you get when you start recording from stop mode. The fol-
lowing parameters are available:

Precount Turns the Precount on or off. When this is deactivated, the other 
settings in this section are greyed out.

Bars Determines the length of the Precount. By default, this is set to 2 
bars.

From 
Mastertrack

This option is only relevant if you have set up tempo changes in 
the Master Track. See the electronic documentation.

Signature The time signature of the Precount.

Prerecord When this is activated, recording will start during the actual 
Precount. This works differently for audio and MIDI:

• When you record audio with Prerecord activated, recording 
will start slightly before the Left Locator. This helps you 
avoid cutting off the start of the recorded audio. The result-
ing Part will start one bar before the Left Locator.

• When you record MIDI with Prerecord activated, anything 
you play during the Precount will be recorded. The result-
ing Part will start from the bar in which you started playing.

Preroll Activate this if you prefer to hear the previously recorded music 
during the Precount, instead of a plain metronome count-in. For 
example, if you start recording on bar 5 with Preroll activated 
and the Precount length set to 2 bars, Cubase VST will play 
back from bar 3. When the song position reaches bar 5, record-
ing is activated.
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Audio Click

Activating this will give you an audio click, played back via the audio 
hardware. You can set the volume of the click in the value field below.

MIDI Click

Activating this checkbox will give you a MIDI click, played back on 
whatever MIDI instrument you have connected. The value fields in the 
section allow you to select which MIDI Channel and Output the click 
should be sent out to, as well as note number and velocity for the high 
note (the first beat in each bar) and the low notes (the other beats).
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Setting the Song and Time Position

Using Fast Forward and Rewind
The Song Position can of course be moved using Fast Forward or Re-
wind. If you hold down [Shift] while clicking the button, Rewind/FF 
is much faster.

By clicking in the Ruler
If you  click somewhere in the ruler, the Song Position Pointer is 
moved there.

By moving the Song Position in the Ruler
You can drag the Song Position Pointer directly in the ruler simply by 
pointing at the triangle, pressing the mouse and dragging left or right.

Dragging the Song Position.

Rewind Fast Forward

Click in the ruler... ...to move the Song Position Pointer.
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By using the Position Slider
The position slider is located on the Transport Bar. Drag the handle or 
click directly somewhere on the line to move the handle there.

The range of the slider relates to the length of your Arrangement. This 
means that if you drag the slider all the way to the right, the Song Po-
sition will appear at the end of the last Part.

Dragging the Position Slider.

About the Snap Value

When you change the Song Position in the ruler or by using the posi-
tion slider, something called “the Snap value” helps you find exact po-
sitions quickly. It does this by limiting the possible points for 
positioning, to Bar, half note, quarter note, etc (or to frames/seconds if 
you are working with time-based material). Snap can of course also be 
set to Off.

The Snap value is set with the Snap pop-up at the top of the Arrange 
window.
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Changing Position values on the Transport Bar
You can adjust the Meter or Time Position values on the Transport 
Bar, as described in the chapter “Basic Methods”. The Song pointer is 
moved accordingly.

Value Description

Off Any position can be used.

Bar Movement is restricted to exact bar lines.

1/2 to 1/16 Movement is restricted to the selected note values.

Frame, Seconds If you’re working with material that isn’t really tempo 
based (e.g. movie narratives, sound effects, etc) you may 
want your editing to snap to time positions instead of meter 
positions. As described on page 44, time positions are dis-
played as “hours:minutes:seconds:frames”. 
The last two items on the Snap pop-up menu allow you to 
snap your editing to seconds, for coarse adjustments, or 
frames, for detailed editing.

If Snap is set to Bar...

...Parts can only be dragged to 
exact bar lines.

If Snap is set to 1/4...

...Parts can be put on any 
quarter note position.
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Making relative Position changes
If you double click on either position value and enter a new one, pre-
ceded by a “+” or “–” character, the song position is moved relatively.

Returning to the beginning of the Song
If the Song is stopped and you click the Stop button again (or press the 
corresponding key command - by default [0] on the numeric key pad), 
the following happens:

• The Song Position is moved to the Left Locator.
• If the Song Position is already at the Left Locator or to the left of it, the Song 

Position is moved to the beginning of the Song.

This means that you can always click twice on the Stop button to re-
turn to the beginning of the Song.

...enter a value 
preceded by + or – ...

...and the value is 
added to the existing 
position.

Double click...
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Going to the last Stop Position
You can move the Song Position to the place you last stopped at, by 
pressing a key on the computer keyboard (by default the key [9] on the 
numeric keypad).

Moving to the Locators
If you click on one of the Locator labels (“Left Locator” or “Right Lo-
cator”) on the Transport Bar, the Song Position is moved to the corre-
sponding Locator. You can also do this by pressing a key on the 
computer keyboard (by default, [1] or [2] on the numeric keypad).

Using Cue Points
Cue points are used to quickly locate to any position. If you for exam-
ple often find yourself jumping to the beginning of the first chorus, set 
up that position as a cue point.

Programming Cue Points

1. Set the Song Position to where you want the Cue Point to be.

2. Hold down the [Shift] key and press any of the keys [3] to [8] on 
the numeric key pad.
The key is now programmed with that position.

Locating to Cue Points

If you press any of the keys [3] to [8] on the numeric key pad, the Song 
Position is moved to the position programmed for that key.

¶ Again, the key commands described above are the default ones. If you like, 
you can change these (see the Key Commands chapter in the electronic doc-
umentation). However, please note that Cue Points can only be programmed 
and recalled using key commands or Toolbar icons - there are no menu items 
for these.
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Using Markers
Another quick way to navigate in the Arrangement is to use Markers. 
There are several differences between Markers and Cue Points:

• Markers are really Marker Parts, that is, they have a start and end position. 
This means you can move Song Position and/or Locators to the Marker Posi-
tions.

• Markers can be named, making it easier to find the right one.
• Each Arrangement has its own Marker Track with a separate list of Marker 

Parts, while Cue Points are global (available in all Arrangements in the Song).
• You can have an unlimited number of Markers.

How to use Markers is described on page 176.
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Cueing

¶ This feature only works with MIDI Tracks.

Cueing is when you fast forward through the music while playing it. 
You might have done this on a tape recorder. The big difference with 
Cueing in Cubase VST is that the MIDI Tracks are played back with 
normal pitch.

1. Hold down [Command], point at the Fast Forward button and hold 
down the mouse button.

2. To change the speed of cueing, drag the mouse left/right while 
keeping the mouse button pressed.
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Locators

Setting the Locators by clicking in the Ruler
1. Set the Snap value.

The Snap value restricts the positions you can move the Locator to, as with 
the Song position, see page 135.

2. If you wish to position the Left Locator, hold down the [Option] 
key. To position the Right Locator instead, hold down the [Com-
mand] key.

3. Click somewhere in the ruler.
The Locator appears at that position. 

• You can also click and drag the Locator flags in the ruler.

Setting a Locator to the current Song Position
In the default key command setup, holding down [Shift] and pressing 
[1] or [2] on the numeric keyboard sets the Left or Right Locator to the 
current Song Position.

Hold down [Option] and click... ..to position the Left Locator.
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Setting the Locators on the Transport Bar
You can also adjust the Left and Right Locator position by changing 
the numerical values in the Locator boxes on the Transport Bar.

Making relative Position changes

Just as with positions (see page 137 in this book) you can double click 
and enter a new value, preceded by a “+” or “–” character. When you 
hit [Return] the Locator is moved relatively.

Setting the Locators by selecting Parts
You can adjust the Locator positions to the range of the currently se-
lected Part(s).

1. Select the Part(s).

2. In the default key command setup, press [Option]-[P].
The Locators are positioned around the selected “block”.

• You can also set the Locators to the start and end of a Marker Part 
on the Marker Track.
This is described on page 176.
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Pre-programming Locator Pairs
If you find yourself moving the Locators back and forth between the 
same positions all the time, you can pre-program some Locator com-
binations for instant recall. Again, the key commands described below 
are from the default key command setup:

1. Set up the Locators as desired.

2. Hold down [Option] and [Command].

3. Press one of the keys [1] to [0] on the “typewriter” part of the com-
puter keyboard (not the numeric keypad).
That key is now programmed with the current settings of the Locators.

Recalling Locator Positions

1. Hold down [Command].

2. Press the desired Locator key (by default, [1] to [0] on the “type-
writer” part of the computer keyboard).
The Locators are moved to the memorized positions.
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Using Time Positions in the Rulers
If you’d like to use Cubase VST as a time based program, rather than 
a meter (tempo) based one, you can change the position indicators in 
any window, as follows:

1. Locate the Mouse Position box.
In the Arrange window this is located on the Status Bar (the area directly 
above the ruler).

2. Click once in the box.
Now the ruler , the Mouse Position box and the Locator displays in the Trans-
port Bar all change to show time positions instead of meter positions.

3. To switch back to meter positions, click again.

¶ Please note that the Snap value does not automatically change when you 
switch to time position. You might want to set Snap to “Frame” or “Second” 
when you use time positions (see page 135).

The Mouse Position box

Time PositionsMeter Positions



CUBASE VST
9 – 145 Playback, Tempo and the Transport Bar



10
10
10
10
10
10
10
10

10
10

10

Working in the 
Arrange window 10



CUBASE VST
Working in the Arrange window 10 – 147

10
10
10
10
10
10
10
10

10
10

About Tracks, Parts and arranging
A Cubase VST Arrangement is roughly structured in three “levels”: 
Several Tracks, each containing a number of Parts which in their turn 
contain Events (audio recordings, MIDI notes, etc). This chapter is 
about Arrangement editing - in other words, the re-arranging of the 
larger building blocks, Parts and Tracks. This is done in the Track List 
and in the right part of the Arrange Window, the area called the Part 
Display.

An Arrangement with the Track List to the left and the Part Display to the right.

You can have up to 16 Arrangements in the same Song. How to create, 
open, close and ‘set aside’ Arrangements is described on page 175.

What can I do with Tracks?
The Track is one of the most basic concepts in Cubase VST. Every 
time you record something in Cubase VST, the recorded material is 
placed on a Track. You can have thousands of Tracks in each Arrange 
window, and you can easily move or copy material between Tracks (if 
the Tracks are of the same kind - see Track Classes, page 154).

The most obvious reason for putting the recorded material on different 
Tracks, is perhaps that you want to organize your music like an “en-
semble” with one Track for each orchestral Part, or “musical instru-
ment”. But there are also many other advantages of working with 
many Tracks.
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Creating Tracks
Create a new Track when you want to add another “layer” to your re-
cording. You might for example want to add another “instrument”, or 
make room for an alternate version of a part in your music. There are 
several ways to create a new Track:

By using the Mouse

• You can also create new Tracks by clicking in the Track list with 
the Pencil tool.
This requires that the option “Allow Tools on Tracklist” is activated in the 
Preferences–General–Arrangement dialog.

By using the Structure Menu
Selecting Create Track from the Structure menu will make a new Track 
appear below the currently selected Track. You may also use a key-
board short-cut (by default, [Command]-[T]) to accomplish the same 
thing.

About Track Classes

As already mentioned, there are several different types of Tracks in 
Cubase VST. When you create a new Track, it will get the same Class 
as the previously selected Track, but you can change this later if you 
wish (see page 154).

Double clicking in an empty 
part of the Track List... ...creates a new Track.
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Naming Tracks
If you start with an empty Arrange Window (with no Tracks), and cre-
ate a new Track, it gets the name “Track 1”. Next time you create a 
New Track, this gets the name “Track 2” and so on. You can rename a 
Track at any time, simply by double clicking on its current name in the 
Track List, and typing in a new name.

Selecting Tracks
If you want to record on a Track, change settings for it or perform an 
operation that affects a whole Track, the Track has to be selected for 
Cubase VST to “understand” which Track you wish to direct the ac-
tion to. The selected Track is also called the “active Track”.

There are two principal ways to select a Track:

• Click in the name field of the Track you want to select.

• Use the [↑ ] and [↓ ] keys on the computer keyboard to select the 
Track above/below the currently selected.

This Track is selected.

If you press the [↑ ] key...
...the Track above in the 
Track List gets selected.
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Changing the order of the Tracks
You can rearrange the Tracks in the list like this:

¶ All the Parts on the Track are moved with the Track.

1. Press the mouse button with the pointer on the Track you 
want to move. The pointer takes on the shape of a hand.

2. Drag the Track with the mouse button pressed. A dotted 
outline shows you where the Track will be placed.

3. When you release the mouse button, the Track is moved 
to its new position.
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Duplicating Tracks
You may make a copy of a Track and all Parts on it. 

1. Position the pointer on the name of the Track in the Track List.

2. Hold down [Option] on the computer keyboard and press the 
mouse button.

3. Drag the outline of the Track to an empty field in the Track List.

4. Release the mouse button.

A duplicate of the selected Track is 
created and placed, complete with Parts, 
at the bottom of the Track List.
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Resizing Tracks
Apart from changing the magnification of the whole Arrange window 
(see page 172), you can specify different vertical magnifications for 
different Tracks, or for different Track classes. For example, you may 
want the Audio Tracks displayed in a larger magnification than the 
MIDI Tracks, to better see the waveforms in the Audio Parts (see the 
section about Part Appearance on page 170). Proceed as follows:

1. Position the pointer in the Track List, at the lower edge of the 
Track you want to change vertical magnification for.
In our example, this would be an Audio Track.

2. Click and drag the lower edge of the Track, upwards to shrink the 
Track or downwards to enlarge it.

3. Release the mouse button.
Now, all Tracks of the same Class gets the specified height.

• To set the vertical magnification of a single Track, hold down [Op-
tion] and drag the edge of one Track to the desired height.

• To set all Track Classes to the same vertical magnification, hold 
down [Command] and drag the edge of one Track to the desired 
height.



CUBASE VST
Working in the Arrange window 10 – 153

10
10
10
10
10
10
10
10

10
10

Deleting Tracks
There are two ways to delete a Track and all Parts on it:

• Click with the Eraser tool on the Track in the Track list.
This requires that the option “Tools on Tracklist” is activated in the Prefer-
ences dialog (“More Prefs” section).

or

1. Make sure that no Part is selected, by clicking in some empty area 
in the Part Display.
This is to make sure that what you Delete will be a Track, not a Part. 

2. Press [Backspace] on the computer keyboard or select Delete 
Track on the Edit menu.

¶ If you change your mind, you can undo the Delete Track operation with the 
Undo option on the Edit menu.

Check that this menu 
item says “Delete Track”, 
not Delete Parts.
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Track Classes
There are different types of Tracks, called classes. In the column 
marked “C” in the Track List, a small symbol shows which class each 
Track has. 

How to select a Class for a Track

Converting a Track from one Class to another
If you have not recorded anything yet on a Track, you may at any time 
convert it to any class. Just select the new class from the menu as de-
scribed above. If there is something recorded on it you may not be able 
to select another class for the Track.

¶ In the rest of this manual, if nothing else is stated, an operation applies to all 
Track classes.

Press the mouse button 
with the pointer in the 
“C” column for a Track...

...to pull down a menu 
where you can select a 
Track Class.
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The Basic Track Classes

Audio Tracks Audio Tracks are used for recording and playing back 
audio.

MIDI Tracks MIDI Tracks are used for regular MIDI recording and 
editing.

Drum Tracks Just like MIDI Tracks, Drum Tracks contain MIDI 
Events, but Drum Tracks are tailor-made for use with 
the Drum editor. See the chapter “Drum Edit” in the 
electronic documentation.

Mixer Tracks Mixer Tracks can contain automation data for the Au-
dio Channel Mixer, the MIDI Track Mixer, or the MIDI 
Mixer (a window that lets you control the parameters 
on your connected MIDI devices, from inside Cubase 
VST). See the chapter “Mixing” and the separate docu-
ment “The MIDI Mixer and Mix Tracks”.

Group Tracks These are described in the chapter “Groups” in the 
electronic documentation.

Tape Tracks These are described in the separate document “Tape 
Tracks – Controlling Tape Recorders”.

Folder Tracks Folder Tracks works as “containers” for other Tracks. 
For example, you could collect all rhythm Tracks in 
one folder, or put different “takes” on the different 
Tracks in a folder. See the Folder Tracks chapter in the 
electronic documentation.

Style Tracks These Tracks are used with “Styles”, a kind of auto-
mated accompaniment patterns. See the separate doc-
ument “Style Tracks”.

Chord Tracks Chord Tracks contain information about chord 
changes. These chords are used by the Style Tracks, 
and in the Score editor in Cubase VST Score.
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About Parts
Parts are the containers for your audio and MIDI recordings. The use 
of Parts in Cubase VST makes it easy to get a quick overview of the 
arrangement, and to move, duplicate or delete sections of music. On 
the following pages you find a number of functions for working with 
Parts in the Arrange window.

• For more information about what you can do with Parts, see the 
chapter “The Arrangement-Working with Tracks and Parts” in the 
electronic documentation.

Creating Parts
Normally, Parts are created automatically when you record something, 
or when you drag or import files into the Arrange window (see page 
220 and page 342). However, there are situations when you might 
want to create an empty Part, and then fill it with Events in an editor. 
There are several ways to do this:

• Select the Pencil tool and draw a Part.
The length of the Part is restricted by the Snap value (see page 135).

• Set the Left and Right Locators to where you want the Part to start 
and end, pull down the Structure menu and select “Create Part”.
A Part is created on the active Track, between the Locators. 

• Double click with the arrow pointer between the Left and Right 
Locator.
A Part is created on the Track where you clicked, between the Locators. 



CUBASE VST
Working in the Arrange window 10 – 157

10
10
10
10
10
10
10
10

10
10

Naming Parts
When you record a Part, it gets the name of the Track. You can rename 
a Part at any time, using one of the following methods:

• Select the Part, open the Inspector and double click on the name 
field.
Type in a new name and press [Return].

• Hold down [Option] on the computer keyboard and double click 
on the Part.
A small name value box opens, where you can type in a new name. 

¶ For the name to be displayed in the Part, the Part Appearance option “Show 
Names” must be selected (see page 170).
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Selecting Parts
As with all elements in Cubase VST, you have to select a Part to be 
able to move, delete or in any way manipulate it. 

Selected Parts are indicated with dark colors and “inverted” Part names or 
Events.

Selecting a Part can be done in several different ways:

By clicking.

Clicking on a Part with the Arrow tool selects it, and deselects all other 
selected Parts.

By shift-clicking.

• If you hold down [Shift] and click on a Part, it is selected, but all 
previously selected Parts remain selected as well.
Note that shift-clicking on a selected Part will deselect it without affecting 
any other selected Parts.

• If you hold down [Shift] and double click on a Part, that Part and 
all following Parts on the Track are selected. 

• If you hold down [Shift] and double click on a Track, all Parts on 
the Track are selected.

By using the computer keyboard.

If a Part is already selected you can press the right arrow key on the 
computer keyboard to select the next Part on the same Track. The left 
arrow key selects the previous Part on the Track. 

Note that holding down [Shift] and using the arrow keys will add to 
the selection, i.e. previously selected Parts will remain selected.



CUBASE VST
Working in the Arrange window 10 – 159

10
10
10
10
10
10
10
10

10
10

By enclosing Parts in a rectangle.

1. Click somewhere with the arrow button in an empty area of the 
Part Display and drag the mouse with the button pressed. 
A dotted rectangle outline is shown.

2. Release the mouse button.
All Parts that were enclosed or “touched” by the rectangle, become selected.

• If you hold down [Shift] when you start to drag, you don’t have to 
point at an empty area, you can start with the pointer over a Part.

¶ Don’t confuse this with the Selection Range tool, which is used to make se-
lections independent of the Parts (see below).

...and drag the mouse with the button pressed. A dotted 
outline of a rectangle is shown.

When you release the mouse button, all Parts that were 
enclosed or “touched” by the rectangle, become selected.

Press the mouse button with the pointer 
somewhere in an empty part of the Part Display...
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Selecting Parts using the Edit menu
On the Edit menu you will find an item called “Select” which brings 
up a sub-menu with a number of options that allow you to select all 
Parts on a Track, all Parts in the Arrangement, to invert the current se-
lection etc (see the Menu and Dialog Reference document for a com-
plete description of the menu selection options).

• By default, you can also select all Parts by pressing [Command]-[A] on the 
computer keyboard.

Deselecting Parts
There are two principal ways to deselect already selected Parts:

• If you click in some empty area of the Part Display, all selected 
Parts get deselected.

• If you hold down [Shift] and click on a selected Part, only this Part 
gets deselected.
The other selected Parts remain selected.
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Using the Selection Range Tool
Sometimes you want to be able to make selections independently of 
the Parts. You may for example want to remove two bars in the middle 
of a Part, copy a cross-section of several Parts to another location, etc. 
Proceed as follows:

1. Select the Selection Range Tool.

2. Click and drag with the mouse button pressed, to create a selec-
tion rectangle around the objects you want to select.
The snap value is taken into account as usual.

• If you hold down [Option] while dragging, the selection rectangle 
will automatically span from the first Track to the last.
This is useful if you want to select a section on all Tracks.

3. If necessary, adjust the size of the selection range by dragging the 
left/right edges of the rectangle.

Now you can move, copy, delete or otherwise manipulate the Selec-
tion in various ways (see below). If you perform any Functions or 
Processing (see page 282), this will also affect the Selection only.
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To deactivate the Selection, click with the Arrow tool somewhere else 
in the Arrangement. 

• You can also use the Selection Range tool in conjunction with the 
Marker Track, to select all material within the boundaries of a 
Marker Part (on all Tracks). See page 184.
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Manipulating Parts and Selections

¶ When you are moving, duplicating or changing the length of Parts or Selec-
tions, the result of your actions depends on the Snap value, just as when 
moving the Song Position or the Locators (see page 134). 

Moving Parts
You can move one or more Parts to a new position on any Track of the 
same Class. Remember that the Snap value determines where you can 
place the Parts.

Press the mouse button with the pointer over the selected Parts you want 
to move. 

Drag the Parts to their new position...

...and release the mouse button. The Parts are moved. Note that the 
relative distances between the moved Parts are kept intact.
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Moving Selections
If you have made a Selection with the Selection Range tool, you can 
click with the Selection Range tool and drag the rectangle to a new po-
sition, just as when moving Parts:

The Selection is cut out from the existing Parts. New Parts are created where 
necessary.

Duplicating Parts or Selections
To duplicate Parts or Selections, proceed exactly as when moving, but 
hold down the [Option] key on the computer keyboard when you are 
dragging. You may move the duplicate to any position on any Track(s).

Other ways of duplicating Parts and Selections are to use Cut/Copy 
and Paste, or the Repeat function (Parts only). These functions are de-
scribed in the chapter “The Arrangement – Part and Track Operations” 
in the electronic documentation.
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Changing the length of Parts
You can change the length of one or several Parts in the following 
way:

1. If you want to change the length of several Parts simultaneously, 
select these.
The operation will affect all selected Parts.

¶ This requires that the option “Tools work on All Selected Parts” is activated in 
the Preferences–General–Arrangement dialog.

2. Select the Pencil tool from the Toolbox.

At this point, there are two different ways to do things:

3. Click at the outline of one of the selected Parts and drag the out-
line to set a new length.
This will move the endpoint of all selected Parts to the same position. 

or...

4. Hold down [Command] and drag the outline of one of the selected 
Parts in the same manner.
This will change the length of all Parts by an equal amount.

¶ If you make a MIDI Part shorter, all Events in the removed section of the Part 
will be erased!
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Splitting Parts
You can use the Scissors tool to split Parts:

1. If you want to split several Parts simultaneously, select these.
This requires that the option “Tools work on All Selected Parts” is activated in 
the Preferences–General–Arrangement dialog.

2. Select the Scissors tool.

As when resizing Parts, there are two ways to continue:

3. Click on one of the selected Parts.
All selected Parts are split in two, at the position where you clicked (taking 
the Snap value into account). The “new” Parts will have the same name as 
the original Parts.

or

4. Hold down [Command] and click on one of the selected Parts.
All selected Parts will be split at a position relative to the Parts’ startpoints:
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Joining Parts
Just as you can split Parts in two, you can use the Glue Tube tool to 
“glue together” Parts on the same Track. The Parts do not have to 
touch one another:

1. Select the Glue Tube tool.

2. Click on the first Part.
The Part is joined to the next Part on the Track. The resulting, longer Part will 
have the name of the first Part.

• Like with the other operations above, gluing affects all selected 
Parts.
This means you can select several pairs of Parts on different Tracks, and click 
with the Glue Tube tool on one of the “first” Parts to glue each selected pair 
together.

¶ This requires that the option “Tools work on All Selected Parts” is activated in 
the Preferences–General–Arrangement dialog.

• If you hold down [Option] and click on a Part with the Glue Tube 
tool, all the consecutive Parts on the Track will be joined into one.
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Monitoring the contents of a Part
With the Speaker tool, you can perform what is known as “Scrub-
bing”. This means that you can listen to the contents of each Part sep-
arately in Stop mode:

1. Select the Speaker tool.
From there on, the procedure differs for Audio Parts and MIDI Parts:

2. To monitor the contents of an Audio Part, click anywhere in the 
Part.
You will hear the contents of the Part played back, from the point where you 
clicked, for as long as you keep the mouse button pressed (or until the end of 
the Part).

3. To monitor the contents of a MIDI Part, drag the pointer forwards 
or backwards over the Part.
Notes and other MIDI Events will be played back according to how fast you 
drag the pointer.
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Deleting Parts
There are several ways to get rid of unwanted Parts.

• Select them and press [Backspace] on the computer keyboard.

• Select them and use Delete Parts on the Edit menu.

• Click on the Parts with the Eraser tool.
If you hold down [Option] when you click, the Part and all the consecutive 
Parts on the Track will be deleted.

¶ Deleting an Audio Part will not erase the actual audio file or the segment in 
the Pool! 
To delete an Audio Part and erase the corresponding audio file from the hard 
disk, select the Part, hold down [Command] and press [Backspace].
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Part Appearance and Color
By using the Part Appearance submenu on the Options menu, you can 
choose how the Parts should be displayed in the Part display. The set-
ting is global for all Arrangements in the Song.

There are three options: 

• Show Names.
The Parts are displayed as boxes with the Part names.

• Show Events.
Each Part is displayed as a box containing a graphical representation 
of the Events in the Part. For MIDI Parts, you may define which types 
of Events should be displayed, by turning on and off the flags in the 
Part Appearance sub menu.

Events shown in Audio Parts and MIDI Parts.

¶ You may activate both these options (in which case both names and Events 
are shown) or none (in which case the Parts are displayed as empty boxes.

• Use Track Settings.
When this option is selected, you can set Part appearances independently for 
individual Tracks, or for all Tracks of a certain Track Class, separately for 
each Arrangement. The selection is done in the Appearance column in the 
Track List, as described on page 208.
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Part Color
To distinguish Parts, you may give them different colors. By default, 
you have a choice of 6 colors, but you can easily edit these or add 
more colors if you like (see the electronic documentation).

Adding Color to all Parts on a Track

1. Make sure no Parts are selected.

2. Select the Track in the Track list.

3. Select the desired color from the Part Color pop-up.

Adding Color to some Parts

1. Select the Parts.

2. Select the desired color from the Part Color pop-up.

Selecting different colors for different Parts can be very useful if you 
want to edit several Parts in a MIDI Editor. As described in the chapter 
“The MIDI Editors-General Information” in the electronic documen-
tation, you can then choose to display the Events in the color of their 
respective Part, making it easier to distinguish the different Parts.

The Part Color pop-up 
is found above the Part 
Display.

Choosing one of the colors from the 
menu adds color to the Parts.

Click here to edit the colors and names.
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Using the Magnifying Glass Tool
As described on page 49 you can use the magnification controls in the 
lower right corner of all main windows to change magnification. In the 
Arrange window, you also have the option to use the Magnifying 
Glass.

The Magnifying Glass can be used in the following ways:

• Click in the Part Display to increase magnification one step.

• Hold down [Option] and click in the Part Display to decrease mag-
nification one step.
When you press [Option] the Magnifying Glass will be shown with a minus 
sign.

• Drag with the Magnifying Glass to set a custom magnification.
A dotted rectangle is shown when you drag. When you release the mouse 
button, the contents of the rectangle will be magnified to fit the Part Display. 

• If you have set a custom magnification, you can hold down [Op-
tion] and click with the Magnifying Glass to return to the previous 
magnification.
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Managing the Arrangements
As stated earlier, you can have up to 16 Arrangements in one Song. 
This section describes some functions used to handle Arrangements.

Creating a new Arrangement
You create a new Arrangement by pulling down the File menu and se-
lecting “New Arrangement”.

Naming an Arrangement
To keep track of the different Arrangements in a Song, you can give 
names to each, simply by double clicking on the Arrangement name in 
the Title bar, and typing in a new name.

¶ For this to be possible, the “window shade” feature of the Mac OS must be 
deactivated!

• If you choose to save an Arrangement to disk as a separate file, 
then the name you give it while saving will be used as the Arrange-
ment’s title next time you load it.
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Activating an Arrange Window
Normally, if you want to work in the Arrange window, you click on it 
to activate the window and bring it to front. However, if you have a lot 
of Arrangements in your Song, some of them might be obscured and 
impossible to activate this way. Then you can use the following 
method instead:

1. Pull down the Windows menu.
At the bottom of the menu, you find a popup with all Arrangements in the 
Song:

2. Select the desired Arrangement from the list.

Saving and Opening Arrangements
The basic file format for Cubase VST is the Song file, but you can also 
save and open Arrangements separately, using the “Save As” and 
“Open” commands on the File menu. This makes it possible to trans-
fer recordings from one Song to another: Save the Arrangement con-
taining the recordings, open the other Song and open the Arrangement 
you saved.

• Read more about Saving and Opening on page 328.
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Closing an Arrangement
If you select Close on the File menu or click on the window’s Close 
button, the following alert message will appear:

Select one of the following options:

• Save.
Opens a file dialog where you can save the Arrangement for later use. After 
saving, the Arrangement is closed.

• Don’t Save.
Closes the Arrangement without saving it.

• Set Aside.
The window is closed, but the Arrangement is kept ,“hidden” in the Song. To 
open a Set Aside Arrangement, pull down the Windows menu and select it 
from the Arrangement popup menu there.

• Cancel.
Cancels the operation, i.e. the Arrangement is not closed.

¶ Please note that there is no “Close Song” command! Even if you close all Ar-
rangements, the Song is still there. To create a new Song, use the “New 
Song” command on the File menu.
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The Marker Track 11
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About the Marker Track
The Marker Track is a “special” Track, used for defining and “mark-
ing” different sections of an Arrangement. This is done by creating 
Marker Parts, to which you can quickly move the Locators and Song 
Position. Marker Parts are handled much like regular Parts, but with a 
few differences which are described in this chapter.

Showing and Hiding the Marker Track
• In the Arrange window, click on the Marker button to display the 

Marker Track.
The button is highlighted and the Marker Track appears above the ruler in the 
Arrange window.

You can always navigate to the Marker Parts, even if the Marker Track 
isn’t visible (see page 183). However, to be able to create and edit 
Marker Parts, you must see the Marker Track.

• To hide the Marker Track, click the Marker button again.

The Marker button, activated.

The Marker Track here 
some Marker Parts.
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Creating Marker Parts
1. Select the Pencil tool.

2. Draw a Part in the Marker Track.

When you release the mouse button, a name box is automatically opened.

3. Type in a name for the Marker Part, or click [Return] to keep the 
default name.
The Marker Part appears. Just as regular Parts, its length is adjusted to the 
closest Snap value.

• To avoid resizing existing Marker Parts, hold down the [Com-
mand]-key when you draw.
This disables resizing, and ensures that a new Part is created. However, note 
that Marker Parts cannot overlap. If you try to draw a new Marker Part that 
starts “within” an existing Part, the first Part will be resized to end at the start 
position of the new Part.
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Renaming Marker Parts

To rename a Marker Part, press [Option] and double click on it. A 
name box opens, in which you can enter a name.

Entering Comments for a Marker Part

If you double click on a Marker Part, a basic text editor is opened. You 
can for example use this to enter comments about a specific section of 
a Song etc.

If you press [Command] and draw a new Marker 
Part, starting here...

...and ending here...

...the first Marker Part is resized, so that it ends at 
the start position of the new Part.
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Editing Marker Parts
In most cases Marker Parts are handled just like regular Parts as de-
scribed in the chapter “Working in the Arrange window”, on page 156. 
Therefore, we will only describe the differences here.

Overlap

Marker Parts cannot overlap. However, you can move a Marker Part 
past another if you want to rearrange the different Parts.

Using Tools

The following tools can be used with Marker Parts. Note that the Snap 
value applies as with regular Parts:

The other tools cannot be used with Marker Parts.

Tool Use

Arrow Use the Arrow tool to move Parts. If you hold down [Option] 
when you move a Part, a copy is created.

Pencil Use the Pencil tool to resize existing Marker Parts, and to create 
new ones (as described above).

Eraser Click with the Eraser tool to delete a Marker Part. If you hold 
down [Option] when you click, that Part and all the consecutive 
Marker Parts will be deleted.

Scissors Click with the Scissors tool to split the Marker Part in two. If you 
hold down [Option] when you click, the Part will be split into 
many Parts with the same length (the length is governed by 
where in the Part you clicked).

Glue Tube Click with the Glue Tube tool on a Part to join it to the next Part. 
If you hold down [Option] when you click, all consecutive Parts 
will be joined into one.

Selection 
Range

This is described on page 161.
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Selecting several or all Parts on a Track

It is not possible to select the entire Marker Track like you can with 
other Tracks. Neither can you click and drag to select several Marker 
Parts. If you want to select several or all Parts on the Marker Track, 
hold down [Shift] and click on one at a time, or hold down [Shift] and 
double click on one Part (this will select that Part and all consecutive 
Parts).
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Navigating to Marker Parts
You can move the Locators and/or the Song Position in relation to the 
Marker Parts, either by clicking directly on the Marker Parts or by us-
ing the Marker pop-up menu.

By clicking
• Clicking on a Marker Part moves the Song Position to the begin-

ning of the Marker Part.

• Holding down the [Command]-key and clicking on a Marker Part 
moves the Locators to the beginning and end of the Marker Part.

• Holding down the [Option]-key and clicking on a Marker Part 
moves the Song Position to the beginning of the Marker Part and 
the Locators to the beginning and end of the Part.

Click on a Part...

...and the Song Position is moved 
to the beginningof that Part.

If you hold down [Command], 
the Locators are moved to the 
boundaries of the Part,.

If you hold down [Option], 
both Song Position and 
Locators are moved.
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By using the Marker pop-up menu
It is also possible to move the Locators and/or the Song Position by se-
lecting a Marker Part from the Marker pop-up menu. The advantage of 
using this method is that you don’t actually need to see the Marker 
Part you want to navigate to. This method is also possible to use from 
windows other than the Arrange window.

Displaying the Marker pop-up menu

There are two ways to do this:

• In the Arrange window, point at the triangle next to the Marker 
button an press the mouse button.

• In any window, hold down [Control] and [Option] and press the 
mouse button anywhere.

The Marker pop-up, here involed from the Arrange window.

Navigating from the pop-up menu

• Selecting the name of a Marker Part in the Marker Track pop-up 
menu moves the Locators to the beginning and end of the Part.

• Holding down the [Command]-key while selecting the name of a 
Marker Part moves the Locators to the beginning and end, and the 
Song Position to the beginning of the Part.

• Selecting the start or end positions of a Marker Part moves the 
Song Position to the beginning or the end of the Part.
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Using Marker Parts to make selections in the 
Arrange window

Besides enabling you to quickly move the Locators and the Song Po-
sition, Marker Parts can be used in conjunction with the Selection 
Range tool to make range selections in the Arrange window. This is 
useful if you quickly want to make a selection that spans all Tracks in 
the Arrangement:

• Click on a Marker Part with the Selection Range tool.
This selects everything in the Arrange window located inside the start and 
end position of the Marker Part, just as if you had used the Selection Range 
Tool to draw a rectangle. Any Functions or Processing you perform will now 
affect the selection only.

In this example, Verse 1 has been selected with the Selection Range tool.
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Moving and Copying Parts

This is a quick way to move or copy complete sections of the Arrange-
ment (on all Tracks):

1. Click on a Marker Part with the Selection Range tool.
Everything in the Arrangement within the Marker Part boundaries is selected.

2. Drag the Marker Part to a new position.
The selection in the Arrange window is moved to the same position.

• If you hold down [Option] while you drag the Marker Part, the se-
lection in the Arrange window is copied instead.



12
12
12
12
12
12
12
12

12
12

12

Play Parameters, Part 
and Track settings 12
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What are Play Parameters?
Play parameters are settings for Parts or Tracks, that affect the outgo-
ing MIDI data. This means that the Play parameters will affect the ma-
terial during playback - they do not really change the recorded data.

This also means that Play Parameter settings, such as transposition, 
are not shown when you edit a Part. To make these settings permanent 
you need to use the Freeze Play Parameter item on the Functions 
menu, as described on page 212.

There are two main uses for Play parameters:

• Change one or several aspects in the playback of your recorded 
music (like volume, velocity, pitch, selected sound, etc).
These changes are easily reversible as they are made to what is played back, 
not to what has actually been recorded.

• Change your music in real-time - i.e. while you play - for instance 
have it transposed. 
This is done in connection with the Thru-function in Cubase VST and we call 
it Realtime Thruing (see page 213). 

When you play back notes from a Part...

...they “pass through” the Play 
Parameter settings (in this case, the 
Transpose parameter set to 7)...

...and are output, in this 
example transposed one fifth 
(i.e. seven semitones) upward.

The actual recorded material in the Part is not affected.
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¶ Two parameters are available for audio material as well: Volume and Pan. 
These are really “mirrors” of the volume and pan controls in the Audio Chan-
nel Mixer (see page 301), and thus always affect volume and pan for a whole 
audio channel. 
In other words, you cannot make different volume settings for different Audio 
Parts on the same Track, like you can with MIDI Parts.

Other settings for Parts and Tracks
Some settings in the Arrange window do not affect playback, but have 
more general purposes. Examples would be Part and Track names, 
Track Class, etc. Since you will find these settings together with the 
Play Parameters, they are described in this chapter as well.
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The three ways of making settings
There are three methods to access the Play Parameters: in the Track 
columns, in the Inspector or using Tools. Some parameters are only 
available with one or two of these methods. On the following pages, 
each of the three methods is described, while the actual settings and 
parameters are described on page 202.

About the “Graphic” Controls

Most parameter values are displayed and edited numerically. How-
ever, for the parameters Volume, Pan and Transpose you can choose 
whether you want to set values numerically or graphically (default). 
This selection is done in the Preferences–General–Miscellaneous dia-
log.

• If “Change Volume with Slider” is activated, the Volume setting 
will appear as a horizontal slider.
This is the default mode. You change the value by dragging the slider “han-
dle” (press [Shift] to make fine adjustments).
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• If “Change Pan with Slider” is activated, the Pan setting will ap-
pear as a horizontal slider.
This is the default mode. You change the value by dragging the slider “han-
dle” left (pans the sound left) or right (pans the sound right). To place the 
sound in the center of the stereo image, drag the slider to its center position. 
Press [Shift] to make fine adjustments.

• If “Transpose with Mini Keyboard” is activated, the Tranpose set-
ting will appear as a small keyboard display.
This is the default mode. You change the amount of tranposition by pointing 
at a key. The yellow C key in the middle represents zero transposition.

Please note that the maximum transpose range is limited when you use this 
graphic representation. To be able to transpose over a wider range, deacti-
vate “Transpose as Keyboard” (or double click and type in a transpose value 
numerically).
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Using the Track Columns
Up to 19 Play Parameters and Track-specific settings can be displayed 
in the Track Columns. Since displaying them all would make the 
Track Columns cover most of the screen, its most practical to display 
only the settings you are actually using, and hide the others.

To see all displayed columns, you may have to drag the Divider to the right.

Displaying a Parameter in the Track Columns
To display a certain parameter in the Track Columns, proceed as follows:

1. Position the pointer in the heading of a Track Column and press 
the mouse button.
A pop-up menu appears, listing all available parameters.

The currently shown parameters 
are indicated with a check mark 
in the list.
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2. Select the parameter you want to display.
When you release the mouse button, the parameter will appear in a Track 
Column of its own, to the left of the column you clicked on. You can move 
the column later if you wish (see page 192).

• To remove a Parameter from the Track List, pull down the pop-up 
menu and select the Parameter again.
The column is hidden.

Changing a value in a Track Column
The methods you use to change a value in a Track Column differ de-
pending on the type of parameter: For numeric settings you use stand-
ard value editing (see page 45), while you edit names by double 
clicking and typing. Some parameters are set using a pop-up menu.

Moving Track Columns
You can rearrange the Track Columns so that they appear in any order: 

1. Position the pointer in the heading of the column you want to move.

2. Hold down [Command] and press the mouse button.

3. Drag the column to its new position and release the mouse button.
The column is moved.

Name type field 
(double click and edit)

Slider type field 
(click and drag)

Pop-up type field 
(click and select)

Numeric field 
(see page 45).
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Storing your Track Column layout as a Track View
Often it is practical to be able to quickly switch between a minimum 
number of Track columns (for editing in the Part Display) and a view 
with a lot of columns (for setting Play parameters). The best way to 
accomplish this, is to store your desired Track Column layouts as 
Track Views. Proceed as follows:

1. Configure the Track Columns as you want them.

2. Hold down [Option] and click in the Track Column heading area.
A pop-up menu appears.

The Track View pop-up menu.

3. Select “Store View...” from the pop-up menu and enter a name in 
the dialog that appears.

To make one of your stored Track Views active, pull down the pop-up 
menu again and select the Track View from the list at the bottom.

The Track View pop-up menu with three stored Views.

Read more about Track Views in the electronic documentation.
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Using the Inspector
The Inspector is a part of the Arrange Window. It contains a number of 
value- and name fields, where you can edit Play Parameters and other 
settings. The contents of the Inspector vary for different Track 
Classes, and sometimes also depend on other settings (for example, an 
Audio Track set to channel “Any” has different Inspector parameters 
than an Audio Track set to a regular channel).

On the following pages you will find descriptions of how to open and 
make settings in the Inspector, while the actual settings and parame-
ters are described on page 202.

¶ For Audio Tracks, the Inspector is also used for setting up the Tracks for re-
cording, as described on page 79.
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Getting the Inspector to appear
You open the Inspector by clicking on the Inspector Icon below 
the Track column. An area to the left of the leftmost column in the 
Track list appears.

• To close the Inspector, click on the Inspector Icon again.

...to open the 
Inspector.

Click on the 
Inspector Icon...
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Opening the Extended Inspector
If you click on the arrow in the top right corner of the Inspector, it is 
extended to the right, displaying further parameters (for MIDI Tracks 
only).

• You can hide the extended Inspector area by clicking the arrow 
button again.

Click the arrow button... to open the extended 
Inspector area.
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Changing values in the Inspector
By changing values in the Inspector, you make changes to your Parts 
and Tracks. Some fields are duplicates of fields in the Track list, Audio 
Channel Mixer or MIDI Track Mixer, while others can be found only 
in the Inspector. To get a basic grip of how to use the Inspector, follow 
the example below:

1. Open the Inspector.

2. Select a MIDI Track on which you have recorded some music.

3. Check that no Parts are selected.
The heading of the Inspector should read “Trackinfo” and the parameter val-
ues should be displayed in black - otherwise, just click on an empty area in 
the Part Display.

4. Start playback.

5. While the music is playing, try changing the "Transpose" and "Vol-
ume" values in the Inspector.
The transposition and volume of the played back music will change accord-
ingly.

Making Real-time changes with the Inspector
When you change the value of a parameter in the Inspector, the new 
value is immediately sent out to the MIDI Output. This will affect not 
only the sound source assigned to the selected Track, but all MIDI de-
vices connected to the same Output as the Track, and set to receive on 
the same MIDI Channel.

You may use this feature for setting appropriate values (e.g. volume, 
velocity etc) while the music is playing, even though this is probably 
easier to do in the MIDI Track Mixer (see page 316).
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What is affected by the Inspector?
This depends on what is selected in the Arrange window. The follow-
ing possibilities exist:

When a Track, but not a Part, is selected

When no Parts are selected, the Inspector has the heading “Trackinfo” 
and the parameter values are displayed in black. The parameter values 
affect the selected Track, and all the recorded material (the Parts) on it.

The Inspector opened for the Track “Gtr”.

There is one exception to this: If you change the Program Change, 
Bank Select, Volume or Pan settings for a Track, only the first Part on 
the Track is set to the values you enter. All following Parts are set to 
“OFF”. This is to avoid that the same MIDI message is sent out over 
and over again unnecessarily.

• If you hold down [Option] when making settings for a Track this 
way, a dialog appears, asking if you want to apply the settings to all 
Tracks in the Arrangement.
If this is what you want, click “Yes”, otherwise click “No”. There is also an 
option called “Same”, which applies the settings only to those Tracks that 
had the same value originally. 
For example, if you change the MIDI Channel for a Track from 2 to 3 while 
holding down [Option], and select “Same”, all Tracks set to MIDI Channel 2 
will be set to channel 3.
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One Part is selected

The Inspector has the heading "Partinfo" and the parameter values are 
displayed in red. The parameter values affect the selected Part only.

The Inspector opened for the Part “Solo”.

Two or more Parts are selected

The Inspector has the heading "Partinfo", and shows the parameter 
values of one of the selected Parts, in red. If you change a parameter, 
the following happens:

• If the checkbox “Only show Important Alerts” is activated in the 
Preferences–General–Miscellaneous dialog, all the selected Parts 
will get the new value, regardless of their previous settings.

• If “Only show Important Alerts” isn’t activated, you will get the 
question “Copy value to all selected Parts?”. 
If you click “Yes”, all the selected Parts will get the new value, regardless of 
their previous settings. If you click “No”, the change only affects the Part 
whose values were shown in the Inspector.

¶ If the option “Restrict Inspector to Track Changes” is activated in the Prefer-
ences–General–Arrangement dialog, the Inspector will always show infor-
mation for the selected Track only. In this mode, it is not possible to make 
settings for individual Parts in the Inspector.



CUBASE VST
Play Parameters, Part and Track settings 12 – 200

12
12
12
12
12
12
12
12

12
12

How MIDI Part and Track settings relate

As you have seen, you may change parameter values both for the 
whole Track and for individual Parts on the Track. It is the latest 
change that “counts”. If you for example change the velocity value of 
a single Part and then set another velocity value for the whole Track, 
the Part will also get this latest velocity value. Other parameter set-
tings for the Part will remain unaffected.

Make various settings for a Part... ...then change the velocity 
value for the whole Track.

Now the velocity value for the Part is changed to that of the 
Track, but the other settings for the Part remain unaffected.
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Using Tools
In the Arrange window Toolbox, some of the tools are used to make 
play parameter settings, directly for the Parts in the Arrange window. 
This is how you use them:

1. Select the Parts you want to make settings for.
If you only want to make settings for one single Part, you don’t have to select 
it.

2. Select the appropriate tool from the Toolbox.

3. Point on one of the selected Parts and press the mouse button.
A graphic control appears. For volume and pan, this will be a horizontal 
slider, for transpose it will be a small keyboard display.

¶ The graphic controls will be used for the Tools, even if you have turned this 
feature off in the Preferences for the Inspector values (see page 189).

4. Drag the mouse to set the desired value and release the mouse but-
ton.
All selected Parts are set to the same value.
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The Parameters
The tables below contain the different parameters for Audio and MIDI 
Tracks/Parts, respectively. In the MIDI Track/Part table, the “Where” 
column shows where you can find each parameter: in the Track Col-
umns (“C”), the Inspector (“I”) or the Tools (“T”). For a more thor-
ough explanation of some of these parameters, see the chapter 
“Inspector Real Time Parameters” in the electronic documentation.

For other Track classes, the contents of the Inspector may differ. See 
the respective chapter in the electronic documentation.

MIDI Part/Track Parameters

Parameter Where Explanation

Track Name C, I The name of the Track.
Part Name I The name of the selected Part.
Start/End I If a Part is selected, these fields show the Start and 

End position of the Part (in the selected position for-
mat). You can move or resize a Part by changing 
these values.

Instrument C, I In Cubase VST terms, an Instrument is simply a cer-
tain MIDI Channel together with a certain Output. In-
struments can be defined for MIDI Tracks and Drum 
Tracks.
Defining your different MIDI Channel/Output combi-
nations as Instruments can be practical, since you 
can do this once and then not have to check the ac-
tual Channel and Output settings. The concept is 
more thoroughly explained in the Instruments chap-
ter in the electronic documentation.

Output C, I The Output port for the selected Track or Part.
Channel 
(Chn)

C, I The MIDI Channel set for the Track or Part.

Program 
(Prg)

C, I Lets you associate a MIDI Program Change number 
with a Track or a Part, to make a connected instru-
ment switch sound. 
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Bank C, I Lets you associate a MIDI Bank Select message with a 
Track or a Part, to make an instrument switch "pro-
gram bank". The pop-up next to this value is used to 
select a protocol for the Bank Select messages (differ-
ent instruments interpret Bank Select messages in dif-
ferent ways - see the chapter “Program Change and 
MIDI Volume” in the electronic documentation).

GM Name C, I This parameter is only available if you have activated 
the “Use Inspector GM Names” option in the Prefer-
ences–General–Arrangement. Clicking on this brings 
down a hierarchical pop-up menu, from which you 
can select a GM instrument by name.
For this to work, your instrument must be compatible 
with the GM (General MIDI) standard.

OMS Patch C, I When you use OMS, this field replaces the “GM 
Names” field. It is used to select sounds in the con-
nected instrument (see the OMS chapter in the on-
line documentation).

Volume C, I, T A volume value for a Track or a Part. This setting is 
sent out as a MIDI Volume message.
In the Track Columns and Inspector, this setting can 
be displayed numerically or graphically - see page 
189.

Transp C, I, T Lets you transpose the notes in a Part or on a whole 
Track.
In the Track Columns and Inspector, this setting can 
be displayed numerically or graphically - see page 
189.

Veloc C, I The value in this field is added to the velocity of the 
notes played back.

Delay C, I Delays the notes. With a negative value, Delay will 
cause notes to play earlier instead.

Length C, I Changes the note length by a percentage factor.

Parameter Where Explanation
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Compr C, I Compresses/expands the velocity range of notes. This 
is done by multiplying the velocities with a percent-
age factor (25% - 200%). 
If for example you want to “even out” a Part with var-
ying velocity values, you could select a “Compr” 
value of 25, 50 or 75%. The smaller the value, the 
lesser the velocity difference between notes. To com-
pensate for the decrease in velocity, you may want to 
add a positive value in the “Veloc” field.
In a similar way, “Compr” values greater than 100% 
will make velocity differences greater.

Pan C, I, T Sends out a MIDI message, telling your instrument to 
place the sound of the Part/Track in a certain position 
in the stereo field.
In the Track Columns and Inspector, this setting can 
be displayed numerically or graphically - see page 
189.

Appearance C This Track Column is described on page 208.
Activity C This Track Column shows if any MIDI/audio is being 

sent out from the Track at the moment. The width of 
each bar represents velocity for notes.

Mute C This column allows you to Mute (silence) a Track.
Class C This column is used to select a Track Class for the 

Track (see page 154).
Time Lock C If you click in this Track Column, a small lock symbol 

appears, indicating that the Track is time locked. This 
means that the Events on the Track will not move, re-
gardless of whether you change the tempo. See the 
chapter “Time Locked Tracks” in the electronic docu-
mentation for more information.

Parameter Where Explanation
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Parameters in the Extended Inspector

For MIDI Parts, the extended (right) Inspector section contains some 
additional parameters:

Audio Parts/Tracks (Mono or Stereo)

Parameter Explanation

Multi Out This pop-up menu allows you to add extra Outs for a 
Track. Among other things, this makes it possible to play 
back a Track over several different MIDI channels, etc. 
See the chapter “Real Time Parameters” in the electronic 
documentation.

Rndm This is a Randomize feature, allowing you to play back 
MIDI Parts with random variations in pitch, velocity, tim-
ing or length. See the chapter “Real Time Parameters” in 
the electronic documentation.

Dyn This function allows you to affect the dynamics and note 
range of the material in various ways. See the chapter 
“Real Time Parameters” in the electronic documentation.

Parameter Explanation

Track/Part Name The name of the selected Track/Part.

Start/End If a Part is selected, these fields show the Start and End 
position of the Part (in the selected position format). You 
can move or resize a Part by changing these values.

Delay Delays the playback of the Audio Track/Part. With a neg-
ative value, Delay will cause the Audio Events to play 
earlier instead.

Chn The audio channel the Track uses, as described on page 
79. For Tracks set to stereo, both channels in the stereo 
pair are shown (e.g. “3+4”).
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Record Info Shows the name of the audio file currently assigned for 
the recording. Clicking on this box allows you to enter a 
name for the audio file, before recording it (see page 84). 
Double clicking allows you to change the folder in which 
created audio files are stored.

Stereo button This is used to select whether the Track should be set to 
Stereo (lit up button) or Mono (dark button). A lock sym-
bol in the button indicates that you cannot switch mode 
(see page 81).

Record Enable Click this button to enable recording on the Track.

Input button This is a duplicate of the Input button for the audio chan-
nel in the Audio Channel mixer window. 
Clicking this button activates monitoring for the channel, 
while holding down [Command] and clicking allows you 
to select an Input for the channel. See page 83.

FX/EQ buttons These are duplicates of the FX/EQ buttons for the audio 
channel in the Audio Channel Mixer. See page 307.

Volume This setting allows you to set the playback volume for the 
audio channel. Actually, it is a “mirror” of the channel 
fader in the Audio Channel Mixer (see page 301).

Pan This setting allows you to pan the audio channel. Actu-
ally, it is a “mirror” of the pan control in the Audio Chan-
nel Mixer (see page 305).

Parameter Explanation
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Audio Parts/Tracks (“any” channel)

If the Track or Part is set to audio channel “any”, the Inspector appears 
different. There are no FX/EQ buttons, and the Input and Record Ena-
ble buttons are replaced by a number of Monitor and Record Info but-
tons, one for each audio channel.

The “any” channel concept is described in the electronic documentation.
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About the “Appearance” Column

If you have selected “Use Track Settings” on the Part Appearance sub-
menu on the Options menu, you can use this Track Column to set how 
the Parts should appear on the Tracks:

• Click in the left part of the column (under the heading “N”) if you 
want the names of the Parts to be displayed.

• Click in the right part of the column (under the heading “E”) if you 
want a graphic representation of the Events in the Parts to be dis-
played (see page 189).

Black dots indicate whether Names, Events or both are activated.

By using modifier keys, you decide whether the setting should affect 
all Tracks, all Tracks of the same class or just the Track you click on:

• If you just click, the setting will affect all Tracks of the same class.
• If you hold down [Command] and click, the setting will affect all Tracks in 

the Arrangement.
• If you hold down [Option] and click, the setting will affect only the Track you 

click on.
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When should I use the Track Columns and 
when should I use the Inspector?

Most of the parameters in the Inspector have equivalents in the Track 
columns. Remember the following facts:

• The Inspector can affect both Tracks and single Parts. The Track columns 
only affect whole Tracks.

• The fields with the same name in the Track columns and the Inspector have 
exactly the same function. Changing the value in one affects the other as 
well.

Why then use the Track columns at all? Well, for one thing, it is very 
handy to have instant overview and control over all Tracks at the same 
time. The contents of the Inspector will change depending on which 
Parts you have selected. There may also be situations when you want 
the Part display (to the right in the Arrange Window) as large as possi-
ble, and therefore need to close the Inspector.
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About Muting Tracks
The Mute column is indicated by an “M”. By clicking in this column, 
you temporarily “silence” the Track. A black dot is displayed in the 
column. To make the Track sound again, you just click in the Mute 
column again.

The Solo function

If you click on the Solo button in the upper left corner of the Arrange 
window, all Tracks except the selected are Muted. This is useful if you 
want to listen closely to the contents of a Track, and don’t want any 
other music to interfere.

Click in the "M" column...

...to Mute the Track. The black dot indicates that a Track is Muted.

Click on the Solo button in the upper left corner of the 
Arrange Window to activate Solo.

The highlighted Solo button 
indicates that Solo is activated.

All Tracks except the 
currently selected, 
are Muted. Only the selected 

Track will play.
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• You can unmute one or more Tracks while in Solo mode if you 
want to listen to a combination of Tracks.

• When you deactivate Solo, all Tracks will return to the Mute status 
they had before Solo was activated.

• If any MIDI notes are sounding at the moment their Tracks are 
Muted, they are allowed to play until their end.

• It is also possible to Mute single Parts, using the Mute tool.
This is described in the chapter “The Arrangement - More on what you can 
do with Parts and Tracks” in the electronic documentation.

About the “M” sign in the Mute column

For Audio Tracks, the Mute column serves a second purpose: when 
monitoring is activated for a Track, an “M” is displayed in its Mute 
column. This is only an indication; you cannot change the monitoring 
status by clicking in the column. The Mute function works as usual, 
regardless of the monitoring status.
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Using Freeze Play Parameters
As already mentioned, the Inspector settings (or “Play Parameters”) 
do not change the MIDI Events themselves, but work rather like a “fil-
ter”, affecting the music on playback. However, sometimes you may 
want to make these settings permanent, i.e. convert them to “real” 
MIDI Events in the Part. You might for example want to transpose a 
Part and then edit the transposed notes in a MIDI editor. For this, you 
need to use the Freeze Play Parameters item on the Functions menu:

1. Select the Part(s) with Inspector settings you want to make perma-
nent.
If no Parts are selected, all Parts on the active Track will be affected.

2. Pull down the Functions menu and select “Freeze Play Parameters”.
Bank Select, Program Change, Patch, Volume and Pan settings in the Inspec-
tor will be converted to MIDI Events and inserted at the beginning of the 
Part(s). All notes in the Part(s) will be modified according to the Transpose, 
Velocity, Delay, Length and Compression settings in the Inspector, and the 
Inspector settings will be reset.

¶ When you export a MIDI file, you can choose to have all Inspector settings 
automatically included in the file, with no need to perform Freeze Play Pa-
rameters: 
Before exporting, open the Preferences–MIDI–MIDI Files dialog and make 
sure the option “Include Part parameters in Exported Files” is activated.
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Real-time Thru
In most MIDI recording situations, the Thru function in Cubase VST 
is used to “echo” incoming MIDI data via MIDI Out. If you use the 
Thru function, the MIDI data that Cubase VST receives via MIDI In is 
modified in real-time by some of the Playback parameters. This means 
that if you for instance set a transposition value of 7 (semitones) and 
play your keyboard, all notes coming out via the MIDI Out are trans-
posed a perfect fifth higher.

This allows you to try out what effect a certain parameter setting will 
have on the music, before and when you record something. Since dif-
ferent Parts can have different settings you must select the right Track 
and check that the Song Position is somewhere within the Part that has 
the settings you want to try. 

¶ It doesn’t matter which Part or Track you have visible in Part Info (you may 
have stepped through the Parts and Tracks with the arrow keys on the com-
puter keyboard), it is only the Song Position and Active Track which deter-
mines which Part’s settings should be used for the real-time modification. 

Notes from the keyboard...

...are passed through 
the Inspector...

...and output again, 
transposed one fifth upward.

The Part in the intersection made up by 
the Active Track and the Song Position 
is used for real-time "Thruing".
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The real-time parameters used for modification are: Transpose, Veloc-
ity and Compression.

You can also thru-put to up to four Instruments (Outputs and MIDI 
Channels), see the chapter “Multi Track Recording” in the electronic 
documentation.
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What is the Audio Pool?

Every time you record on an Audio Track, a file is created on your 
hard disk. This file is also added to the Audio Pool, a window listing 
all audio files used in the Song. The way the Audio Pool displays Cu-
base VST audio files and their contents is similar to the way the Mac-
intosh Finder displays lists of files and folders.

But Cubase VST is not restricted to playing complete files. It can also 
play any section of a file from the beginning, at the end, or some snip-
pet in the middle, short or long, it doesn’t matter. A specification for 
such a section of a file is called a segment. For each file that is used in 
the Song there will be at least one segment. There can be more. For ex-
ample, different sections of an audio file might be used in more than 
one place in the song. All the segments are listed in the Audio Pool.

• Read more about files and segments in the chapter “How Cubase 
VST handles Audio and MIDI” in the electronic documentation.

This chapter describes the basic techniques and information related to 
the Audio Pool. In the electronic documentation you will find a lot 
more information.

This Audio File has four segments, playing different sections of the file.

The number to the left of the name, shows how many times 
each segment is used in the Song.
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Opening the Audio Pool
The Pool is opened by selecting “Audio Pool” from the Panels menu 
or by using a key command (by default [Command]-[F]).

How files and segments are displayed

Files
Each file is represented by a line in bold text, preceded by a triangle. 
For each file there are a number of settings and information, described 
in the chapter “The Audio Pool” in the electronic documentation.

Renaming a file

You can rename an audio file by double clicking on its name in the 
Audio Pool and typing in a new name. This method makes it possible 
for Cubase VST to keep track of the name change. Renaming audio 
files in the Finder is not recommended.

Segments
Each file that is in use, has one or more segments, listed below the file 
in the Pool. The segments have their own settings, described in the 
chapter “The Audio Pool” in the electronic documentation. 

To display or hide the segments for one audio file, you click on the tri-
angle preceding the file.

• To Show/Hide all segments for all files, select Expand/Collapse 
from the pop-up View menu.
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Auditioning a segment

To audition a segment from its beginning, press and hold the mouse 
button with the pointer over the speaker icon to the left of the segment 
name. The segment will be played back in its entire length (or for as 
long as you hold down the mouse button).

If you don’t wish to audition the segment from its beginning, you can 
click anywhere in the waveform image to the right. The segment will 
play back from the position where you clicked, for as long as you keep 
the mouse button pressed.

Finding Out how a Segment is used in the Song

Next to the speaker icon for each segment, you will see a number tell-
ing how many times in the Song this segment is used. A segment with-
out numbers is not used anywhere.

It is also possible to display segments in different colors depending on 
the color of the corresponding Parts in the Arrange window. See the 
Audio Pool chapter in the electronic documentation.
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Dragging from the Pool to the Arrange 
window

One of the most important features in the Pool, is the possibility to 
drag segments into the Arrange window. This example makes use of 
the Quick Start Song included on the CD-ROM:

1. If you haven’t already copied the Quick Start Song folder to your 
hard disk, do this now.
See page 23.

2. Open the Song “Quick Start Song”.

3. Select New Arrangement from the File menu so that you get a new 
empty Arrangement.
In this example you will not use the original Arrangement, even though it will 
still be there in the background. 

4. Make sure you have a number of Audio Tracks at the top of the Ar-
rangement.

5. Set the tempo of the Arrangement to 70 BPM.

6. Pull down the Audio menu and select Pool.
A Pool window with a large number of audio files in it is displayed.

7. Resize and arrange the windows so that you can see the first eight 
Tracks in the Arrangement, as much as possible of the Part Display 
and as much as possible of the Pool window.

8. In the Pool window, select Expand from the pop-up View menu.

9. Now, below each file appears one or several segments.
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10.Position the mouse pointer over one of the segment names, and 
press the button. With the mouse button down, drag the segment 
onto an Audio Track in the Arrangement.
The picture sequence below shows this step in more detail.

11. If the Part doesn’t appear at the place you intended, simply drag it 
to the right Track and bar position.

1. Point at the 
Segment name

2. Drag onto an audio Track in 
the Arrangement

3. The Segment appears as a 
Part in the Part Display
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12.Play back to hear the new Arrangement.

13.Drag another segment to another Track, and position it so that 
they start at the same time. Play back to hear the results.

14.Continue like this to add more Parts to build an Arrangement.

Two tips:

• Remember that you can repeat Parts that are already in the Ar-
rangement. 
This might be faster than dragging the same segment from the Pool many 
times.

• Use the Cycle function to try out different files and see if they go 
well together.
The Cycle function makes the section between the Left and Right Locator re-
peat over and over again. Just place the Left and Right Locators where you 
want them, click on the Cycle button on the Transport Bar so that it is lit, and 
activate playback. Then drag files to positions inside the Cycle while the pro-
gram is playing back!



CUBASE VST
Using the Audio Pool 13 – 223

13
13
13
13
13
13
13
13

13
13

Importing Files into the Pool
If you have any other audio file on your hard disk, and would like to 
use it in the song, you can import it into the Pool and then drag it into 
the Arrangement, as described above.

File Specifications
The Audio file must meet the following specifications:

• It must be in AIFF (Audio Interchange File Format) or SDII (Sound Designer II) 
format.

• It must be an uncompressed 16 bit file.
• The sample rate (also called sampling frequency) of the file must be 44.1kHz.
• The file can be mono or stereo.

The files that Cubase VST creates when you’re recording audio are: 
AIFF, 44.1kHz, 16 bits.

Importing the file
1. Activate the Pool window.

2. Select Import Audio from the pop-up File menu.

3. Use the file dialog box to locate the file, select it and click Open.

4. The dialog reappears so that you can import more files. If you like, 
do so. When you are done, click Done.
Now, the File appears at the bottom of the Pool window, complete with a 
segment which can be dragged into the Arrangement, as described above.
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• Please note that you can also import audio files directly into the 
Arrangement, as described in the chapter “Importing and Export-
ing Audio” in the electronic documentation (using the “Import Au-
dio File” item on the File menu). 
It is also possible to drag one or more audio files directly from the Finder into 
the Arrangement or the Pool.
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Introduction
There are several ways to edit audio recordings in Cubase VST: 

• By manipulating Audio Parts in the Arrange window.
• By changing file and segment settings in the Audio Pool (see the Audio Pool 

chapter in the electronic documentation).
• By editing and trimming the Audio Events in the Audio Editor.
• By applying permanent editing and processing the actual audio files and seg-

ments in the Wave Editor (described in the Wave Editor chapter in the elec-
tronic documentation).

This chapter describes the basic features and techniques in the Audio 
Editor. For more detailed information, see the Audio Editor chapter in 
the electronic documentation.

About Segments, Events, Parts and Non-
destructive editing

As already mentioned, an audio segment is a section of an audio file. 
Basically, each segment consists of a reference to an audio file, a start 
point and an end point (called Start and End Insets from now on).

An Audio Event can be viewed as a “box” containing a segment (to-
gether with some additional settings). The Audio Part, in turn, is a 
“box” containing one or several Audio Events (just like MIDI Parts 
contain notes or other MIDI Events).

When you edit an Audio Part in the Audio Editor, you do not change 
the actual recording (i.e. the audio file), but rather the properties of the 
segment(s) and Audio Event(s) in the Part. The editing you perform is 
non-destructive, meaning that no audio data is lost. You can always 
change the settings back to the way they were before you started edit-
ing.
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Opening the Audio editor
To open the Audio editor, proceed as follows:

• Double click on an Audio Part, 

or

1. Select one or more Audio Parts.
You can edit Parts from several Tracks at the same time, if you like.

2. Pull down the Edit menu and select Edit, or press the correspond-
ing key command (by default, [Command]-[E]).

You can only have one Audio editor window open at a time.
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The Audio Editor - overview

About Lanes

When you first open the Audio editor you will note that it is divided 
horizontally into something we call Lanes. You can move or copy 
Events between Lanes, but the results of this are different, depending 
on the audio channel setting of the edited Track:

• When Editing A Single Channel (Mono) Track.
If the Track is set to Mono, and set to play back on one specific audio chan-
nel, in the Arrange window (as opposed to being set to channel “Any”), the 
Lanes all have equal value. The only reason for you to use more than one 
Lane when editing a single channel Track is if you find that it gives you a bet-
ter overview of what is going on.

• When Editing a Stereo Track.
If the Track is set to play back in Stereo, the Audio Editor will show two dif-
ferent Lanes, one for each stereo side. This means that if you edit a Stereo 
Track set to channel 3, the Audio Editor will display lanes for channel 3 and 
4.
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• When Editing a Multi Channel Track.
If you are editing a Track set to channel “Any” (or several Parts on different 
Tracks), each Lane will represent one of the available audio channels. Which 
audio channel each Lane “uses” is indicated by a number on the left side of 
the window.

By moving an Event between Lanes with different channel numbers, you 
change which audio channel the Event is played back on.

¶ This chapter assumes you are editing Parts that are all on the same audio 
channel. For more information about multi channel audio editing, see the 
Audio Editor chapter in the electronic documentation.

How Audio Events are displayed
Normally, Audio Events are displayed as boxes containing a wave-
form - or two waveforms if the corresponding audio file is in stereo. In 
addition, several handles, markers and other things can be shown in 
the Event. What is displayed depends on the setting on the View pop-
up menu:

Waveforms

This option governs whether the waveform(s) should be shown or not. 
Usually, you will want to leave this option activated.

Names

When this is activated, the name of the segment is shown in the top left 
corner of the Audio Event.
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Handles

Each Event has a Start and End Inset which represent the Segment 
start and end points in the audio file. If the “Handles” option is acti-
vated on the View pop-up menu, handles for adjusting the Start and 
End Insets are visible in the upper and the lower corners (respectively) 
of the Events. For information about how to adjust the Insets, see page 
236 in this chapter.

The shape of the handle indicates what the Event actually plays:

• Even if the Event doesn’t begin or end inside the window, the Start 
and End Inset symbols will be visible at the edges of the window. 
If you have long Events, this allows you to see the “status” of the Insets (as de-
scribed above) without scrolling the view.

The Handles option will also show/hide the Q-Points (see page 232).

If this symbol appears at the beginning of the Event, it means that the 
Event plays the audio file from the beginning.

If this symbol appears at the beginning of the Event, it means that the 
Event plays the file from some point later than the absolute beginning 
of the file. The Start Inset has already been adjusted.

If this symbol appears at the end of the Event, it means that the Event 
plays the audio file to its end.

If this symbol appears at the end of the Event, it means that the Event 
does not play the file to its absolute end. The End Inset has already 
been adjusted.

End Inset handleStart Inset handle Q-Point handle
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By Output

When this is activated, all Events that play back on the same audio 
channel will be displayed on the same Lane. For more information 
about this, see the Audio Editor chapter in the electronic documenta-
tion.

Lane Info

If this option is activated a field will be shown to the left of each Lane, 
displaying the number of the corresponding audio channel.

Dynamic Events

When this is activated, the lower part of the Audio Event will display a 
volume curve, a pan curve or Match Points. This is all described in the 
Audio Editor chapter in the electronic documentation.

About Q-Points
In the Audio Event, you will also find a vertical line with a handle, 
marked “Q”. This is the Q-Point, a marker that is used for snapping 
the Event to musical positions.

The concept behind this is that with audio, as opposed to MIDI, the 
beginning of the Event might not occur at a musical position at all, 
there might for example be a significant amount of silence at the be-
ginning of the recording.
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This means that snapping the beginning of the Event to a musical po-
sition normally doesn’t make much sense. Hence Q-points. These al-
low you to specify a position in the Segment which is to be taken as 
it's first “musically significant position”, the first down-beat for in-
stance.

• To move the Q-Point in an Audio Event, just click and drag the Q-
handle.
For the Q-Point to be visible, “Handles” must be activated on the View pop-
up menu.

For more info about working with Q-Points, see the Audio Editor 
chapter in the electronic documentation.

Which Audio Events will I Hear?
If any two Audio Events try to play back on the same audio channel at 
the same time, only one of them will be heard. This is shown in the 
pictures below:

The ”1st Part” Event is cut off by the ”2nd Part” Event.

The ”MainBeat” Event is cut off by the ”Fill-in” Event. After the end of this 
shorter Event, the ”MainBeat” Event will be heard again.
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Creating Audio Events
There are three general ways to create new Audio Events in the Audio 
Editor:

• By recording.
Audio Recording in the Audio Editor is done just as in the Arrange window. If 
you are editing several Parts on different Tracks, you determine which Part to 
record into by clicking in the Lane Info field to the left in the window.

• By importing.
If you select the Pencil tool and click somewhere in a Lane, a file dialog will 
open. Locate and select the audio file you want to import, and click OK. An 
Audio Event is created at the position where you clicked (taking the Snap 
value into account), and the file and segment is added to the Pool.
The file specifications are the same as when importing into the Pool (see page 
223).

• By dragging segments from the Pool, or even dragging audio files 
directly from the Finder.
This is done just like dragging segments into the Arrange window (see page 
220).
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Manipulating Audio Events
This section describes some of the basic ways of manipulating Audio 
Events.

Moving Events
Audio Events are moved just like other objects in Cubase:

1. Select the Arrow Tool.

2. Select all Events you want to move.

3. Press and hold the mouse with the arrow pointer over one of the 
selected Events (not in the handles) and move the mouse.
The mouse box shows you where the Q-point of the first selected and 
dragged Event will wind up when you release the button. 

4. If you want to restrict movement to horizontally or vertically, hold 
down [Shift] while dragging.

5. Release the mouse button, and the selected Events are moved to 
the new position. 
The Snap function applies, positioning the Event so that its Q-point gets 
aligned with the closest Snap value.

You can also make fine adjustments to Event position, using the Hand 
tool. This is described in the Audio Editor chapter in the electronic 
documentation. Furthermore, using the left/right cursor while holding 
down the [Command]-key moves the event one Snap value to the right 
or left.
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Duplicating Events
This works just as when moving Events, except that you hold down 
[Option] while you are dragging the Events. The duplicated Audio 
Events will play new segments, with the same properties as the original.

• If instead you want the duplicated Event to play the same segment, 
you can create a Ghost Copy of the Event, by holding down [Com-
mand] while you are dragging.
The advantages of this are that you don’t get a lot of identical segments in the 
Pool, and that you can edit one segment, and have your changes affect sev-
eral Audio Events at once. For more info about Ghost Copies, see the Audio 
Editor chapter in the electronic documentation.

Changing Start and End Insets
Changing the Start and End Insets is the main way to trim your Audio 
Events. There are a couple of things to think about before starting:

• Snap to Zero.
If the option “Snap To Zero” is enabled on the Audio Setup submenu (located 
on the Options menu), all offset adjustment will be followed by an automatic 
“search for a zero crossing”. The advantage of using zero crossings is that 
there will be no clicks due to sudden volume changes in the audio material. 
For more info on Zero Crossings, see the chapter “The Audio Editor” in the 
electronic documentation.

• Changing the Magnification.
It is often a good idea to zoom in horizontally and vertically when you are 
making fine adjustments to the segment start and end points. Use the magni-
fication controls in the lower right corner of the window to change magnifi-
cation.

• The Inset values are in meter position format.
This means that when you change the Insets, the smallest possible position 
increment/decrement is determined by the Display Resolution (set in the 
Preferences, see page 43). If you need sample accurate editing of Segment In-
sets, you can perform this in the Pool, as described in the Audio Pool chapter 
in the electronic documentation.

• The Insets do not “snap” to the closest Snap value.
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Changing the Start Inset

The Start Inset is adjusted by dragging in the upper left corner of the 
waveform part of the Segment. Usually, you will point at the handle, 
click and drag, but the handle does not actually have to be shown 
(hide/show it with the View pop-up menu, if you like).

• If you click somewhere along the very top edge of the segment 
(though not on the segment name) the Start Inset will immediately 
be set to that position.
The Start Inset can also be changed numerically from the Info Line (see page 
241).

Position the pointer in the upper left 
corner of the waveform...

...and drag the Inset 
left or right.
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What happens when you Change the Start Inset?

Changing the Start Inset adjusts from which point in the file the Seg-
ment plays; it “hides” more or less of the beginning of the file. It does 
not move the audio in the Song. Note the difference between changing 
the Start Inset and moving the Event:

Changing the End Inset

This is done just as changing the Start Inset, only you click and drag in 
the lower right corner of the waveform. Changing the End Inset ad-
justs the Length of the Event; that is, it hides more or less of the end of 
the file.

• If you click somewhere along the bottom edge of the segment, the 
End Inset will immediately be set to that position.
The End Inset can also be set numerically on the Info Line (see page 241).

Monitoring the changes

If you activate the Speaker icon, a short section of the segment will be 
played back when you change the Insets, allowing you to fine-tune the 
settings by ear. In the electronic documentation, you find information 
about how to set the length of the section to be played back.

Before moving the Event

After moving the Event

Before moving the Start Inset

After moving the Start Inset
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Auditioning Audio Events
This allows you to check out the contents of an Event, by playing it 
back from any position: 

1. Deactivate the Scrub icon on the Status Bar.
When this is activated, the Speaker tool is used for Scrubbing. This is de-
scribed in the Audio Editor chapter in the electronic documentation.

Auditioning mode.

2. Select the Speaker Tool from the Toolbox.

3. Make sure the Scrub icon on the Status Bar is deactivated.

4. Click on an Event.
The Event is played back from that point as long as you hold the mouse but-
ton down. The audio is routed through the Audio Channel mixer as usual.
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Deleting Audio Events
Audio Events can be deleted in several ways, just as Parts in the Ar-
range window:

• By clicking with the Eraser tool.
This will remove the Event from the Audio Part. The file will remain on the 
hard disk, and in the Audio Pool, together with the segment.

• By selecting the Event and pressing [Backspace] on the computer 
keyboard.
Again, this will only remove the Event from the Audio Part.

• By selecting the Event, holding down [Command] and pressing 
[Backspace].
In this case, the following alert message will appear:

If you click No, only the Audio Event will be removed, as if you had not 
pressed [Command].
If you click Yes, the audio file will be permanently deleted from the hard 
disk, and the segment and file will be removed from the Audio Pool.

¶ Permanently deleting an audio file from your hard disk this way cannot be 
undone!
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Editing on the Info Line
The Info Line is a section in the window containing numerical settings 
for the selected Audio Event. Proceed as follows:

1. To display the Info Line, click on the “I” button on the Status Bar:

2. Select one or several Events.
If a single Event is selected, the values are displayed in green; if more than 
one Event is selected, the values are displayed in orange.

3. Adjust the values as described in the table below:

• If more than one Event is selected, the changes are applied in rela-
tion to the original value for each Event.

Heading: Description:

Start Start Position. Adjusting this moves the Event.

End End Inset. Adjusting this shortens or lengthens the Event.

QPoint Q-point. Adjusting this moves the Q-point. See page 232 in 
this chapter.

Seg Segment name (not shown if more than one Event is se-
lected). If you change this, this is reflected in all Events that 
play the Event, and in the Pool.

File File name (not shown if more than one Event is selected). 
Changing this means that the actual audio file on the hard 
disk is renamed.

Chan The audio channel the Event plays on (not shown if more 
than one Event is selected). This cannot be changed on the 
Info Line.
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What can I do with the MIDI Editors?
When you record MIDI data, you fill Parts with notes and other MIDI 
“Events”. But you don’t really get to see and manipulate those Events 
individually from the Arrange window. In the MIDI editors you do!

Different types of Events and where to find 
them

Below we’ll list the different types of MIDI data that Cubase VST can 
record, and how and where they are displayed for editing:

Notes (Note On and Off messages)
Notes are displayed in all MIDI editors. Let’s look at a drum pattern 
and how it is shown in the different editors:

In Drum Edit

In the Drum Edit window, the notes are shown as diamonds. 
Each key corresponds to a Sound, as listed to the left. The different 
shadings of the diamonds indicate different velocity values.
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In Key Edit

In List Edit

The notes are shown as boxes, with higher notes higher up in 
the grid. Note length is indicated by the width of the boxes.

The piano keyboard to the left is there to make it easy 
to find the right pitch when inputting or editing notes.

The notes are shown both in the list to the 
left, and in the graphic display to the right.

The black bar graphs are for graphically displaying and editing 
MIDI “Value 2” in every Event. In the case of notes, “Value 2” 
is the velocity value.
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In Score Edit

In Score Edit, notes are displayed and 
edited just as notes on a printed score.



CUBASE VST
An Introduction to MIDI Editing 15 – 246

15
15
15
15
15
15
15
15

15
15

Continuous Messages
In MIDI, various types of MIDI messages are used to transfer contin-
uous changes. To be exact, these types are:

• Aftertouch (Channel Pressure and Poly Pressure).
• Pitch Bend.
• Controllers, like sustain pedal, MIDI Volume, Modulation wheel etc.

To be really exact (not to say pedantic!) some of these are not really 
continuous. Sustain Pedal for example can only be down (On) or up 
(Off). However, the MIDI specification groups all these messages as 
Continuous messages, and so does Cubase VST.

Continuous messages (not only MIDI messages, but all kinds of contin-
uous information) are best viewed and edited in the Controller Editor:
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However, you can also edit continuous MIDI messages in Key, Drum 
and List Edit:

In Key Edit, the area beneath the Divider is the Controller Display.

Clicking on this icon brings up a pop-up menu, allowing you 
to select which type of continuous data should be shown. 
In this case, modulation wheel Events are displayed.

The “mountains” of continuous data are in reality a large number of single 
Events. This becomes clear when looking at the same data in List Edit:

The modulation Events 
are listed in their 
playback order.

Value 2 for each Event is shown in the 
list and in the bar display. The grey 
color indicates non-note Events.
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Program Change messages

A Program Change message is a MIDI Event, telling a connected 
MIDI device to switch to another Program (e.g. a sound in a synthe-
sizer, a setting in a reverb device, etc). You can record Program 
Change messages into Cubase VST like any other Event. If you want 
to edit (or create new) Program Change messages, you can do this in 
several different editors, but it will probably be most practical to do it 
in List Edit.

System Exclusive messages

System Exclusive messages are a special kind of MIDI Events, in-
tended for detailed control of the parameters of a MIDI device. Since 
all devices have different parameters, each major manufacturer of 
MIDI devices has a special ID code that is included in the System Ex-
clusive message.

System Exclusive messages can be displayed and edited in the List 
Edit window (See the “List Edit” chapter in the electronic documenta-
tion, and the separate document about handling SysEx).
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Opening A MIDI Editor
There are several ways to open a MIDI editor:

¶ If you haven’t recorded any MIDI data, but want to input MIDI Events “from 
scratch” in a MIDI Editor, you need to create a Part first, by using the Pencil 
tool or the Create Part function. This is described on page 156.

Double clicking on one Part

If the Part is on a Drum Part, the Drum editor opens. If it is a regular 
MIDI Part, which editor opens depends on the “Preferred MIDI Edi-
tor” setting in the Preferences. To set this, proceed as follows:

1. Open the Preferences–General–Editors dialog.

2. Pull down the Preferred MIDI Editor pop-up menu and select an 
editor (Key, Score or List Edit).

The Preferred MIDI Editor setting is saved with the Song if the “Save 
with Song” box is checked. If you want this setting to be valid for all 
new Songs, you should set up your ”Autoload” song for this. See page 
339.



CUBASE VST
An Introduction to MIDI Editing 15 – 250

15
15
15
15
15
15
15
15

15
15

Editing a complete Track

You can edit all Parts on a Track at the same time:

For MIDI Tracks the “Edit“ item opens Key Edit, for Drum Tracks it 
opens Drum Edit.

Editing more than one Part

You can edit any selection of Parts, even Parts on different Tracks at 
the same time. The only restriction is this:

¶ List Edit can only be used to edit Parts that are all on the same Track.

1. Select the Parts you want to Edit.

2. Select the preferred editor from the Edit menu or use the keyboard 
equivalents.
You can also double click on one of the selected Parts to open the default ed-
itor (assuming that all Parts are MIDI Parts).

1. Make sure no Parts are selected, by clicking somewhere 
in the background area of the Arrange Window.

2. Select the Track you want to Edit.

3. Select the preferred editor from the Edit 
menu or use the keyboard equivalents.
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Key Edit

Overview
Below you will find a description of some of Key Edit’s main features:

The dark notes are selected.

The position of the mouse pointer is 
shown both in the Mouse Box and on 
the Piano keyboard.

The Song Position Pointer.

Clicking here opens the Controller Display.

The Snap and Quantize boxes.

The Goto, Do 
and To pop-ups.

The Edit Solo button. Click this if you only 
want to hear the edited Part(s).

The Info Line. This is used 
for numerical editing of 
selected Events.
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Drum Edit
Drum Edit can be used to edit MIDI Tracks. It can also be used in a 
more advanced context, for editing Drum Tracks. See the chapter 
“Drum Edit and Drum Tracks”.

Overview
Below you will find a description of some of Drum Edit’s main fea-
tures:

The Song Position pointer.

The position of the mouse is shown in the 
Mouse Box. The name of the Drum Sound 
on the corresponding line, is shown in the 
box below.

The Drum Sound list. 
By dragging the Divider 
further to the right, more 
columns are shown.

The dark notes are 
selected.

Clicking here opens the 
Controller Display.

The Edit Solo button is for 
soloing the edited Part(s), 
while the Solo button below 
allows you to listen to the 
selected Drum Sound only. The Info Line.
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About Drum Maps
In Drum Edit, each key on your MIDI keyboard is represented as a 
“Sound”, in a “Drum Map”. This map consist of 128 Sounds which 
can be named and set to represent a certain drum sound in your syn-
thesizer, sampler or drum machine.

When you have defined a Sound, all notes that are already recorded with 
that Sound will appear as diamonds on that “line” in the note display.

Opening ready-made Drum Maps
A number of ready-made drum maps are included on the Cubase VST 
CD-ROM. This example describes opening a drum map for General 
MIDI instruments, but you may very well find a drum map which has 
been created specifically for the drum sounds in one of your instru-
ments. To load a map, proceed as follows:

1. Select Open from the File menu.

2. From the Filetypepop-up menu, select”Drum Map”.

3. Locate the Drum Maps folder on the Cubase VST CD-ROM.
You may find it more convenient to copy the desired Drum Maps from the 
CD-ROM to your hard disk, and open them from there instead.

4. Locate the drum map you desire, and click Open.
Now when you next time open the Drum editor, your Drum Map is already 
properly defined and recordings made in the Arrange window should appear 
with all the notes on the right “lines”.
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• If you want to open a General MIDI compatible drum map, the 
quickest way is to select “gm.drm” from the “Open from Library” 
submenu on the File menu.
This opens the GM drum map in the Library Files folder in your Cubase VST 
folder.

If you save your Song, the selected drum map is saved together with the 
Song. It will be loaded automatically next time you open the Song.

¶ If you are editing a Drum Track, you can open Drum Maps directly from the 
Inspector. This also allows you to use different Drum Maps for different 
Tracks, etc. See the Drum Edit chapter in the electronic documentation.



CUBASE VST
An Introduction to MIDI Editing 15 – 255

15
15
15
15
15
15
15
15

15
15

Setting up and changing the Drum Map
You can easily change an existing drum map, or set up a whole new 
one to fit the percussion and drum setups in your MIDI instruments.

¶ This example assumes you are using Drum Edit for editing MIDI Parts. 

Now, recordings made with the Sound played by that key will appear 
on that line.

Saving your Drum Map
You may of course save any Drum Maps you have created. This is de-
scribed in the “Drum Edit and Drum Tracks” chapter in the electronic 
documentation.

1. Check out and memorize which key on your keyboard is used to play 
a certain Sound.

2. Open the Drum editor and drag the Divider between the Drum Map 
and the Note display so that you see the first few columns in the list.

3. Double click on a Drum Name 
and type in your own.

4. Double click on the I-note value 
for that Sound, and type in the pitch 
of the key that plays the Sound.
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List Edit

Overview

The Song Position is shown both in 
the Event list and in the Event display

On the Insert pop-up menu, you decide 
which type of Events to input.

A selected Event.

The Mask pop-up is used to make List Edit 
show Events of a certain type only.

The Mouse position is 
shown in the Mouse Box.

The Do, To and 
Goto menus.

The Snap and 
Quantize pop-ups.
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Score Edit
The design and features of the Score editor differs depending on 
which version of Cubase VST you have: In the “regular” Cubase VST, 
there is a basic Score editor without advanced layout features, while 
Cubase Score VST contains a larger Score editor, for pro-level score 
layout and printing.

Unless where explicitly stated otherwise, this section and the Score 
Edit chapter in the electronic documentation describe the basic Score 
editor in Cubase VST. If you have Cubase Score VST or Cubase Au-
dio VST you should also read the separate “Score Layout and Print-
ing” document.

Overview
Below you will find a description of some of Score Edit’s main features:

The “inverted” notes are selected.

The Song Position Pointer.

The mouse position is shown both in the mouse box 
and as a note name in the box below. When you 
move a note, the lower box shows the amount of 
transposition in semitones.

If you are editing Parts on several Tracks at the same time, the striped 
double bar line at the beginning of the score indicates the Active Track.

The Info Line, used 
for numerical editing 
of selected notes.
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Getting the Score displayed correctly
When you first open Score Edit, the score layout can reflect the minor 
inaccuracies of a real human performance. There are a number of set-
tings that can be made to clean up the score layout, without having to 
change the actual MIDI data. See the Score Edit chapter in the elec-
tronic documentation for more info.

Page Mode vs Edit Mode
If you are using Cubase VST Score or Cubase Audio VST, your pro-
gram will have a Score menu. The top item on this menu is used to 
switch the Score editor between its two modes, “Page” and “Edit”.

The text below assumes the editor is set to Edit mode. The other mode 
is for score layout and printing. Users of the regular Cubase VST (not 
Score) do not have to worry about this.

Selecting Page Mode will display the music as it will look when printed...

...while Edit Mode displays the music in a way more suitable for editing:
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Window Size
Score Edit’s Edit mode displays as many notes as there is room for in 
the window. In other words, to see more or less of your Track, simply 
resize the window.

About Recording and Playback in the Editors
Basically, anything you can do in the Arrange window that relates to 
playback and recording, you can also do in the editors.

• Realtime
As everything else in Cubase VST, editing can happen in realtime. This 
means that you can edit while the music is playing or actually even while 
you are recording!

• Step Recording
If you prefer not to record your music in real time, you may use the Step Re-
cording function to input music one note at a time. This is explained in the 
chapter “Step Recording” in the electronic documentation.

• Follow Song
If Follow Song on the Options menu is turned on, the window automatically 
scrolls during playback, so that the current Song Position is always visible.

By default, pressing [F] on the computer keyboard will turn Follow Song on/
off.
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• Ed Solo

When this button is activated, you will only hear the Track/Parts that are cur-
rently being edited. All other Tracks are muted. Use this function when you 
want to concentrate on editing the Parts in the editor, rather than hearing the 
recording in a context.

• Cycle
Activating Cycle (see page 109) can be very handy for editing, since you can 
fine tune a recording and instantly hear the result without having to Rewind 
and Play to get to the right section.
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Entering Notes
Notes can be entered manually, using slightly different methods in the 
different MIDI editors:

Key Edit
1. Set the Snap value to the smallest position you want to enter a note at.

If for example you only want to enter notes at quarter note positions, set Snap 
to “4”.

2. Set the default length of the note to enter with the Quantize value.
The value “8” will for example give eighth notes. You may also change the 
length while you’re drawing - see page 262.

Snap and Quantize values set up for entering eighth notes at quarter note 
intervals.

3. Select the Pencil tool.

4. Move the pointer onto the note display, to the position where you 
want the note to be placed.
The keyboard display to the left, and two fields on the Status Bar will help 
you by showing the position and pitch.

5. Click once with the mouse to input a note.

The pitch is indicated on the keyboard display and in the Status Bar.
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Setting the length while drawing 

It is possible to set the length of notes to something else than the quan-
tize value, while entering them. Still the Snap value applies so you can 
only set the Length to multiples of this value.

1. Aim with the Pencil at the correct position and pitch.

2. Press the mouse button and drag to the right with the button 
pressed.

3. Release the mouse button. 
The Event is adjusted to the closest Snap value.

Determining the velocity of the notes

By holding down different modifier keys on the computer keyboard, 
you can give the notes you enter different velocity values. This is de-
scribed in the chapter “The MIDI Editors - General Information” in 
the electronic documentation.
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Drum Edit
1. Drag the Divider to the right, so that you can see the “Q” and 

“Len” columns.

2. Locate the Sound you want to enter notes for, and set the value in the 
“Q” column to the smallest position you want to enter a note at.
When inputting notes, this value works in the same way as the Snap value in 
Key Edit. However, Drum Edit allows you to set different Q values for each 
Sound, making it easier to quickly input patterns with 16th note hihat pat-
terns and eighth note snares and bass drums, etc.

3. Set the default length of the note to enter in the “Len” column.
Again, you may set different values for different Sounds.

Q and Len values set up for entering a 16th note hihat pattern.

4. Select the Drumstick tool.

5. Move the pointer onto the note display, to the position where you 
want the note to be placed.

6. Click once to input a note.
If you want to remove a note, just click on it again with the Drumstick.

Two fields on the Status Bar will help 
you by showing the position and Sound.
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Entering several notes at once

If for example you want to enter a 16th note pattern, there is an easier 
way of doing this than clicking in the notes one by one:

1. Set up Q and Len values for the Sound.

2. Select the Paint Brush tool.
Aim at where you want the first note to be, click and drag to the 
right.

3. Release the mouse button.
A row of notes are entered, positioned according to the Q value for the Sound.

Determining the velocity of the notes

By holding down different modifier keys on the computer keyboard, 
you can give the notes you enter different velocity values. This is de-
scribed in the Drum Edit chapter in the electronic documentation.
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List Edit
In List Edit, you can insert any type of Event. However, in this exam-
ple, we will insert notes (see the List Edit chapter in the electronic 
documentation for more information).

1. Pull down the Insert pop-up menu and make sure “Note” is selected.

This is where you select the type of Event to enter.

2. Set the Snap and Quantize values as when entering notes in Key Edit.

3. Select the Pencil tool.

4. Aim and click in the Event display to the right of the List.
The Event will appear both in the Event display and in the List. 

• You can set the length of the note manually while you are entering 
it, just like in Key Edit (see page 262).

When you enter a note in List Edit this way, it gets a default pitch. To 
change the pitch of the note, proceed as follows:

5. Drag the divider to the right, so that you can see “Val 1” column in 
the List.
For Note Events, Value 1 is the pitch.

6. Change the pitch value using any kind of value editing.
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Score Edit
In Score Edit, you use the Note tool to input notes:

1. Set the Snap value to the smallest position you want to enter a note at.

2. Select the Note tool.

3. Select a note value by clicking on a note button on the Toolbar.

The Note tool takes on the shape of the selected note value.

4. Press the mouse button somewhere in the score display.

5. With the mouse button down, drag the note up/down. 

Accidentals appear to show you the exact pitch of the note. The pitch is also 
shown in the value field under the Mouse Box:

6. When you have the note at the right note line with the correct ac-
cidental, release the mouse button.

Entering Rests

You can use the Rest tool to insert rests between notes. Like the Note 
tool, the Rest tool changes appearance depending on the chosen note 
value. See the Score Edit documentation for full details.
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Selecting Notes and other Events
• Selecting Notes and other Events in the main Event displays is done exactly 

like when selecting Parts in the Arrange window, see the previous chapter.
• Selecting Events in the List in List Edit can be done by clicking, Shift-clicking 

or Command-clicking (for selecting a range of Events).
• In Key, Drum or List Edit, you can press [Shift] and double click on a note, to 

select all notes with the same pitch.
• You may use the Select sub-menu in the Edit menu to select Events. The con-

tents of this sub-menu varies depending on which editor you are in. See the 
“Menu and Dialog Reference” section.

• Selecting in the Controller Display in Key and Drum Edit is slightly different. 
See the chapter “The MIDI Editors – General Information” in the electronic 
documentation.

Manipulating Notes
This section describes some basic MIDI editing techniques. Two fea-
tures are available to make editing easier:

• The Snap value.
The Snap value is used in the editors just like in the Arrange window, that is 
for restricting movement and editing to certain note positions. However, in 
the MIDI editors you can select smaller Snap values than in the Arrange win-
dow, for very fine adjustments of positions and lengths.

In the editors, you will also find 
the Snap to Groove option. 
This is described in the 
electronic documentation.
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• The Speaker Icon.
If you activate the Speaker button on the toolbar, notes and other Events will 
be played back when you click on them, move them or edit them on the Info 
line (see page 271).

Moving Notes
You move notes by dragging them with the Arrow tool, just like mov-
ing Parts in the Arrange window. If you select several notes, you can 
move them all at once, maintaining the relative distance between the 
notes.

Restricting movement to one direction

Sometimes you may want to transpose the note without moving it 
sideways, or vice versa. Proceed as follows:

1. Aim at the note with the Arrow tool and press the mouse button.

2. Start moving the note in the desired direction.

3. Press [Shift] and continue moving the note.
The note will now move in one direction only.

• You can also use the Kicker tools to move a note horizontally in 
Snap value steps.
This is described in the electronic documentation.
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Using Keyboard Commands

You can also move selected notes using Keyboard Commands:

Duplicating Notes
Again like in the Arrange window, if you hold down [Option], the 
notes you drag will be duplicated.

Changing the length of Notes
The following method can be used in Key and List Edit, to change the 
length of notes:

1. Set Snap to an appropriate value.
The length of the note can only be a multiple of the Snap value.

2. Select the Pencil tool.

3. Click on the right edge of the note, drag the outline of the note to 
a new length and release the mouse button.

It is also possible to use the Pencil tool to change the length of multi-
ple notes. This method is described in the chapter “The MIDI Editors 
- General Information”, in the electronic documentation.

Keyboard Command Description

[Command] + 
Left/Right arrow button.

Moves all selected notes one Snap value to the 
right/left.

[Command] + 
Up/Down arrow button

Transposes all selected notes one semitone up/
down.

[Command] + [Shift] + 
Up/Down arrow button

Transposes all selected notes one octave up/
down.
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Auditioning Notes

If you click on a note with the Speaker tool, it is played back. You can 
also drag over notes (and other Events) to play them back one after the 
other.

Deleting Notes
Just like Parts in the Arrange window, Notes (and other Events) can be 
deleted in several ways:

• By clicking on them with the Eraser tool.

• By selecting them and pressing [Backspace] (or selecting Delete Events from 
the Edit menu).

• By using various functions on the Do pop-up menu (described in the elec-
tronic documentation).
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Editing on the Info Line
At the top of each editor (except List Edit), you have the Info Line. 
This can be shown/hidden with the Info button.

The Info Line shows the values for the selected notes. The values can 
be edited, just as in the List in List Edit. If you have several notes se-
lected and edit them on the Info Line, the following rules apply:

• The Info Line displays the values of the first note, in orange.
When only one note is selected, the values are displayed in green.

• If you edit a value, all selected notes are affected relatively.
This means that the values for all notes are changed by the same amount.

• If you hold down [Option] and edit a value, all selected notes get 
the same value.

When the “i” button is lit, 
the Info Line is shown.
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Editing Velocity
One type of data you’ll be likely to view and edit often is velocity (or, 
more specifically, note-on velocity). This is slightly different from 
other types, since velocity is not an Event itself, rather a property of a 
note. This means that if there are no notes in the edited Part, you will 
not see any velocity values. Also, you cannot create velocity values 
(you have to enter new notes). 

Velocity values can be edited in most editors, but are probably best 
viewed and edited in Key or Drum Edit:

Showing and Hiding the Controller Display
Key and Drum Edit have a dedicated Controller Display at the bottom 
of the window, for showing velocity values and Events other than 
notes. 

• To show or hide the Controller Display, click on the Controller 
Display button in the lower left corner of the window.

By default, you can also show/hide the Controller Display by pressing [Op-
tion]-[C].

Once you have opened the Controller Display, you can change its size 
by dragging the Divider up or down:
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Displaying Velocity in the Controller Display
The Controller Display can show various types of data, but only one 
type at the time. To specify that the velocity values should be shown, 
proceed as follows:

1. Position the pointer on the Event type icon (in the Controller Dis-
play) and press the mouse button.
The Event Type pop-up menu appears.

2. Select “Velocity” at the top of the pop-up menu.
The velocity values are shown as bars, positioned according to their respec-
tive notes and with higher bars representing higher velocity values.

¶ In Drum Edit, you also have to select the Drum Sound for which you want to 
view the velocity values (by clicking on the Sound in the list to the left).
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Editing the Velocity values
To change the velocity of a note, proceed as follows:

1. Select the Pencil tool (or Drumstick tool, in Drum Edit).

2. To change the velocity of a note, click on its velocity bar.

To change a series of values, drag over them.

Creating a velocity ramp

To create a ramp of values, for example a fade-in or fade-out, proceed 
as follows:

1. Select the Line tool.

2. Position the pointer where you want the ramp to start and press 
the mouse button.

This display shows the numerical value at the mouse position 
(in this case, the velocity is set to 53).
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3. “Draw” the outline of the ramp with the mouse button pressed.

When you release the mouse button, the velocity values are changed:
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Editing Continuous Events
A lot of MIDI Event types are “Continuous” Events, such as After-
touch, Modulation and Pitch Bend (see page 246). While these can be 
edited in the Controller Display in Key or Drum Edit, it is even easier 
to do this in the Controller Editor.

¶ This section describes the basic features of the Controller Editor. For more de-
tailed information, see the Controller Editor chapter in the electronic docu-
mentation.

Opening the Controller Editor
This is opened much like any of the MIDI Editors:

1. Select the Track or Part(s) you want to edit.
You can only edit Parts on the same Track in the Controller Editor!

2. Pull down the Edit menu and select “Controller”.
The Controller Editor opens.
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Selecting which Event Types should be displayed
You can display any type of Continuous Events in the Controller Edi-
tor, and it is also possible to view several different Event types at the 
same time. Proceed as follows:

1. In the list to the left, click on the arrow button next to the label 
“Common”, so that the list of Common Event Types is visible.
This list contains the most commonly used Continuous Event types.

2. If you want to display an Event Type that is not included in the 
“Common” list, click on the “Controller” arrow button to display 
the complete list of MIDI Continuous Controller types.
As you can see, some of the Event Types are available in both lists.

3. Click on an Event Type to view it in the main display to the right.

4. If you want to view several different Event Types, hold down 
[Shift] and click on them.
The display to the right is divided into several smaller displays, each showing 
one Event Type.

The black dot indicates that the 
Part contains data of this type
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Creating new Events
1. Select what type of data you want to enter.

2. Use the Snap value to decide what “density” you want for the Events.
For very smooth Continuous Controller curves, you should use a small Snap 
value. However, please note that this creates a very large number of MIDI 
Events, which can cause MIDI playback to “stutter” in some situations. A me-
dium-low density is often sufficient.

3. Hold down the [Option] key.
From here on there are basically three ways to go:

4. Release the [Option] key.

If you want to enter just one Event, 
click once with the Pencil.

If you want to “paint a curve”, drag the 
Pencil (with the mouse button pressed).

If you want to create a perfect ramp, use the Line tool. This works in the 
same way as when creating velocity ramps - see page 274.
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Editing the Values
This is done just like creating new Events, except you do not press the 
[Option] key:

• To change one value with the Pencil, simply click on it.

• To change a series of values, drag over them with the Pencil.

• To create a ramp, use the Line tool.

You can also select a single Event by clicking on it with the Arrow 
tool, and editing its value numerically on the Info Line.

Deleting Events
You can delete Continuous Events in two principal ways:

• Click on the Events with the Eraser tool.

• Select the Events (by dragging with the Arrow tool) and press 
[Backspace].
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Closing the Editor
There are two ways of closing a MIDI editor, “Cancelling” and 
“Keeping”.

Cancelling
If you press [Esc] (escape) on the computer keyboard, the editor and 
all the changes you made since you last opened it are discarded.

• If you haven’t activated the checkbox “Only Show Important 
Alerts” in the Preferences–General–Miscellaneous dialog, you will 
be asked to confirm this:

Cancelling can be thought of as a super-undo. It allows you to try out 
a series of changes to a recorded piece of music and then easily revert 
back to its original state.

Keeping
If you close the editor by clicking the window’s Close box  or by 
pressing [Return], the window closes and all the editing you have 
made is kept.

“Yes” will cancel all changes you have 
made since you opened the editor.

“No” will exit the editor, 
but keep your changes.
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The “Keep Appended Events?” Dialog
If you close the editor and a dialog appears asking you if you want to 
“Keep appended Events”, this is because you have added Events out-
side the Part(s) being edited.

• If you click “Yes”, the Part will be extended to encompass the added Events.
• If you click “No”, the Events outside the Part will be discarded.
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Quantizing and Using 
Functions 16
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Introduction
By using “functions” you can perform various operations on notes and 
other MIDI Events, and in some cases on Audio Events as well.

• Quantization is a function that automatically moves Events, to tighten up the 
timing or to create a certain rhythmic feel.

• Other Functions may change dynamics, delete certain Events, change 
pitches, etc.

Some of the most important functions can be found on the Functions 
menu. In addition, the editors have their own “miniature” Functions 
menus, called the “Do” menus.

The main Functions menu and one of the Do menus – they both contain 
“functions”.
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What is affected when you perform 
Quantizing and other Functions?

Before explaining how the functions work, it is important to know ex-
actly what is affected by a function:

In the Arrange Window
If you use a function from the Arrange window, there are three op-
tions:

• If you have made a Range Selection with the Selection Range tool, any func-
tions will affect the contents of this selection only.

• If you have any Parts selected, any functions will apply to all selected Parts. 
• If there are no selected Parts, the function will apply to all Parts on the ac-

tive Track.
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In the Editors
All the editors feature a pop-up menu called “To”. There you can de-
cide which Events should be affected by a function. The menu options 
are explained in this figure:

All Events, active or 
inactive, will be 
affected.

This option has to do 
with the Loop feature, 
which is described in 
“An Introduction to 
the MIDI Editors”.

This option has to do with the Loop 
feature which is described in “An 
Introduction to the MIDI Editors”.

Only the selected 
Events inside the Cycle 
are affected.

All active or inactive 
Events inside the 
Cycle (between the 
left and right locators) 
will be affected, 
whether the Cycle is 
on or off.

All selected Events, 
active or inactive, 
will be affected.
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How Quantizing is performed

¶ The description below assumes that you are familiar with the basic principles 
of Quantization. For detailed information about the uses and theory of Quan-
tization, see page 290.

Setting Up and Applying Quantization
Before you apply quantization to the selected material for the first 
time, you need to make a few settings:

1. Select a Quantize Value from the Quant pop-up menu (in the Edi-
tors, this pop-up menu is labelled “Q”).

This value serves as a “guide” for the quantize function, determining to 
which positions the notes should be moved when you quantize. See page 
290 for a detailed description.

2. Pull down the Quantizing Type sub-menu on the Functions menu.
Listed on the sub-menu are different methods for quantizing.

These are the five different 
Quantize Types.

This part of the sub-menu 
is used to select a Groove 
(see page 297).
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3. Select the Quantizing Type of your choice and release the mouse 
botton.
The selected Quantizing Type is performed and will also remain selected for 
further use. The selected Quantizing Type is indicated by a check mark to the 
left on the sub-menu.

¶ If you prefer to not have Quantizing automatically applied when you select 
Quantizing Type, you can turn off this feature by deactivating the option “Se-
lecting Quantizing Type applies Quantize” in the Preferences–General–Mis-
cellaneous dialog.

Applying the Selected type of Quantization
Once you have selected a desired Quantize Value and Type, you can 
apply quantization directly, without having to make any settings. 
There are several ways to do this:

Using the Functions Menu

If you select “Quantize” from the Functions menu, the selected mate-
rial is quantized according to the set Quantize Value and Type.
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Using the Keyboard

By using a key command for the Quantize function, you can quantize 
Parts and Events without having to use the Functions menu. By de-
fault, the Quantize key command is [Q].

• You can also set up key commands for each Quantize Type. 
This allows you to select a Quantize Type and apply it, all with one key-
stroke.

• There are also key commands for each Quantize Value.
This allows you to change the Quantize Value with one keystroke. By de-
fault, the Quantize Value key commands are the numeric keys [1]-[8] on the 
“typewriter” part of the computer keyboard, so that pressing [1] sets the 
Quantize Value to a whole note, [2] to a half note, [3] to a quarter note, etc.

Automatic Quantize - Getting your music quantized while 
recording

When Automatic Quantize is activated, everything you record is im-
mediately quantized according to the currently selected Quantizing 
Type. The quantization can be undone, as described below.

• To activate Automatic Quantize, click on the AQ Button on the 
Transport Bar.

¶ Note that Automatic Quantize applies to MIDI recording only. See page 293 
for information about quantizing audio.
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Undoing Quantize

¶ Quantizing is not definite or irrevocable - not even after saving to disk! You 
can always re-quantize to any value, even to Off, unless you specifically 
“freeze” your Quantize, with “Freeze Quantize” (on the Functions menu). 

This means that notes quantized to eighths can later be quantized to 
sixteenths. The original (un-quantized) positions of the notes are used 
for determining how notes should be moved, except when using Itera-
tive Quantize. You can re-quantize just some notes in one of the Edit 
windows.

To completely restore quantized Events to their original positions, use 
the Undo Quantize function on the Functions menu. This can be ap-
plied to any selection of Parts or individual Events, just as all Func-
tions (see page 284).

• The default key command for Undo Quantize is [U].
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What is Quantizing?
Quantizing in its fundamental form is a function that automatically 
moves recorded notes, positioning them on exact note values: 

However, quantizing in Cubase VST is more than just correcting er-
rors, it is a creative feature. Using the various methods and settings, 
you can use quantizing to create new rhythmic feels:

If you for example record a series of eighth notes, some of them 
may end up slightly beside the exact eighth note positions.

Quantizing the notes with the Quantize Value set to eighth notes 
will move the “misplaced” notes to exact positions.

Note that this operation can affect both the timing, the length 
and the velocity (here indicated by brightness) of the notes.

Using Groove Quantizing to create a shuffle feel from a 
series of 1/16th notes:
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About the Quantize Value
The Quantize Value concept may need some explanation. By setting this 
value, on the pop-up menu on the Status Bar, you select the exact positions 
the notes should be moved towards when you quantize. These are the op-
tions:

The effect of the different Quantize Values is explained in the illustra-
tion on the next page.

This column is for selecting the basic 
Quantize note value. As you see, the 
available values range from 1 (whole 
note) to 128 (1/128 note).

If you select OFF, no 
quantizing will be done.

If you drag the pointer to the right, 
you can add a “T” or a “.” option 
to the note value. 
This will result in a Tuplet (T) or 
Dotted (.) Quantize Value.

In this example a Quantize Value 
of eighth note triplets is selected.

Selecting this item opens a dialog, used 
for setting which type of Tuplet should 
be used:

Most usually, you would set this to “3”, 
in which case you will be able to use 
Triplets for Quantize Values (by 
selecting one of the “T” values above).
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Quantizing with different Quantize Values

¶ The example below assumes you are using the Over Quantize method (see 
page 294), which moves notes to exact Quantize Value positions.

¶ When quantizing MIDI Parts, only notes are affected, not other Event types . 

Quantizing with an eighth note 
triplet Quantize Value moves the 
each second eighth note, creating 
a triplet shuffle beat.

Quantizing with a dotted eighth note 
Quantize Value moves notes to 
positions three sixteenth notes apart.

Quantizing the eighth note pattern with a quarter 
note Quantize Value, will move every second 
eighth note to even quarter note positions.

It is important to realize that there will now be two notes on each 
beat! This can give rise to strange sounds, increased volume etc. 

Start with a straight eighth note pattern.



CUBASE VST
Quantizing and Using Functions 16 – 293

16
16
16
16
16
16
16
16

16
16

About Quantizing Audio Parts

Quantizing Audio Parts affects the position of each Audio Event in the 
Part (taking the Q-point into account). Since Audio Parts in many 
cases contain only one Audio Event, quantizing audio is often not very 
useful. However, it is possible to split an audio segment into several 
smaller segments, and then apply quantization. This is described in the 
electronic documentation.
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The different Quantizing Types
As described on page 286, there are five basic Quantizing Types avail-
able on the Functions menu. The three most important ones are de-
scribed on the following pages. The rest are described in the electronic 
documentation.

Over Quantize

This is a very musical version of the standard “auto correct” quantize. 
Over Quantize will move notes to the closest Quantize Value, without 
changing the length of the notes. But it also detects and holds together 
chords (see the figure below) and if you consistently play behind, or 
ahead of the beat, it uses this fact when finding notes to move. In most 
situations, Over Quantize is probably the most suitable Quantize func-
tion to use.

When you Over Quantize (in this 
example with a Quantize Value of 4), 
Cubase VST realizes that the three 
notes are a chord, and holds them 
together.
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Iterative Quantize

If you want to straighten up the timing of your notes a little, but don’t 
want the precise feel you get from using Over Quantize, Iterative 
Quantize is probably the best bet. It works like this:

Instead of moving a note to the closest Quantize Value, Iterative Quan-
tize moves it only part of the way. You specify how much the notes 
should be moved towards the selected Quantize Value with the param-
eter “Iterative Q: Strength Percentage” in the Preferences–MIDI–
Quantize dialog.

In the same dialog you will also find the parameter “Don’t Iterative Q 
Notes Closer than”, which is a value in sixteenth notes and ticks. Only 
notes further away than the specified value are moved. This lets you 
allow a certain amount of loose timing, while still being able to 
straighten out really “off” notes.
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Creating a Shuffle Feel using Iterative Quantize

To show the difference between regular quantizing and Iterative Quan-
tize, let’s look at two identical eighth-note patterns:

The upper set of notes are 
Over Quantized to eighth 
note triplets...

...while the lower set of notes are 
Iterative Quantized using the same 
Quantize Value. Strength is set to 
66%. (Don’t Q is set to 800, but 
doesn’t really matter in this case.)

The upper pattern gets a heavy, precise triplet feel...

...while the lower pattern gets a more jazzy, natural shuffle feel.
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Groove Quantize
This type of quantizing is not meant for correcting errors, but for cre-
ating rhythmic feels. This is done by comparing your recorded music 
with a “Groove” (a pattern with a certain feel) and moving the appro-
priate notes so that their timing matches the one of the Groove. You 
can for example easily create the shuffle feel from the Iterative Quan-
tize example above, using a suitable Groove instead. Furthermore, 
Grooves can also contain information about velocity and length, al-
lowing you to tailor the complete rhythmic feel of your music.

You select a Groove from the list on the lower half of the Quantizing 
Type sub-menu on the Functions menu (Grooves may also be organ-
ized in different folders, in which case more submenus appear in this 
list). 

There are a lot of Grooves included with Cubase VST from the begin-
ning, but you can also load new ones from disk or make up your own, 
using the Groove Box (see the chapter “More about Quantizing and 
Grooves” in the electronic documentation).

The sub-menu structure on the Groove list 
corresponds to the folder structure in the 
selected Groove folder on your hard disk.
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Other Functions
The Functions menu is not only used when quantizing, it contains a lot 
of other functions as well. In addition the “Do” menus in the editors 
contain useful editing functions. The same rules as for Quantizing are 
used to decide what gets affected.

The various functions on these menus are described in the  “Menu and 
Dialog Reference” section and in the electronic documentation.
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Introduction
This chapter describes the general procedures of handling levels, pan, 
EQ and effects to create a final stereo mix. Mixing is done in different 
windows in Cubase VST, mainly the Audio Channel mixer (for audio) 
and the MIDI Track mixer (for MIDI).

Mixing Audio

¶ This chapter assumes that you are using “standard” audio hardware with ste-
reo outputs only. If you have audio hardware with more than two outputs, 
you can route different audio channels to different outputs, using the Bus sys-
tem. This is described in the chapter “The Input/Output Bus System” in the 
electronic documentation.

Setting Levels
1. Pull down the Panels menu and select “Audio Channel Mixer”.

The Audio Channel mixer window opens.

2. Select “Audio Master Mixer” from the Panels menu.
The Master window opens. This is used to set the final level of the mixed sig-
nals. 
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3. If possible, try to arrange the windows so that you can see both the 
Audio Channel mixer and the Master window at the same time.

4. In the Audio Channel mixer window, make sure the “In” buttons 
are not activated for the audio channels.
When these are activated, the level meters show the input level instead of the 
playback level.

5. Make sure neither the “Read” or the “Write” buttons are acti-
vated.
These are used for automating mixer movements, as described in the elec-
tronic documentation. For now, we’ll stick to manual mixing.

6. Activate playback, and use the faders to set the relative volume for 
the audio channels.
The fader settings are displayed numerically below the faders. You can boost 
weak signals by +6 dB in the Audio Channel Mixer, if you like. Just be sure to 
avoid signal levels above 0 dB (clipping - see page 86).

Clipping is indicated by the red clip 
light above the “In” button. To reset 
the clip indicator, click on it.
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• For stereo channel pairs, the faders are automatically “linked”, i.e. 
moving the fader for the left channel will automatically move the 
fader for the right channel, and vice versa.
Stereo channel pairs are indicated graphically in the following way:

To set the level independently for one channel in a stereo pair, hold down 
[Option] and drag the fader.

• If you hold down [Command] and click on a fader, it will automat-
ically be set to position 0.0 dB.

7. Adjust the total volume with the faders in the Master window.
The faders are linked, i.e. if you move one fader the other will move as well. 
If you want to adjust the level of one stereo channel independently, press 
[Option] and move the fader.

A stereo channel pair

Mono channels
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About automating levels

There are two ways of automating level settings:

• By using the Write/Read function in the Audio Channel Mixer.
As described in the chapter “Mixing Audio and using Effects” in the elec-
tronic documentation, this allows you to record and play back fader move-
ments (as well as most other mixer and effect settings).

• By using the Dynamic Event feature in the Audio Editor.
This allows you to set volume curves for individual Audio Events. See the Au-
dio Editor chapter in the electronic documentation.
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Setting Pan

With the Pan controls, you set the stereo position of each audio chan-
nel. Like volume, pan settings can be automated using the Write/Read 
function or the Dynamic Events in the Audio Editor.

• When you are changing Pan for a channel, the setting is shown nu-
merically (L63–R63) in the level display below the fader.
To make the display show the fader setting again, click the fader handle.

• To select center Pan position, hold down [Command] and click on 
the Pan control.

• For audio channels in a stereo pair, you should probably pan the 
left (odd-numbered) channel fully left and the right (even-num-
bered) fully right.

¶ If the Mono switch in the Master window is activated, all audio playback will 
be in mono, and the Pan settings will have no effect.

The Mono switch
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Using Mute and Solo

For each audio channel, there is a Mute and a Solo button, which can 
be of great use when you want to listen closely to one or several audio 
channels. These work as follows:

• Clicking the Mute button silences the output of the audio channel.
To deactivate Mute, click on the button again.

• Clicking the Solo button silences the output of all other audio 
channels.
You may Solo several audio channels at the same time if you like. To deacti-
vate Solo, click on the button again.

Mute and Solo settings can be automated using the Write/Read func-
tions in the Audio Channel Mixer. See the electronic documentation.

The MIDI Mute button

Activating the MIDI Mute button will turn off all MIDI output. Use 
this when you want to concentrate on the audio, setting levels, eq, etc. 
Closing the Audio Channel mixer will automatically deactivate the 
MIDI Mute function.
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Making Equalizer settings
Cubase VST is equipped with a powerful equalizer. Depending on 
your computer power and available free resources, you can have up to 
4 bands of full parametric EQ per audio channel!

Each audio channel has its own EQ window. To activate and set EQ for 
a channel, proceed as follows:

1. Click on the “EQ” button at the top of the channel strip.
The EQ and FX Send window opens. This contains a duplicate of the Audio 
Channel mixer channel strip, a row of effect send knobs (see page 311) and 
1–4 EQ modules.

An EQ and FX Send window with two EQ modules visible and active.

¶ If you make Equalizer settings for the left channel in a stereo channel pair, 
the settings will automatically be reflected in the right channel.
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2. If you like, activate the “Hi Quality” button.

In the Hi Quality mode, you will get an EQ with improved audio quality. We 
recommend that you use this, except if you want to play back Songs mixed in 
a previous version of Cubase VST (where the Hi Quality mode wasn’t availa-
ble). However, if you need to conserve computer power you might consider 
turning off Hi Quality mode (which requires more processing power). Note 
that you can activate or deactivate Hi Quality independently for different au-
dio channels.

3. Use the arrow buttons in the top right corner to set the number of 
visible EQ modules.
This helps you avoid “screen cluttering” by hiding unused modules.

4. Activate as many EQ modules as you need (up to four) by clicking 
on their “Enable” buttons.
As soon as any of the EQs are activated, the “Active” button and the “EQ” 
button indicator in the channel strip are lit.

¶ The maximum total number of EQ modules (for all channels together) is gov-
erned by your computer’s performance. If you activate more EQ modules 
than your system can handle, you will note that the “Over” indicator in the 
Audio Performance window lights red, and the audio playback stutters and 
distorts. Keep an eye on the Audio Performance bar graphs and deactivate a 
number of EQ modules, until the computer load seems normal.
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5. Set the parameters for the activated EQ module.
It is perhaps easiest to set up a playback cycle and experiment with the set-
tings until you get the desired sound. The three basic EQ parameters are:

The other EQ parameters are described in the chapter “Mixing and 
Using Effects” in the electronic documentation.

¶ Please note that high Gain values may give rise to distortion. Check the chan-
nel level meters and compensate with the channel volume faders.

6. Close the EQ window by clicking on its close box in the upper left 
corner.
In the Audio Channel mixer, the “EQ” button indicator for the audio channel 
will now be lit, which means EQ is applied to that channel.

Turning EQ on and off from the Audio Channel Mixer

When you have enabled the desired EQ modules and made settings, 
you can turn equalizing on and off for the channel from the Audio 
Channel Mixer window, by holding down [Control] and clicking the 
“EQ” button for the channel. This toggles the status of the Active but-
ton in the EQ and FX Send window.

Gain Governs the amount of boost or attenuation around the set 
frequency. The value range is ± 24 dB (or ± 12 dB if you have 
deactivated Hi Quality mode).

Frequency The center frequency for the equalization. Around this fre-
quency, the sound will be boosted or attenuated according 
to the Gain setting. The range of the Frequency parameter is 
determined by the Hi and Lo Limits.

Q Determines the width of the frequency band around the 
center frequency to be affected. The narrower frequency 
band, the more drastic effect of the boost or attenuation.
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Applying Effects
There are three basic types of effects in Cubase VST; insert effects 
(applied separately to each channel, by using the channel inserts in the 
Audio Channel Mixer), send effects (applied separately to each chan-
nel by using the effect sends in the Audio Channel Mixer) and master 
effects (effects that accept a stereo input, and are inserted into the mas-
ter mix). 

• Insert effects are used when you want all sound from a channel to be proc-
essed. Typical insert effects would be distortion, filters, auto panners, etc. 

• Send effects are used when you want to mix the effect signal with the “dry” 
(unprocessed) signal. Typical send effects would be reverb, delay, chorus, 
etc. 

• Master effects are used when you want to process the final stereo mix. Typi-
cal master effects would be noise reduction units, compressor/limiters or 
other effects that change the overall characteristics of the final stereo signal.

In this section, we will only describe how to use send effects. Insert 
and master effects are described in the chapter “Mixing and using Ef-
fects” in the electronic documentation.
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Routing an Audio Channel through the Send Effects

You can have eight different send effects in Cubase VST, and you can 
send the signal from each audio channel to any combination of these 
eight effects. First you need to activate the effect “processors” you 
want to use. This is done in the Audio Send Effects window:

1. Pull down the Panels menu and select Audio Send Effects.
The Audio Send Effects window opens. This resembles an effect rack, with up 
to eight separate “processors” arranged on top of each other. If you have less 
than eight effects selected, there will be a slot at the bottom of the window, 
labeled “No Effect”:

The size of the window depends on the number of activated effects.

2. Pull down the pop-up menu to the right in the “No Effect” slot.

The Audio Send Effects window with no effects activated: 

The Audio Send Effects window with five effects activated: 
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You can select between the following effects (for more detailed de-
scriptions, see the separate Acrobat documents for each Effect Plug-
in):

Other effects may be included with the program when you purchase it. 
There are also additional Effect Plug-Ins separately available - contact 
your Steinberg dealer for more information. 

3. Select an effect from the pop-up menu.
When you select an effect, the “No Effect” slot turns into a “normal” effect 
slot, and another “No Effect” slot appears below it in the window (provided 
that all eight effect slots aren’t already in use).

4. Activate the effect processor by clicking on its “Power” button.

Effect Description

Choirus A chorus and flanger effect, which adds “depth” and “an-
imation” to a sound.

Choirus2 For some computer configurations, the original Choirus 
effect gave rise to clicks and distorted sound. The 
Choirus2 effect solves this problem. It is identical to the 
“Choirus Classic” featurewise, but draws slightly more 
computer power.

Espacial A reverb effect, adding ambience and “room quality” to 
the sound.

Fuzz A simulation of a typical transistor fuzzbox.

Auto Pan Makes the sound move automatically between the left 
and right channel.

Stereo Echo A delay effect, with the possibility to set different delay 
times for the left and right channel.

Tun-a This is not really an effect - but a chromatic tuner. Use 
this to tune your instruments before recording.

WunderVerb 3 A reverb that provides smoother, denser reverberation.



CUBASE VST
Mixing 17 – 313

17
17
17
17
17
17
17
17

17
17

5. Set the Effects Master knob to a moderate value.
This governs the total input level to the effect processor. You may have to ad-
just this setting later.

6. If you wish to activate more effects, repeat steps 2 to 5.
Remember that the Effects rely heavily on the CPU power in your computer. 
The more activated effect units, the more computer power will be used for ef-
fects.

¶ To turn off an effect completely, pull down the Effect Type pop-up menu and 
select “No Effect”.

Now, you need to set up the effect sends, so that the audio signals are 
routed to the effects you just activated:

1. Open the Audio Channel Mixer.

2. Click on the EQ button for the audio channel you want to add ef-
fects to.
The EQ window opens, as described on the previous pages (you can also 
open this by clicking on the EQ button in the Inspector). The section between 
the channel fader and the EQ modules contains the effect sends.

Effects Master knob

Power button

Send level

Pre-fader Send switch

Dry Button (affects all eight sends)

Send routing popup

Send On/Off
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3. Make sure the “DRY” button is not pressed.
When this button is pressed, all eight effect sends are deactivated for the 
channel. Click on it to turn the function on/off.

4. Click on the “On” button for one of the effect sends and turn the 
corresponding Send level knob to a moderate value.

5. Pull down the pop-up menu below the Send level knob.
This is the Send Routing pop-up menu, used for routing the send to the de-
sired effect processor.

The first items on this menu correspond to the activated internal effects (up to 
eight) while the following items route the effect sends to Buses and Groups 
(see the electronic documentation).

6. Select an effect from the pop-up menu.

¶ It is possible to assign two or more effect sends to the same effect slot, but this 
is not useful and would probably only lead to distortion in the effect unit.

7. If you want the signal to be sent to the effects before the faders, 
click on the Pre button for the send.
With Pre-fader effect sends, the amount of effect for the channel is not af-
fected by the volume fader. With Post-fader effect sends (Pre button not 
pressed), the amount of effect is proportional to the channel volume, and will 
change with the volume fader movements.

8. If you want to use several effects for this audio channel, repeat 
steps 4 to 7 above for the other effect sends.
Make sure to deactivate all effect sends you don’t intend to use.
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Finally, you need to select programs for the effect processors. Since 
you will probably need to adjust the send levels while doing this, leave 
the FX/EQ window open.

1. Return to the Audio Send Effects window.

2. Click on the Prog. button, to put the processor in Program mode.

3. Step between the effect programs, either by clicking on the left or 
right part of the Prog. button or by rotating the value dial.
The number of program locations depends on selected effect type. It might be 
a good idea to set up a cycle and have the audio channel play back while 
you are making settings, to hear the effect of your selected effect programs.

¶ Not all effects come with ready-made programs.

4. Use the send level knob in the FX/EQ window to adjust the amount 
of effect for the audio channel.

5. If you have several effect processors activated, repeat steps 2 to 4 
for these. 

¶ The effect settings can be edited and automated, as described in the elec-
tronic documentation.
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Mixing MIDI

¶ To be able to “mix” your MIDI Tracks, your MIDI Instruments must be able to 
respond to MIDI Volume and Pan messages. Furthermore, if your instruments 
support any of the standards GS (Roland's extension of GM) or XG (Yamaha's 
extension of GM), you will be able to control various other parameters in the 
instruments, such as effects, filters, envelopes, etc.

What is MIDI “Mixing”?
The easiest way to mix your MIDI Tracks (or really, to change levels, 
pans and other settings in your MIDI Instruments), is to use the MIDI 
Track Mixer. This is opened by selecting MIDI Track Mixer on the 
Panels menu.
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Even though the MIDI Track Mixer resembles the Audio Channel 
Mixer, there is a big difference between how they work: While the Au-
dio Channel Mixer actually affects the audio played back, the MIDI 
Track Mixer emulates this by sending out MIDI Controller messages 
to your MIDI Instruments. For example, changing the volume for a 
Track in the MIDI Track Mixer causes Cubase VST to send out MIDI 
Volume messages to the instrument. This is important to realize, since 
it affects the behaviour of the Mixer in many ways.

MIDI Track Mixer vs Inspector Settings

Many of the settings in the MIDI Track Mixer are also available in the 
Inspector. Settings you make in the MIDI Track Mixer are reflected in 
the Inspector, and vice versa, according to the following rules:

• Inspector settings made for the Track are reflected in the MIDI Track Mixer.
• Inspector settings made for single Parts are not reflected in the MIDI Track 

Mixer.
• Settings you make in the MIDI Track Mixer affects the Inspector settings for 

the Track (but not for individual Parts).
• Mixer automation (created with the Write/Read function in the MIDI Track 

Mixer) will not be reflected in the Inspector.

When you play back a MIDI Track this may cause some confusion: 
Consider a Track set to the volume 90 (in the MIDI Track Mixer or 
Track Inspector). Somewhere a bit into the Track, there is a Part set to 
volume 127. On playback, when the Song position reaches this Part, 
the volume will be raised in your instrument, but this will not be re-
flected in the MIDI Track Mixer! The same thing will happen if the 
Parts contain recorded controller messages. Therefore:

¶ If you want to have “absolute control” over the volume, pan etc from the 
MIDI Track Mixer (manually or using automation), make sure that all Inspec-
tor Part Parameters are set to OFF and that the Parts don’t contain any con-
troller messages of those types.
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The Relationship between Tracks and “Mixer Channels”
For each MIDI Track or Drum Track, there is one channel fader 
(Folder Tracks are also displayed in the MIDI Track Mixer - see the 
electronic documenation for details). 

If you create new Tracks or delete any existing Track, the Mixer will 
adjust accordingly.

¶ Please note that you can have several MIDI Tracks set to the same MIDI 
channel. Since all actions in the MIDI Track Mixer send out MIDI messages 
(volume, pan, etc), this means that “mixing” one of these Tracks also affects 
all other Tracks set to the same MIDI channel. 
For example, if you move the fader for one of the Tracks, the faders for the 
other Tracks on the same channel will move accordingly.

¶ Tracks set to channel “Any” are displayed in the MIDI Track Mixer, but you 
cannot make any settings for them. The “Any” channel concept is explained 
in the chapter “How Cubase VST handles audio and MIDI” in the electronic 
documentation.

Setting Levels
You adjust the levels of your MIDI Tracks by moving the faders.

The level settings may be automated, using the Write/Read functions. 
See see the MIDI Track Mixer chapter in the electronic documentation.

When you move a fader, the display below it 
shows the setting numerically (0-127). This is 
the value of the MIDI Volume message sent 
out on the corresponding MIDI channel.



CUBASE VST
Mixing 17 – 319

17
17
17
17
17
17
17
17

17
17

About the Meters

As in the Audio Channel mixer, playback is reflected by the level me-
ters next to each fader. However, in the MIDI Track Mixer, the level 
meters actually show the velocity values of the MIDI data being 
played back. This means that the faders (which adjust the volume in 
the instrument) don’t affect the meters (which indicate the velocity of 
each Event that is played back). Also, playing back one single long 
note will only cause the level meters to flash briefly at the beginning of 
the note - since they only respond to the note-on messages, not to the 
actual sound level.

Setting Pan
You adjust the pan (stereo position) of your MIDI Tracks with the pan 
controls. 

The pan settings may be automated, using the Write/Read functions. 
See see the MIDI Track Mixer chapter in the electronic documenta-
tion.

When you change this setting, 
the display below the fader 
shows the setting numerically 
(L63 - <C> - R63).
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Using Mute and Solo

On each Mixer channel strip, there is a Mute and a Solo button, which 
can be of great use when you want to listen closely to one or several 
MIDI Tracks.

• Clicking the Mute button silences the output of the Track.
To deactivate Mute, click on the button again.

• Clicking the Solo button silences the output of all other Tracks in 
the MIDI Track Mixer.
Tracks that are not visible in the MIDI Track Mixer (Audio Tracks, Chord 
Tracks, etc) are not affected by this.
You may Solo several Tracks at the same time if you like. To deactivate Solo, 
click on the button again.

Mute and Solo settings can be automated using the Write/Read func-
tions in the MIDI Track Mixer. See the electronic documentation.

The Audio Mute button

Activating the Audio Mute button will turn off all Audio output, by 
Muting all Audio Tracks in the Arrangement. Use this when you want 
to concentrate on the MIDI material.
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Changing the Track Names
At the bottom of each mixer channel strip, the name of the corre-
sponding Track is displayed. By double clicking on this, you can 
change the name of the Track, just like in the Arrange window.

Advanced Settings
At the top of each channel strip you will find an arrow button. Clicking 
on this extends the channel strip, displaying various other settings (ef-
fects, synth parameters, etc). For details about how to use these, see 
the MIDI Track Mixer chapter in the electronic documentation. There 
you will also find information about how to automate your mixer set-
tings, and how to customize the MIDI Track Mixer.
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What is QuickTime?
QuickTime is an extension to the Macintosh operating system that al-
lows you to play back movies in a window on your Macintosh.

Cubase VST supports QuickTime, which means that you can have 
video playing on your screen, synchronized with Cubase VST’s play-
back.

What can I do with QuickTime in Cubase 
VST?

• You can open any QuickTime movie and play it on your screen, 
synchronized with Cubase VST’s playback.

• You can import an audio track from a QuickTime movie into Cu-
base VST.
This allows you to edit the audio data in the movie, cut out unwanted parts, 
add music, etc..

• You can export audio from Cubase VST and import it into a Quick-
Time movie.

The last two options are described in the chapter “Quicktime Movie 
capabilities” in the electronic documentation. In this book we will 
concentrate on the first possibility.
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Playing a movie in sync with Cubase VST 

Adding the Movie to the Song
1. Pull down the Options menu and select “Setup...” from the Movie 

Setup sub-menu.
The Setup Movies dialog opens.

2. Click the “Add Movie” button.
The standard QuickTime file dialog appears. This shows a Preview still image 
of the movie to the left. If there is no Preview you can create one for the se-
lected Movie file, using the “Create” button.

3. Locate the movie file, select it and click Open.
This adds the movie to the list in the Setup Movies dialog (and to the Song, 
see page 326).
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Opening the Movie
Once you have added a movie, there are two ways to open it on the 
screen:

• In the Setup Movies dialog, select the movie in the list and click 
Open Movie.

Or:

• Pull down the Windows menu and select the movie directly from 
the Movies submenu.

Playing back

• When you activate playback in Cubase VST, the movie plays back in sync.
• To turn off synchronized playback, deactivate the “On Line” function in the 

Movie window.
• When you activate playback in the movie window, only the movie will 

play, regardless of the “On Line” setting.

¶ The audio in the movie is not played back when you play the Movie from 
within Cubase VST.
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Positioning
The positions of Cubase VST and the movie are completely linked. 
This means that when you Fast Forward, Rewind, Locate etc, the 
movie will be positioned accordingly. Also, when you perform the 
same operation in the Movie window, Cubase VST’s song position 
will move with the Movie’s.

Setting an Offset
The Movie window has a Start Time setting. This can be used to set a 
start point for the movie in the Song. The value is in time code 
(SMPTE) format.

If for example you set this to “0:1:0:0:0”, the Movie will start one 
minute in, from the beginning of the Song.

Saving the Movie List
When you save the Song, the list of added Movies is saved with it. 
This does not mean that the actual movies are copied into the Song 
file, only that the program keeps track of which Movies were used and 
where on your hard disk(s) they are located.
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The Find Movie Feature

If you open a Song containing movies, and one of the movie titles is 
greyed out in the Setup Movies dialog, this means that the program 
couldn’t find the movie in question. For example, you may have re-
named the movie document, moved it to another folder, etc. To “find” 
the movie again, use the Find Movie feature:

1. Select the greyed-out movie in the Setup Movies dialog.

2. Click the Find Movie button.
A file dialog appears, allowing you to re-find the movie.

3. Locate the movie, select it and click open.
Remember to save the Song if you want to keep the new path to the movie.
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About the various File Formats
Cubase can read and write many different file formats which contain 
different types of information. Some file formats support specific Cu-
base functions and can only be read by Cubase alone, while others are 
designed for importing/exporting information between different com-
puter programs. Being familiar with the different file formats will help 
you to make the right decisions when saving and opening your music, 
transferring music between Cubase and other computer programs, and 
when customizing your Cubase setup and its functions.

The two main File Formats - Song and Arrangement
There are two main document formats you can use for saving your 
music: Song and Arrangement. A third option; MIDI File, is available 
if you want your music (MIDI only - no audio) to be playable in other 
sequencers (see page 343). If you want to save your music for further 
use in Cubase VST, you should use either the Song or the Arrange-
ment format:

Song

When you save a Song, the following information is included:

• All the Arrangements.
• The Pool, all audio settings and audio file references (but not the actual audio 

files themselves).
• The entire Setup, that is, settings in dialogs and on menus, Groove maps, 

Transport Bar settings etc.
• The Drum Maps.
• All preferences with the “Save with song” option activated (see page 71).
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Arrangement

When you save an Arrangement, the following is included:

• All the things you see in one Arrange window; the Tracks, the Parts, Inspector 
settings, tempo, etc.

• The audio file references for the audio Parts used in the Arrangement.

The Arrangement format is often perfectly adequate for saving a piece 
of music. The pros and cons of both formats are shown in the table on 
the next page.

File Format Advantages Disadvantages

Arrangement • Takes up little disk space.
• Can be saved, and opened in 
another Song, which is an easy 
way to transfer music between 
different Songs.
• Does not contain “unneces-
sary” settings if all you want to 
save is the music.
• Opening an Arrangement 
does not affect settings in dia-
log boxes and on menus, 
which, in some situations, is 
an advantage.

• Does not contain any 
audio settings, other than 
the audio file references 
used in the Arrangement.
• Does not contain a 
complete “snapshot” of 
the program’s “state”.

Song • Contains the complete Pool 
and all other audio settings.
• Contains more than one Ar-
rangement.
• Saves all the settings on all 
menus, in all dialog boxes etc.
• Includes the Drum Map.

• Takes up more disk 
space than the Arrange-
ment file format, even if 
you only have one Ar-
rangement in the Song.
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¶ Even though the Song files contain all audio references, they do not contain 
the actual audio files! If you want to transfer a Song containing audio to an-
other computer, you need to move the audio files as well. The Prepare Ar-
chive and Prepare Master functions in the Pool make this easier - see the Pool 
chapter in the electronic documentation.

Other File Formats
Besides the file types Song and Arrangement, there are a number of 
different formats that are used for different purposes.

What’s the difference between “Native” and Imported/
Exported File Formats? 

A native file is one that is designed for use in Cubase exclusively. 
These files can generally not be read by other computer programs. Im-
ported/exported files on the other hand, are ones that can be read by 
various computer programs. The difference between the two becomes 
apparent when comparing the file types Arrangement and MIDI File. 
Both contain MIDI data but while MIDI Files can be read by other 
computer programs, Arrangements can’t. An Arrangement is a native 
file format while a MIDI File is an import/export file format.

¶ As a rule, native file formats are opened and saved using the Open and Save 
commands, while other file formats are handled with specific Import/Export 
functions.
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Native File Format Table

The following file formats are native ones:

File Format Explanation

Song Complete Cubase document format including audio ref-
erences.

Arrangement Cubase document format containing MIDI data etc.

Part Contains audio or MIDI Events. Audio Parts also include 
the audio file references for these Events. This makes it 
possible to import Audio Parts into other Songs, without 
having to import their audio files separately in the Pool.

Drum Map Contains settings for drum sounds, for use with drum-
tracks.

Setup Contains information about various general settings in 
the program.

Window Set Contains a “snap-shot” of a window set.

Keyboard Layout Contains a custom set of key commands.

Score Set Contains various settings used in Score Edit. This item is 
only available in the Cubase VST Score and Cubase VST/
24 program versions.

Stationery This file format behaves like a Song in all respects, except 
that you cannot save it by using the “Save” option - you 
have to use “Save As”. Stationery files can be used as 
templates (the Autoload Song is an example of this - see 
page 339).
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Export/Import File Format Table

The following files are of the import/export type:

File Format Explanation

MIDI File Export/Import format for Standard MIDI Files. Can be created 
and read by various computer programs (see page 341).

24 Song This allows you to import Songs created with Steinberg Pro-
24 (an older sequencer software).

Audio File As described on page 223, audio files can be imported into 
Cubase VST (into the Pool, the Arrangement or the Audio 
Editor).

ReCycle (REX) 
File

This allows you to import REX-files (Recycle EXport files) 
created in Steinberg ReCycle (a powerful software for han-
dling sampled loops). See the ReCycle chapter in the elec-
tronic documentation.

3.x Song/Ar-
rangement

This allows you to save recordings you have made with Cu-
base VST 4.0 in a format that can be read by the previous 
version of Cubase VST.
If you wish to do the opposite, i.e. open Songs or Arrange-
ments created in an earlier VST version, you can just open 
them with the Open command as usual.

3.x Grooves Allows you to open Groove files created with previous ver-
sions of Cubase.

Movie Quick Time Movie file format (see page 322).
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Opening
1. Select Open... from the File menu.

The Open dialog appears.

2. Use the File Type pop-up to select which type of file you want to 
open.

3. Locate the correct folder on your hard disk using the standard 
Macintosh buttons and file list.

4. If you like, you can reduce the number of files displayed, by using 
the Date pop-up menu (see below).

5. Click on the file in the file list.
The list will only show documents of the selected type.

6. Click Open.

File List

The File Type 
pop-up menu

File selected 
for opening

The Date pop-up menu.
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The Date pop-up

The Date pop-up menu serves as a “filter” for which files should be 
listed in the Open dialog. The following options are available:

Any Time All files of the specified type are listed, regardless of 
their “last changed” date.

Today Only files changed today are listed.

Yesterday Only files changed yesterday are listed.

Last Week Only files changed during the last week (up to and 
including yesterday) are listed.

Earlier than Last Week Only files changed earlier than last week are listed.
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About opening Songs

If the file is a Song, and you haven’t saved the currently loaded Song, 
you will be prompted with a reminder that the Song you open will re-
place the current Song. 

• Click Save if you want to save the current Song before opening a 
new one.

• Click Discard to open the new Song without saving the current 
one.

• Click Cancel to abort the operation (i.e. not open any new Song).

About closing Songs

There is no way to close the Song in Cubase VST! The Close com-
mand on the File menu only closes the current Arrangement, as de-
scribed on page 175. If you want to create a new Song, you should use 
the New Song command on the File menu.

About opening Arrangements

If the file is an Arrangement, it will appear as a new window on screen, 
in addition to any Arrange windows already open. You can have up to 
16 Arrangements in your Song at the same time.

See page 173 for information about how to name, close and set aside 
Arrangements.
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Opening Recent Files
At the bottom of the File menu, the last ten opened files will be listed. 
By selecting directly from this list, you can quickly open recently used 
files without having to use the file dialog.

Using the Library Feature
In the Cubase program folder is a sub-folder named “Library Files”. 
You can open the files located in this folder from the sub-menu “Open 
from Library” on the File menu.

Place files that you use on a regular basis in the Library Files folder. 
This could be files of any native file type, such as drum maps, template 
Songs, mixer maps, etc.
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Saving
When you have edited or in any other way altered documents and want 
to keep them that way, they must be saved on your hard disk. This is 
done using the “Save As...” or “Save” items on the File menu:

Using “Save As...”
1. Pull down the File Menu and select “Save As...”

The file dialog appears.

2. Use the standard Macintosh buttons and file list to find the loca-
tion on your hard disk where you want to save the file.

3. Use the file type pop-up to select a format.

4. Type in a name for the file.

5. Click the Save button.

Using “Save”
On the File menu you will also find a menu item called “Save”.

• If you have already saved your Song once (using “Save As...”) selecting Save  
(or, by default, pressing [Command]-[S] on the computer keyboard) will save 
your Song without asking for a file name and location. The file you save now 
will simply overwrite the earlier version.

• If you have not yet saved your Song, selecting “Save” is the same as selecting 
“Save As...”.

File List

The File Type 
pop-up menu

File Name
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Customizing Cubase VST - the Autoload Song
Each time you launch Cubase VST, a default Song called “Autoload” 
is opened. This makes it possible to customize the default functional-
ity and layout of the program:

1. Launch the program. 

2. Set up the program as you want it.
This may include the number and organization of Tracks, MIDI setup, Drum 
Map, Metronome settings, Audio settings, Part color and appearance and 
much more. See the Customizing chapter in the electronic documentation.

¶ Remember to activate the “Save with Song” checkbox for the settings you 
make (see page 71).

The “Save with Song” checkbox in the Audio System Setup dialog.

3. Select “Save As” from the File menu.

4. Navigate to the Cubase VST program folder.

5. Type in the name ”Autoload” (without the quote signs) and click 
Save.
You will be asked if you want to replace the current Autoload file. Click Re-
place.

Next time you launch Cubase VST, you will automatically get your 
desired setup and layout.
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About the Autosave Feature

In the Preferences–General–Miscellaneous dialog you will find a set-
ting called Autosave. If you activate this, you can set how often the 
program should automatically save your Song. The Song is saved in 
the same folder as the original file, under the name “XXX Autosave”, 
where “XXX” is the name of the original Song file.

Using the Save Backup feature
By using the Save Backup feature on the file menu you can save a 
backup copy of the current song. This copy is a complete replica of the 
original song and has the same name, with an additional number that 
corresponds to the number of backups made. If you for example save a 
backup of a song called “Jammin”, the first backup will have the title 
“Jammin 2”, the second; “Jammin 3” etc. This feature enables you to 
save copies of your music at different stages in a song. This might be 
useful if you want to try out different ideas without risking to loose ex-
isting recordings etc. The backup copies are placed in the same folder 
as the original files.

Revert to saved
If you for example have edited several tracks and afterwards change 
your mind, you can revert back to the last saved version of the song by 
using the “Revert to saved” command on the File Menu. When you 
use this command, all changes made since the last time you saved the 
song are lost. If you are using the “Autosave” or “Save Backup” func-
tions, please be aware that the Revert to saved function only recog-
nizes a manual save, and therefore does not revert to the last autosave 
or saved backup.



CUBASE VST
File Handling 19 – 341

19
19
19
19
19
19
19
19

19
19

Importing
To open files of a non-native format, you use one of the Import options 
on the File menu:

Importing MIDI Files
1. On the File menu, select “MIDI File...” from the Import submenu.

Cubase VST recognizes files as MIDI Files if they meet one of two 
criteria:

• The file is a Macintosh file with the file type “Midi” (the standard file type for 
MIDI File on the Macintosh).

• The file has the extension “MID” (the standard MS-DOS extension for MIDI 
Files).
The file dialog appears.

2. Locate the file and select it in the file list.

3. Click Open.

4. Use the dialog box that appears to decide if you want the file to ap-
pear in a new Arrange window or if you want to merge the MIDI 
File into the current Arrangement.
If you choose the latter option, the file will appear in the current Arrange-
ment, starting at the Left Locator position.

¶ When you import a MIDI file, there are a number of settings that affect how 
the file is split up, how program change messages are handled, etc. These set-
tings are found in the Preferences–MIDI–MIDI Files dialog. See the Menu 
and Dialog Reference document for descriptions of the settings.
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Importing Audio Files
Audio files can be imported in several ways:

• By dragging files directly from the Finder into the Arrangement or the Pool.
• By using the Import Audio command in the Pool (see page 223).
• In the Arrange window, by selecting “Audio File...” from the Import submenu 

on the File menu. The imported Audio file will be placed on the selected Au-
dio Track, at the position of the Left Locator (see the chapter “Importing and 
Exporting Audio” in the electronic documentation).

• You can also import audio files directly into the Audio Editor, using the Pen-
cil tool (see page 234).

Importing ReCycle Files
Steinberg ReCycle is a program designed especially for working with 
sampled loops. Among other things, ReCycle makes it possible to 
change the tempo of loops without affecting the pitch, and to edit the 
loop as if it were built up of individual sounds. 

The Import - ReCycle File command on the File menu allows you to 
import “REX” files exported from ReCycle, and play and edit these in 
Cubase VST. In effect, this makes it possible to use ReCycled files 
without the need of an external sampler. See the ReCycle chapter in the 
electronic documentation.

Importing a Pro-24 Song
If you have Song files created with Steinberg Pro-24 (an older se-
quencer software for the Atari computer), it is possible to import them 
into Cubase VST, using the “24 Song...” option on the Import submenu.

¶ To be able to transfer files from the Atari to the Macintosh, you need to use 
an MS-DOS formatted floppy disk.

Importing QuickTime Movie Files
The “Movie Setup” submenu on the Options Menu allows you to im-
port Quick Time Movies for editing in Cubase. See page 322.
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Export
To save information in a non-native file format, you use one of the Ex-
port options on the File menu:

Exporting in MIDI File format
You might want to export an Arrangement as a Standard MIDI File, so 
that it can be loaded into other computer programs or hardware se-
quencers, for example.

¶ A Standard MIDI File contains MIDI data only - no audio. Any Audio Tracks 
in your Arrangement is automatically excluded from the created MIDI file.

1. Mute all the Tracks you don’t want included in the MIDI File.

2. Pull down the File menu and select “MIDI File...” from the Export 
submenu.

The file dialog appears.

3. Select a name and location for the file.
If you want to be able to import the MIDI file into PC-based programs, you 
should give it the extension “.MID”.

4. Click Save.
A dialog appears, allowing you to select whether you want the file to be of 
“Type 1” or “Type 0”. 

• If you select “Type 1”, the Track structure is preserved in the file (even 
though all Parts on each Track will be linked together into one long Part). 

• If you select “Type 0”, the MIDI File will only contain one single Track, 
with the data on different MIDI channels.
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Which type to use depends on the level of compatibility required. Usually, 
you should select “Type 1”, but some sequencers will only read “Type 0” 
files.

¶ When you export a MIDI file, there are settings that affect the contents of the 
file. These settings are found in the Preferences–MIDI–MIDI Files dialog. See 
the Menu and Dialog Reference document for descriptions of the settings.

Exporting Cubase 3.x files
With the introduction of Cubase VST 4.0, the native file format was 
changed. Even though Cubase VST 4.0 and later can read files created 
with previous VST versions, the opposite is not true. Therefore, you 
have the option to export your Songs or Arrangements in a format 
compatible with Cubase VST 3.x, using the corresponding items on 
the File - Export submenu.

¶ If you export a file in 3.x format, any 4.0-specific settings will be lost. Make 
sure that you perform a regular Save as well, if you want to be able to con-
tinue working with the Song/Arrangement in VST 4.0 later.

Exporting Audio Files
Since audio files are unique in the sense that they are not actually a 
part of a Song, and can be “shared” by many different Songs, it is very 
helpful to be familiar with the different options available when han-
dling these types of files.

Audio files can be exported in several ways:

• By using the Export Segment command in the Pool.
This allows you to export a segment and make it an audio file of its own.

• In the Arrange window, by using the Export - Audio Tracks com-
mand on the File menu.
The Export Audio File command lets you mix down several Audio Tracks into 
one audio file, including effects and automation if you like.

These functions are described in detail in the electronic documentation.
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Using Drag and Drop
Just as it is possible to drag Parts and segments between different win-
dows, you can drag and drop files between Cubase VST and the 
Finder. For example, Parts can be copied to and from the hard disk, 
grooves can be dragged directly from disk into the Groove Box, etc 
(see below for a full list of drag and drop options). The following ex-
ample shows how to drag an Audio file from the Finder into the Ar-
range window:

1. In the Finder, open the window containing the Audio file, and 
make sure it is visible when you switch to Cubase VST.

2. In Cubase VST, go to the Arrange window.

3. Point at the Audio file, press the mouse button and drag its icon 
into the Arrange window.

Since it is an audio file, you need to drag it to an Audio Track, or to an empty 
area (in which case a new Audio Track will be created).
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4. Release the mouse button.

The audio file is added to the Pool, and a Part is created at the position you 
dropped it (taking the Snap value into account as usual). The Part will con-
tain a segment that plays the complete file.

The following files can be dragged and dropped:

Item: Drag and Drop options:

Audio Files Can be dragged from the Finder into the Arrangement, Audio 
Pool or Audio Editor.

Parts Any combination of Parts can be dragged from the Arrange-
ment into the Finder. This will create a Cubase Part file, 
which you can later open with the Open command on the 
File menu, or drag back into Cubase VST. 

MIDI Events Any combination of MIDI Events can be dragged from a 
MIDI Editor to the Arrangement (will create a new Part con-
taining the selected Events) or to the Finder (will create a 
new Part file).

MIDI Files A MIDI File can be dragged from the Finder into the Arrange-
ment (creates new Parts and, if necessary, new Tracks) or 
into a MIDI Editor, in which case the Events in the MIDI File 
will be added to the edited Part.



CUBASE VST
File Handling 19 – 347

19
19
19
19
19
19
19
19

19
19

Backup Strategies

Make Backups of your audio files!

Needless to say, it is essential that you back up your audio data regu-
larly, preferably on other media. Audio files are very large by nature 
and can quickly use up all the available space on your hard disk. If you 
record audio frequently, you will propably need to store these files 
separately, somewhere else than on your hard disk. When doing this, 
keep in mind that audio files are not a part of a Song. It is therefore im-
portant that you update the Songs which contain audio references, so 
that these references are accurate. There are various functions to make 
it easier to manage your audio files (see below). These are also de-
scribed in detail in the Audio Pool chapter in the electronic documen-
tation.

Prepare Archive
This function on the Pool File pop-up menu takes all the audio files 
used in the Song (or, if you wish, all the audio files in the Pool, regard-
less of whether they are used or not) and puts them in a new folder that 
you specify. For details, please refer to the electronic documentation.

Prepare Master
This option takes all the audio files used in the Song, extracts only the 
used bits of each audio file and stores this into new files. The result is 
a new set of files that play back the Song just as before, but now only 
contains the portions of audio which actually appears in the song. The 
Song is also updated to play the new “trimmed” files.

For details, please refer to the electronic documentation.
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Streaming to and from DAT
If you have installed audio hardware with digital inputs and outputs, 
you can use the included DAT Streaming application to store your au-
dio files on DAT tape. There are several uses for this:

• Backup all your audio data.
• Easily transfer large audio files between different computers running Cubase 

VST.
• Since the DAT stream format is compatible with the format used with Cubase 

Audio for Atari Falcon, the DAT Streaming function can be used to transfer 
audio files between Atari and Macintosh.

The DAT Streaming application is described in the electronic docu-
mentation.
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